
 

 

Tuần 1  

Tiết: 1 

Bài 1:  

TỪ MÁY TÍNH ĐẾN MẠNG MÁY TÍNH 

 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

 Biết khái niệm mạng máy tính 

 Biết lợi ích của mạng máy tính  

2. Kĩ năng:  

 Vai trò quan trọng của mạng máy tính trong xã hội. 

3. Thái độ:  

 Giáo dục thái độ học tập nghiêm túc. 

 Nhận thức được vấn đề bản quyền trên mạng. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Trực quan 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: sách giáo khoa, giáo án, sách bài tập. 

b. Học sinh: sách giáo khoa, vở ghi, sách bài tập. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện cá nhân. 

 Yêu cầu: Chúng ta có thể soạn thảo văn bản, lập trình, tính toán  trên  một máy tính 

độc lập được hay không? 3 máy tính có thể sử dụng chung một máy in được không?  

 HS thực hiện.  

 GV đưa ra vấn đề: Vậy theo em dựa vào đâu mà người ta có thể làm được như vậy? 

Để nắm rõ, chúng ta cùng đến với bài học ngày hôm nay.  

 

3.1. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

1. Khái niệm mạng máy tính. 

Chuyển giao nhiệm vụ 2 

Yêu cầu: Tham khảo thông tin 

SGK.  

+ Mạng máy tính là gì? 

HS thực hiện nhiệm vụ 2 

HS thực hiện cá nhân. 

Nghiên cứu thông tin sgk. 

Báo cáo kết quả: 

+ Mạng máy tính là tập hợp các máy tính được 

kết nối với nhau theo một phương thức nào đó 



 

 

+ Em hãy nêu các kiểu kết nối phổ 

biến của mạng máy tính 

GV nhận xét, đánh giá -> Chốt 

kiến thức lên bảng. 

Hướng dẫn HS ghi bài. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 3 

Yêu cầu:  

+ Nêu ưu, nhược điểm của từng 

kiểu kết nối mạng máy tính trên. 

GV mời đại diện mỗi nhóm trình 

bày mỗi kiểu kết nối. Các nhóm 

còn lại nhận xét, sửa chữa. 

 

 

 

 

 

 

 

 

 

 

 

- GV nhận xét, đánh giá -> Chốt 

kiến thức lên bảng. 

thông qua các phương tiện truyền dẫn tạo thành 

một hệ thống cho phép người dùng trao đổi 

thông tin, chia sẻ tài nguyên như dữ liệu, phần 

mềm, máy in,… 

+ Các kiểu kết nối mạng máy tính: 

- Kết nối hình sao. 

 
- Kết nối đường thẳng. 

 
- Kết nối kiểu vòng. 

 
Nhận xét. 

Ghi bài. 

HS thực hiện nhiệm vụ 3 

Hoạt động nhóm nhỏ (2 bạn ngồi cùng bàn). 

HS báo cáo kết quả: 

+ Mạng hình sao: Có ưu điểm là nếu có một thiết 

bị nào đó ở một nút thông tín bị hỏng thì mạng 

vẫn hoạt động bình thường, có thể mở rộng hoặc 

thu hẹp tùy theo yêu cầu của người sử dụng, 

nhược điểm là khi trung tâm có sự cố thì toàn 

mạng ngừng hoạt động. 

+ Mạng đường thẳng: Có ưu điểm là dùng dây 

cáp ít nhất, dễ lắp đặt, nhược điểm là sẽ có sự ùn 

tắc giao thông khi di chuyển dữ liệu với lưu 

lượng lớn và khi có sự hỏng hóc ở đoạn nào đó 

thì rất khó phát hiện, một sự ngừng trên đường 

dây để sửa chữa sẽ ngừng toàn bộ hệ thống. 

+ Mạng dạng vòng: Có thuận lợi là có thể nới 

rộng ra xa, tổng đường dây cần thiết ít hơn so 

với hai kiểu trên, nhược điểm là đường dây phải 

khép kín, nếu bị ngắt ở một nơi nào đó thì toàn 

bộ hệ thống cũng bị ngừng. 

Nhận xét, bổ sung. 



 

 

 

Chuyển giao nhiệm vụ 4 

Yêu cầu:  

+ Em hãy nêu các thành phần chủ 

yếu của mạng? 

 

 

- GV nhận xét, đánh giá -> Chốt 

kiến thức lên bảng. 

Hướng dẫn HS ghi bài. 

 

 

 

 

 

  

 

2. Lợi ích của mạng máy tính. 

 

Chuyển giao nhiệm vụ 5 

Yêu cầu học sinh đọc thông tin sgk. 

+ Các lợi ích của mạng máy tính là 

gì?  

+ Tìm hiểu từng lợi ích. 

 

 

- GV nhận xét, đánh giá -> Chốt 

kiến thức lên bảng. 

Hướng dẫn HS ghi bài. 

HS thực hiện nhiệm vụ 4 

Hoạt động nhóm nhỏ (2 bạn ngồi cùng bàn). 

HS báo cáo kết quả: 

- Các thiết bị đầu cuối như máy tính, máy in,… 

- Môi trường truyền dẫn cho phép các tín hiệu 

truyền được qua đó(sóng điện từ, bức xạ hồng 

ngoại). 

-Các thiết bị kết nối mạng(modem, bộ định 

tuyến) 

- Giao thức truyền thông: là tập hợp các quy 

tắc quy định cách trao đổi thông tin giữa các 

thiết bị gửi và nhận dữ liệu trên mạng. 

Nhận xét, bổ sung. 

Ghi bài. 

 

 

 

HS thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

+ Dùng chung dữ liệu. 

+ Dùng chung các thiết bị phần cứng như máy 

in, bộ nhớ, các ổ đĩa,… 

+ Dùng chung các phần mền. 

+ Trao đổi thông tin.Nhận xét. 

Tìm hiểu từng lợi ích. 

Ghi bài. 

 

3.2. Hoạt động luyện tập. 

GV chuyển giao nhiệm vụ 6  
HS thực hiện cá nhân. 

Yêu cầu: 

Câu 1: Hãy nêu các thành phần cơ bản của mạng máy tính: 

A. Thiết bị kết nối mạng, môi trường truyền dẫn, thiết bị đầu cuối và giao thức 

truyền thông 

B. Máy tính và internet 

C. Máy tính, dây cáp mạng và máy in 

D. Máy tính, dây dẫn, modem và dây điện thoại 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

3.3. Hoạt động vận dụng kiến thức. 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

 HS về nhà học bài cũ. 



 

 

 Tìm hiểu bài mới. 

 

Tuần 1 

Tiết: 2 

BÀI 2 

MẠNG THÔNG TIN TOÀN CẦU INTERNET. 

 
I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  
- Biết khái niệm mạng Internet 

- Biết một số dịch vụ cơ bản của Internet và lợi ích của chúng 

2. Kĩ năng:  

 HS có được các kỹ năng thao tác trên Internet. 

3. Thái độ:  

 Giáo dục thái độ học tập nghiêm túc. 

 Nhận thức được vấn đề bản quyền trên mạng. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Trực quan. 

 Thảo luận nhóm. 

 Hỏi đáp 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: sách giáo khoa, giáo án, sách bài tập. 

b. Học sinh: sách giáo khoa, vở ghi, sách bài tập. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ:  

3. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện cá nhân. 

 Yêu cầu: Hằng ngày các em sử dụng Internet vào các công việc gì? 

 GV mời HS trả lời, nhận xét. 

 HS trả lời: Tìm kiếm thông tin học tập, vui chơi, giải trí, bán hàng online, ... 

 GV  Nhận xét. 

 GV đưa ra vấn đề: Hằng ngày các em sử dụng Internet rất nhiều như vậy, nhưng các 

em đã biết chính xác Internet là gì chưa? Mạng máy tính và mạng Internet có giống 

nhau không? Chúng ta sẽ hiểu rõ hơn trong bài học hôm nay “Mạng thông tin toàn cầu 

Internet”. 

3.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

1. Tìm hiểu về Internet.  

Chuyển giao nhiệm vụ 2 

 

HS thực hiện nhiệm vụ 2 



 

 

Yêu cầu:  

+ Hỏi 1: Hãy cho biết Internet là gì? 

Cho ví dụ về những dịch vụ thông tin 

trên Internet. 

+ Hỏi 2: Theo em ai là chủ thực sự 

của mạng Internet? 

+ Hỏi 3: Hãy nêu điểm khác biệt của 

Internet so với các mạng máy tính 

thông thường khác? 

+ Hỏi 4: Nếu nhà em nối mạng 

Internet, em có sẵn sàng chia sẻ 

những kiến thức và hiểu biết có mình 

trên Internet không? 

+ Hỏi 5: Theo em, các nguồn thông 

tin mà internet cung cấp có phụ 

thuộc vào vị trí địa lí không? 

GV đánh giá nhận xét. 

Gv kết luận:  

Mỗi phần nhỏ của Internet được 

các tổ chức khác nhau quản lí, nhưng 

không một tổ chức hay cá nhân nào 

nắm quyền điều khiển toàn bộ mạng. 

Mỗi phần của mạng, có thể rất khác 

nhau nhưng được giao tiếp với nhau 

bằng một giao thức thống nhất( giao 

thức TCP/IP) tạo nên một mạng toàn 

cầu. 

Khi đã gia nhập Internet, về mặt 

nguyên tắc, hai máy tính ở hai đầu 

trái đất cũng có thể kết nối để trao 

đổi thông tin trực tiếp với nhau. 

 
GV hướng dẫn HS ghi bài. 

 

2. Một số dịch vụ trên Internet. 

 

HS thực hiện cá nhân. 

Nghiên cứu thông tin sgk. 

Báo cáo kết quả: 

+ Hỏi 1: Internet là mạng kết nối hàng triệu 

máy tính và mạng máy tính trên khắp thế giới, 

cung cấp cho mọi người khả năng khai thác 

nhiều dịch vụ thông tin khác nhau như Email, 

Chat...  

+ Hỏi 2: Mạng Internet là của chung, không ai 

là chủ thực sự của nó. 

+ Hỏi 3: Các máy tính đơn lẻ hoặc mạng máy 

tính tham gia vào Internet một cách tự nguyện 

và bình đẳng; Mạng Internet có quy mô toàn 

cầu, mạng LAN, WAN thường có quy mô nhỏ 

không ở phạm vi toàn cầu. 

+ Hỏi 4: Không chỉ em mà có rất nhiều người 

dùng sẵn sàng chia sẻ tri thức, sự hiểu biết 

cũng như các sản phẩm của mình trên Internet. 

+ Hỏi 5: Các nguồn thông tin mà internet cung 

cấp không phụ thuộc vào vị trí địa lí. 

HS nhận xét, bổ sung. 

Ghi nhận kiến thức. 

Ghi bài. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

HS thực hiện nhiệm vụ 3 



 

 

Chuyển giao nhiệm vụ 3 

Yêu cầu:  

+ Tìm hiểu dịch vụ Web.Cho ví dụ 1 

số trang web, một số trình duyệt 

web. 

GV mời đại diện 1 nhóm trình bày. 

Các nhóm còn lại nhận xét, sửa chữa. 

 

 

 

GV nhận xét, đánh giá -> Chốt kiến 

thức  

GV hướng dẫn HS ghi bài. 

 

 

 

Chuyển giao nhiệm vụ 4 

Yêu cầu:  

+Máy tìm kiếm giúp em làm gì? 

+Danh mục thông tin là gì? 

+Khi truy cập danh mục thông tin, 

người truy cập làm thế nào? 

GV mời đại diện 3 nhóm trình bày 

ứng với 3 ý trên. Các nhóm còn lại 

nhận xét, sửa chữa. 

GV nhận xét, đánh giá -> Chốt kiến 

thức  

Hướng dẫn HS ghi bài. 

 

 

 

Chuyển giao nhiệm vụ 5 

Yêu cầu: 

+Thư điện tử là gì? 

+Nêu ưu điểm khi sử dụng thư điện 

tử? 

a) Thực hiện: 

HS thảo luận nhóm (5 phút). 

GV mời đại diện 2 nhóm trình bày 

ứng với 2 ý trên. Các nhóm còn lại 

nhận xét, sửa chữa. 

 

GV nhận xét, đánh giá -> Chốt kiến 

thức  

 

Hoạt động nhóm nhỏ (2 bạn ngồi cùng bàn). 

HS báo cáo kết quả: 

Dịch vụ Web: 

+ Word Wide Web(Web): Cho phép tổ chức 

thông tin trên Internet dưới dạng các trang nội 

dung, gọi là các trang web. Bằng một trình 

duyệt web, người dùng có thể dễ dàng truy cập 

để xem các trang đó khi máy tính được kết nối 

với Internet. 

+ VD trang web: baomoi.com, 

bongda.com.vn, ... 

+ VD trình duyệt web: Google chorme, cốc 

cốc, fire fox, Internet Explorer, ... 

HS nhận xét, bổ sung. 

Ghi bài. 

HS thực hiện nhiệm vụ 4 

Hoạt động nhóm nhỏ (2 bạn ngồi cùng bàn). 

HS báo cáo kết quả: 

+ Máy tìm kiếm giúp tìm kiếm thông tin dựa 

trên cơ sở các từ khóa liên quan đến vấn đề cần 

tìm 

+ Danh mục thông tin là trang web chứa danh 

sách các trang web khác có nội dung phân theo 

các chủ đề. 

+ Người truy cập nháy chuột vào chủ đề mình 

quan tâm để nhận được danh sách các trang 

web có nội dung liên quan và truy cập trang 

web cụ thể để đọc nội dung. 

HS nhận xét, bổ sung. 

Ghi bài. 

HS thực hiện nhiệm vụ 5 

Hoạt động nhóm nhỏ (2 bạn ngồi cùng bàn). 

HS báo cáo kết quả: 

+Thư điện tử (E-mail) là dịch vụ trao đổi thông 

tin trên Internet thông qua các hộp thư điện tử. 

+Sử dụng thư điện tử em có thể đính kèm các 

tệp(phần mềm, văn bản, âm thanh, hình ảnh,..). 

Đây cũng là một trong các dịch vụ rất phổ biến, 

người dùng có thể trao đổi thông tin cho nhau 

một cách nhanh chóng, tiện lợi với chi phí 

thấp. 

Ghi bài. 

 

 

 



 

 

 

 

3.3. Hoạt động luyện tập. 

GV chuyển giao nhiệm vụ 6 
HS nhóm. (2 HS cùng bàn 1 nhóm) 

Yêu cầu: Trả lời câu hỏi 1, sgk, trang 19. 

HS thảo luận nhóm, báo cáo kết quả: 

Một số điểm khác biệt giữa mạng Internet và các mạng LAN, WAN: 

+ Mạng Internet co quy mô toàn cầu, mạng LAN, WAN thường có quy mô nhỏ, 

không ở phạm vi toàn cầu. 

+ Mạng Internet là mạng máy tính sở hữu chung, còn các mạng LAN, WAN thường 

của một công ty, cơ quan hay cá nhân nào đó. 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

3.4. Hoạt động vận dụng kiến thức. 
GV chuyển giao nhiệm vụ 7  
HS thực hiện cá nhân, báo cáo kết quả. 

Yêu cầu: Trả lời câu hỏi 3, sgk, trang 19. 

Báo cáo kết quả: 

+ Sử dụng dịch vụ thư điện tử (gửi kèm tệp thư). 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà học bài cũ. 

Tìm hiểu bài mới. 

 

 

 

Tuần 2  

Tiết: 3 

BÀI: 2 

MẠNG THÔNG TIN TOÀN CẦU INTERNET. 

V. MỤC TIÊU BÀI HỌC: 

5. Kiến thức:  
- Biết thêm một số ứng dụng cơ bản của Internet và lợi ích của chúng 

- Biết được cách để có thể kết nối Internet 

6. Kĩ năng:  

 HS có được các kỹ năng thao tác trên Internet. 

7. Thái độ:  

 Giáo dục thái độ học tập nghiêm túc. 

 Nhận thức được vấn đề bản quyền trên mạng. 

8. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

VI. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 



 

 

 Trực quan. 

 Thảo luận nhóm. 

 Hỏi đáp 

VII. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: sách giáo khoa, giáo án, sách bài tập. 

b. Học sinh: sách giáo khoa, vở ghi, sách bài tập. 

VIII. TIẾN TRÌNH DẠY HỌC: 

5. Ổn định:  

6. Kiểm tra bài cũ:  

GIÁO VIÊN HỌC SINH 

Câu hỏi: Hãy cho biết sự giống 

nhau và khác nhau giữa mạng 

không dây và mạng có dây? 

 

 

GV gọi HS lên bảng trả lời. 

Nhận xét, khuyến khích HS và 

cho điểm. 

Đáp án: Mạng không dây và mạng có dây: 

*Giống nhau: Đều chung mục đích sử dụng để 

kết nối các máy tính với nhau thành mạng máy 

tính. Và được phân chia dựa trên môi trường 

truyền dẫn tín hiệu. 

*Khác nhau: 

- Môi trường truyền dẫn: 

Mạng có dây sử dụng môi trường truyền dẫn là 

các dây dẫn. 

Mạng không dây sử dụng môi trường truyền 

dẫn không dây. 

- Mạng không dây có khả năng thực hiện kết 

nối mọi lúc, mọi nơi trong phạm vi mạng cho 

phép. 

 

HS lên bảng trả lời. 

Các HS còn lại nhận xét, sửa chữa câu trả lời 

của bạn. 

 

7. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện cá nhân. 

GV chiếu một vài dịch vụ trên internet. 

 Yêu cầu: Em hãy cho biết một số dịch vụ trên internet? 

 GV mời HS trả lời, nhận xét. 

 HS trả lời: Hội thảo trực tuyến, học tập, vui chơi, giải trí, bán hàng online, ... 

 GV  Nhận xét. 

GV đặt vấn đề vào bài mới 

7.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

 

3. Một vài ứng dụng khác trên 

Internet  

 

HS thực hiện nhiệm vụ 2 

HS thực hiện cá nhân. 



 

 

Chuyển giao nhiệm vụ 2 

Yêu cầu: 

+ Nêu một vài ứng dụng trên 

Internet? 

+ Phân tích, cho ví dụ từng ứng 

dụng. 

GV nhận xét, đánh giá -> Chốt 

kiến thức  

Hướng dẫn HS ghi bài. 

 

4. Làm thế nào để kết nối 

Internet  

Chuyển giao nhiệm vụ 3 

Yêu cầu học sinh đọc thông tin 

sgk. 

+ Để kết nối được Internet, đầu tiên 

em cần làm gì? 

+ Em còn cần thêm các thiết bị gì 

nữa không? 

+ Em hãy kể tên một số nhà cung 

cấp dịch vụ Internet ở Việt Nam?  

 

GV nhận xét, đánh giá -> Chốt 

kiến thức  

Hướng dẫn HS ghi bài. 

Báo cáo kết quả: 

+ Hội thảo trực tuyến; đào tạo qua mạng; thương 

mại điện tử;  

+ Phân tích, cho ví dụ. 

Nhận xét. 

Ghi bài. 

 

 

 

 

 

 

HS thực hiện nhiệm vụ 3 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

+ Cần đăng kí với một nhà cung cấp dịch vụ 

Internet (ISP) để được hỗ trợ cài đặt và cấp 

quyền truy cập Internet. 

+Modem và một đường kết nối riêng (đường 

điện thoại, đường truyền thuê bao, đường 

truyền ADSL, Wi - Fi). 

+Một số nhà cung cấp dịch vụ Internet ở Việt 

Nam: Tổng công ti bưu chính viễn thông việt 

nam VNPT, Viettel, tập đoàn FPT, công ti 

Netnem thuộc viện công nghệ thông tin. 

Nhận xét. 

Ghi bài. 

 

7.3. Hoạt động luyện tập. 

GV chuyển giao nhiệm vụ 4 
HS nhóm. (2 HS cùng bàn 1 nhóm) 

Yêu cầu:  

Câu 1: WWW là viết tắt của cụm từ nào sau đây ? 

A. World Win Web         B. World Wide Web 

C. Windows Wide Web   D. World Wired Web 

Câu 2: Người dùng có thể tiếp cận và chia sẻ thông tin một cách nhanh chóng, tiện lợi, 

không phụ thuộc vào vị trí địa lý khi người dùng kết nối vào đâu? 

A. Laptop                B. Máy tính 

C. Mạng máy tính    D. Internet 

Câu 3: Máy tìm kiếm là: 

A. Là công cụ tìm kiếm các thông tin trong máy tính 

B. Là một loại máy được nối thêm vào máy tính để tìm kiếm thông tin trên Internet 

C. Là một phần mềm cái đặt vào máy tính dàng để tìm kiếm thông tin 

D. Là một công cụ được cung cấp trên Internet giúp tìm kiếm thông tin trên cơ sở các 

từ khóa liên quan đến vấn đề cần tìm. 



 

 

Câu 4: Internet là 

A. mạng kết nối các máy tính ở quy mô một nước 

B. mạng kết nối hàng triệu máy tính ở quy mô một huyện 

C. mạng kết nối hàng triệu máy tính ở quy mô một tỉnh 

D. mạng kết nối hàng triệu máy tính ở quy mô toàn cầu 

 

HS thảo luận nhóm, báo cáo kết quả: 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

7.4. Hoạt động vận dụng kiến thức. 

GV chuyển giao nhiệm vụ 5  
HS thực hiện cá nhân, báo cáo kết quả. 

Yêu cầu: HS trả lời câu hỏi sau 

Câu 1: Sau khi sưu tầm được nhiều ảnh đẹp về phong cảnh quê hương em, nếu muốn 

gửi cho các bạn ở nơi xa, em có thể sử dụng dịch vụ nào trên Internet? 

Báo cáo kết quả: 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

8. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà học bài cũ. 

Tìm hiểu bài mới. 

 

 

 

 

Tuần 2  

Tiết: 4 

Bài 3: TỔ CHỨC VÀ TRUY CẬP THÔNG TIN TRÊN INTERNET. 

 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

 Biết các khái niệm web, trang web, siêu văn bản  

 Biết các khái niệm website, địa chỉ web 

2. Kĩ năng:  

 Biết tìm kiếm thông tin trên Internet. 

3. Thái độ: Tập trung lĩnh hội kiến thức, chủ động trong học tập. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Sách giáo khoa, giáo án, hình ảnh. 

b. Học sinh: Sách giáo khoa, vở ghi. 



 

 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ:  

Giáo viên Học sinh 

Yêu cầu: 

+ Internet là gì? 

+ Hãy cho biết một vài điểm 

khác biệt của mạng Internet so 

với các mạng LAN, WAN. 

Mời 1 HS lên bảng trả lời. 

 

 

 

 

 

 

 

Nhận xét, đánh giá, cho điểm. 

Thực hiện yêu cầu. 

Kết quả: 

+ Internet là hệ thống kết nối các máy tính ở 

quy mô toàn thế giới. 

+ Một số điểm khác biệt giữa mạng Internet và 

các mạng LAN, WAN là:  

 Mạng Internet có quy mô toàn cầu, mạng 

LAN, WAN thường có quy mô nhỏ, không ở 

phạm vi toàn cầu.  

 Mạng  Internet  là  một  mạng  máy  tính  "sở  

hữu  chung",  còn  các  mạng LAN/WAN 

thường là của một công ti, cơ quan hay cá nhân 

nào đó. 

HS nhận xét, sửa chữa. 

 

 

 

 

 

3. Tổ chức dạy học: 

3.1. Khởi động:  

 

Hoạt động của GV Hoạt động của HS 

Chuyển giao nhiệm vụ 1 

GV phân nhóm: 2 HS ngồi cùng bàn 1 

nhóm. 

Yêu cầu: Tìm hiểu vấn đề sgk. Trang 

21 về câu nói “ Thế giới trên đầu 

ngón tay”. Theo em hiểu câu nói này 

như thế nào? 

 

GV đánh giá, nhận xét. 

GV đưa ra vấn đề: Để biết được câu 

nói của Bill Gates có đúng không, 

chúng ta cùng tìm hiểu qua tiết học. 

 

HS thực hiện nhiệm vụ 1 

HS thảo luận nhóm.  

HS báo cáo kết quả: 

+ Với Internet chúng ta chỉ cần một màn 

hình máy tính, nháy chuột, các ngón tay 

gõ phím nội dung cần tìm là có thể biết 

mọi thông tin của toàn thế giới. 

+ Chỉ rõ sức mạnh vô biên của mạng 

thông tin toàn cầu Internet. 

HS nhận xét. 

 

3.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

1. Tìm hiểu tổ chức thông tin trên Internet. 



 

 

Chuyển giao nhiệm vụ 2 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 1, 

sgk, trang 21). 

+ Theo em thế nào là siêu văn bản. Nó 

được tạo ra bằng ngôn ngữ gì? 

 

GV nhận xét, đánh giá -> Chốt kiến 

thức  

Chuyển giao nhiệm vụ 2 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 1, 

sgk, trang 21). 

+ Theo em thế nào là trang web, địa chỉ 

trang web? 

+ GV cho HS xem các hình ảnh về một 

số trang web và yêu cầu HS nêu địa chỉ 

trang web đó. 

GV nhận xét, đánh giá -> Chốt kiến 

thức  

GV hướng dẫn HS ghi bài. 

Chuyển giao nhiệm vụ 3 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 1, 

sgk, trang 21). 

+ Website là gì? Địa chỉ website là gì? 

+ Khi truy cập vào một website, trang 

web được mở ra đầu tiên có tên là gì? 

+ GV giới thiệu một số website thông 

qua hình ảnh. 

 

GV nhận xét, đánh giá -> Chốt kiến 

thức  

GV hướng dẫn HS ghi bài. 

HS thực hiện nhiệm vụ 2 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Siêu văn bản là loại văn bản tích hợp 

nhiều dạng dữ liệu khác nhau như: văn 

bản, hình ảnh, âm thanh, video …và các 

siêu liên kết đến các siêu văn bản khác. 

HS nhận xét, bổ sung. 

 

HS thực hiện nhiệm vụ 2 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Trang web là một siêu văn bản được gán 

địa chỉ truy cập trên Internet. Địa chỉ truy 

cập này được gọi là địa chỉ trang web. 

+ Quan sát hình và thực hiện yêu cầu. 

HS nhận xét, bổ sung. 

Ghi bài. 

 

 

HS thực hiện nhiệm vụ 3 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Website là một hoặc nhiều trang web liên 

quan được tổ chức dưới một địa chỉ truy 

cập chung.  

Địa chỉ truy cập chung  được gọi là địa chỉ 

của website 

+ Khi mở một website trang đầu tiên được 

gọi là trang chủ. 

+ Quan sát hình ảnh. 

HS nhận xét, bổ sung. 

Ghi bài. 

 

3.3. Hoạt động luyện tập. 

GV chuyển giao nhiệm vụ 4 

HS nhóm. (2 HS cùng bàn 1 nhóm) 

Yêu cầu: Siêu văn bản là gì? Phân biệt sự khác nhau giữ siêu văn bản và trang web? 

HS thảo luận nhóm, báo cáo kết quả: 

+ Siêu văn bản là loại văn bản tích hợp nhiều dạng dữ liệu khác nhau như: văn bản, 

hình ảnh, âm thanh, video …và các siêu liên kết đến các siêu văn bản khác. 

+ Trang web cũng là siêu văn bản; sự khác nhau giữa chúng là có được gán địa  

chỉ trên Internet hay không. (trang web được gán địa chỉ trên Internet). 



 

 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

3.4. Hoạt động vận dụng kiến thức. 
GV chuyển giao nhiệm vụ 5  
HS thực hiện cá nhân, báo cáo kết quả. 

Yêu cầu: 

+ Trang chủ của Website WWW.dantri.com.vn có địa chỉ là gì? 

HS báo cáo kết quả: 

+ Trang chủ có địa chỉ trùng với địa chỉ website: dantri.com.vn. 

HS nhận xét. 

GV nhận xét, đánh giá -> Chốt kiến thức  

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà học bài cũ. 

Tìm hiểu bài mới. 

 

Tuần 3 

Tiết: 5 

Bài 3: TỔ CHỨC VÀ TRUY CẬP THÔNG TIN TRÊN INTERNET. (tt) 

 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

 Biết trình duyệt là công cụ được sử dụng để truy cập web.  

 Biết có thể sử dụng máy tìm kiếm ñể tìm kiếm thông tin và hình ảnh trên Internet. 

2. Kĩ năng:  

 Biết tìm kiếm thông tin trên Internet. 

3. Thái độ: Tập trung lĩnh hội kiến thức, chủ động trong học tập. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Sách giáo khoa, giáo án, hình ảnh. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1. Khởi động:  

 

Hoạt động của GV Hoạt động của HS 

Chuyển giao nhiệm vụ 1 

GV phân nhóm: 2 HS ngồi cùng bàn 1 

nhóm. 

HS thực hiện nhiệm vụ 1 

HS thảo luận nhóm. (5 phút) 

HS báo cáo kết quả: 

http://www.dantri.com.vn/


 

 

Yêu cầu: Đoán kết quả tìm kiếm khi 

gõ cùng một địa chỉ cunghoc.com vào 

trình duyệt Cốc Cốc và vào máy tìm 

kiếm Google. 

 

GV đánh giá, nhận xét. 

GV đưa ra vấn đề: Để xem câu trả lời 

dự đoán có đúng,chúng ta cùng tìm 

hiểu qua tiết học. 

 

+ Khi gõ địa chỉ cunghoc.com vào: 

Cốc cốc: một trang web Cùng học sẽ 

được mở ra. 

Máy tìm kiếm Google: một loạt kết quả 

gợi ý tiềm kiếm hiển thị dưới dạng liệt 

kê. 

HS nhận xét. 

 

3.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

Tìm hiểu tổ chức thông tin trên Internet. 

 

Chuyển giao nhiệm vụ 2 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 2, 

sgk, trang 23). 

+ Muốn truy cập vào các trang web 

người dùng phải làm như thế nào? 

+ Thế nào là trình duyệt web? 

+ Em hãy nêu một số trình duyệt web mà 

em biết. 

GV đánh giá nhận xét, chốt lại. 

GV hướng dẫn HS ghi bài. 

 

 

Chuyển giao nhiệm vụ 3 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 2, 

sgk, trang 24). 

+ Muốn truy cập vào một trang web ta 

làm như thế nào? 

+ Văn bản chứa liên kết có dạng như 

thế nào? 

 

 

GV đánh giá nhận xét, chốt kiến thức. 

GV hướng dẫn HS ghi bài. 

 

HS thực hiện nhiệm vụ 2 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Phải sử dụng phần mềm trình duyệt web 

(web browser). 

+ Là một phần mềm ứng dụng giúp người 

giao tiếp với hệ thống www: truy cập các 

trang web và khai thác các tài nguyên trên 

internet. 

+ Một số trình duyệt web: Internet 

Explorer, Fiefox, Cốc cốc, chrome, 

Opera, … 

HS nhận xét, bổ sung. 

Ghi bài. 

HS thực hiện nhiệm vụ 3 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Muốn truy cập vào một trang web ta làm 

như sau: 

 Nhập địa chỉ của trang web vào ô địa chỉ. 

 Nhấn Enter. 

+ văn bản chứa liên kết thường có màu 

xanh dương hoặc được gạch chân; khi di 

chuyển trên các thành phần chứa liên kết, 

con trỏ chuột sẽ có dạng hình bàn tay. 

HS nhận xét, bổ sung. 

Ghi bài. 

 

Tìm kiếm thông tin trên Internet.  



 

 

Chuyển giao nhiệm vụ 4 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 3, 

sgk, trang 25). 

+ Máy tìm kiếm là gì? 

+ Khi nào thì nên sử dụng máy tìm 

kiếm mà không sử dụng trình duyệt 

web? 

+ Thông tin tìm kiếm được có thể là gì? 

+ Cho ví dụ máy tìm kiếm. 

GV đánh giá nhận xét, chốt kiến thức. 

GV hướng dẫn HS ghi bài. 

 

 

 

Chuyển giao nhiệm vụ 5 

HS thực hiện cá nhân. 

Yêu cầu: Tìm hiểu nội dung (mục 3, 

sgk, trang 25). 

+ Máy tìm kiếm tìm thông tin dựa vào 

đâu? 

+ Để tìm thông tin bằng máy tìm kiếm, 

ta thực hiện những bước nào? 

 

GV đánh giá nhận xét, chốt lại. 

GV hướng dẫn HS ghi bài. 

HS thực hiện nhiệm vụ 4 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Máy tìm kiếm là công cụ hổ trợ tìm kiếm 

thông tin trên Internet theo yêu cầu của 

người dùng. 

+ Khi chưa biết địa chỉ cụ thể của một trang 

web, có thể tìm kiếm trên máy tìm kiếm để 

được các kết quả gợi ý. 

+ Thông tin tìm kiếm có thể là văn bản, 

hình ảnh, phim (video), các trang web, … 

+ Ví dụ: Google, Bing, Yahoo, … 

HS nhận xét, bổ sung. 

Ghi bài. 

 

HS thực hiện nhiệm vụ 5 

HS nghiên cứu thông tin sgk. 

HS báo cáo kết quả: 

+ Máy tìm kiếm tìm thông tin dựa trên các 

từ khóa (từ hoặc cụm từ liên quan đến vấn 

đề cần tìm kiếm). 

+ Ta thực hiện như sau: 

* Truy cập vào máy tìm kiếm Google.  

* Gõ từ khoá vào “ để nhập từ khoá. Nhấn 

phím Enter hoặc nháy nút tìm kiếm. 

HS nhận xét. 

Ghi bài. 

 

3.3. Hoạt động luyện tập. 

GV chuyển giao nhiệm vụ 6 
HS thưc hiện cá nhân.  

Yêu cầu: câu hỏi 4, sgk, trang 26? 

HS báo cáo kết quả: 

+ Để truy cập các trang web em cần sử dụng một phần mềm là trình duyệt web (web 

browser). 

+ Muốn truy cập vào một trang web ta làm như sau: 

 Nhập địa chỉ của trang web vào ô địa chỉ. 

 Nhấn Enter. 

HS nhận xét. 

GV nhận xét, chốt kiến thức. 

3.4. Hoạt động vận dụng kiến thức. 
GV chuyển giao nhiệm vụ 7  
HS thực hiện nhóm. (2 bạn cùng bàn 1 nhóm) 

Đại diện 1 nhóm báo cáo kết quả, các nhóm còn lại nhận xét. 



 

 

Yêu cầu: Trang web www.google.com.vn có thể tìm kiếm được mọi thông tin ta cần 

tìm. Đúng hay sai. Giải thích? 

HS báo cáo kết quả: 

Sai. Vì: mặc dù Internet là kho thông tin, kiến thức khổng lồ vầ mọi lĩnh vực, nhưng 

nếu chưa có cá nhân hoặc tổ chức nào chia sẻ về vấn đề mà ta quan tâm trên mạng 

internet, máy tìm keiems sẽ không có khả năng tìm thấy. 

HS nhận xét. 

GV nhận xét, chốt lại. 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà học bài cũ. 

Tìm hiểu bài mới. 

Tuần 3 

Tiết: 6 

BÀI TẬP  
I. MỤC TIÊU: 

1. Kiến thức:  

- Tổng hợp kiến thức đã học 

- Ôn luyện lại các dạng bài tập. 

2. Kỹ năng:  

- Kỹ năng chung về mạng máy tính, sử dụng dịch vụ internet, truy cập web và tìm 

kiếm thông tin trên internet 

3. Thái độ:  

- Nghiêm túc, tích cực xây dựng bài. Phát huy tính tự học, tìm tòi sáng tạo  

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

Giáo viên: Sách giáo khoa, giáo án, hình ảnh. 

Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1. Khởi động:  

Hoạt động 1. Ôn tập lý thuyết và giải quyết tình huống giáo viên nêu ra. 

Giáo viên hỏi lại học sinh các kiến thức đã học 

Học sinh suy nghĩ-nhớ lại và trả lời 

3.2. Hoạt động luyện tập:  

 

Hoạt động của GV Hoạt động của HS 

Chuyển giao nhiệm vụ 1 

Gv:  yêu cầu hs đọc thông tin SGK 
HS thực hiện nhiệm vụ 1 

http://www.google.com.vn/


 

 

? Nhắc  lại khái niệm mạng máy tính 

? Nêu lợi ích của mạng máy tính. 

- GV yêu cầu các nhóm báo cáo kết quả 

và nhận xét. 

- GV: Quan sát, đánh giá quá trình hoạt 

động của HS. Đánh giá kết quả cuối 

cùng của các nhóm. Chốt kết quả để 

vào nội dung kiên thức 

 

Chuyển giao nhiệm vụ 2 

Gv:  yêu cầu hs đọc thông tin SGK bài 

tập 2 

Hs:  đọc thông tin SGK 

? Internet là gì. 

? Nêu các dịch vụ trên internet. 

? Dịch vụ nào trên Internet được nhiều 

người sử dụng nhất. 

 

- GV yêu cầu các nhóm báo cáo kết quả 

và nhận xét. 

- GV: Quan sát, đánh giá quá trình hoạt 

động của HS. Đánh giá kết quả cuối 

cùng của các nhóm. Chốt kết quả để 

vào nội dung kiên thức 

 

 

 

Chuyển giao nhiệm vụ 3 

Gv:  yêu cầu hs đọc thông tin SGK 

? Siêu văn bản là gì. 

? Sự khác nhau giữa  siêu văn bản và 

Web. 

? Website là gì 

? Nêu cách truy cập Web 

? Ví dụ. 

? Nhắc lại cách tìm kiếm thông tin trên 

Web. 

? Nêu các bước sử dụng máy tìm kiếm. 

?  trả lời câu hỏi 4 và 5 sgk ( tr 26) 

 

 

 

GV thực hiện trên máy cho HS quan 

sát 

- HS: Đọc và tìm hiểu trả lời theo yêu 

cầu trong tài liệu. 

- HS: Thảo luận với nhau để thực hiện 

các thao tác 

- Hs quan sát kết quả và cho nhận xét  

về kết quả tìm được đó? 

- HS: chú ý lắng nghe => ghi nhớ kiến 

thức 

 

 

HS thực hiện nhiệm vụ 2 

- HS: Đọc và thảo luận với nhau để 

thực hiện các thao tác 

HS nêu nôị dung ghi nhớ  

- Khái niệm Internet.  

- Dịch vụ trên Internet 

+ Tổ chức và khai thác thông tin trên 

Web. 

+ Tìm kiếm thông tin. 

+ Thư điện tử. 

+ Hội thảo trực tuyến. 

+ Đào tạo qua mạng. 

+ Thương maịi điện tử 

Hs:   

 Quan sát kết quả và cho nhận xét  về 

kết quả tìm được đó? 

- HS: chú ý lắng nghe => ghi nhớ kiến 

thức 

HS thực hiện nhiệm vụ 3 

- HS: Đọc và thảo luận với nhau để 

thực hiện các thao tác 

HS nêu nôị dung ghi nhớ  

- Siêu văn bản 

- Web, Website. 

- Truy cập Web:   

       + Trình duyệt Web. 

( Phần mềm: Internet Explorer -> nháy 

đúp vào biểu tượng e)                               

                                

         + Truy cập: Nhập địa chỉ vào ô 

địa chỉ -> enter 

 

- Tìm kiếm thông tin: 

       +Máy tìm kiếm: ( Yahoo.com;  ...) 



 

 

- GV yêu cầu các nhóm báo cáo kết quả 

và nhận xét. 

- GV: Quan sát, đánh giá quá trình hoạt 

động của HS. Đánh giá kết quả cuối 

cùng của các nhóm. Chốt kết quả để 

vào nội dung kiên thức 

 

 

 

       + Sử dụng máy tìm kiếm:                       

( Google.com.vn; ....) 

 

HS: nhập Vietnamnet.vn 

HS: Truy cập máy tìm kiếm. ví dụ 

nhập google.com.vn tại ô đ/c. 

     Gõ từ khóa vào ô gõ từ khóa. ví dụ 

"hoa hong" -> enter. 

Quan sát kết quả và cho nhận xét  về 

kết quả tìm được đó? 

- HS: chú ý lắng nghe => ghi nhớ kiến 

thức 

 

 

4. Hướng dẫn về nhà: 

- Nhắc lại nội dung bài học và yêu cầu học sinh nắm các kĩ năng thực hiện 

- Về nhà học và thực hiện lại các bài tập. 

- Chuẩn bị tốt bài thực hành 1 

 

 

Tuần 4  

Tiết: 7, 8 

Bài thực hành 1: 

SỬ DỤNG TRÌNH DUYỆT ĐỂ TRUY CẬP WEB 
 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

 Biết các thành phần trên cửa sổ trình duyệt cốc cốc 

 Biết truy cập một số trang web để đọc thông tin, duyệt các trang web bằng các 

liên kết 

 Biết đánh dấu các trang liên kết 

 Biết lưu trữ bài viết, tranh ảnh, video trên một trang web 

2. Kĩ năng:  

 Biết tìm kiếm thông tin trên Internet, biết chọn lọc những thông tin hay. 

3. Thái độ: Tập trung lĩnh hội kiến thức, chủ động trong học tập. Sử dụng Internet 

một cách lành mạnh. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Sách giáo khoa, giáo án, hình ảnh. 

b. Học sinh: Sách giáo khoa, vở ghi. 



 

 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: Kết hợp trong bài. 

3. Tổ chức dạy học: 

3.1. Khởi động:  

 

Hoạt động của GV Hoạt động của HS 

Chuyển giao nhiệm vụ 1 

Giáo viên giới thiệu một số hình ảnh biểu 

tượng trình duyệt. 

Yêu cầu HS cho biết tên trình duyệt tương ứng 

với ảnh. 

GV đánh giá kết luận: Có rất nhiều trình duyệt 

trợ giúp việc tìm kiếm thông tin. Nhưng chúng 

đều có chức năng và cách thức sử dụng gần như 

giống nhau, chỉ khác nahu ở cách tổ chức các 

lệnh và vị trí các lệnh trên cửa sổ trình duyệt. 

Hôm nay chúng ta thực hành tìm kiếm trên trình 

duyệt Cốc Cốc. 

HS thực hiện nhiệm vụ 1 

HS báo cáo kết quả. 

HS nhận xét. 

3.2. Hoạt động luyện tập: 

Hoạt động của GV Hoạt động của HS 

 

Chuyển giao nhiệm vụ 2 

Yêu cầu: Tìm hiểu nội dung Bài 1, sgk, 

trang 29. Cho biết: 

+ Muốn khởi động Cốc Cốc  có những 

cách nào? 

+ Liệt kê các thành phần của cửa sổ 

Cốc Cốc? 

+ Trang đầu tiên sau khi khởi động Cốc 

Cốc hiển thị những gì? 

GV đánh giá nhận xét -> Chốt lại. 

Giúp đỡ HS trong quá trình thực hành. 

 

 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 3 

Yêu cầu HS: Tìm hiểu nội dung mục 2, 

Bài 1, sgk, trang 30. Thực hành trên 

HS thực hiện nhiệm vụ 2 

HS thực hiện nhóm (2 HS) 

HS báo cáo kết quả: 

+ C1: Nháy đúp chuột vào biểu tượng của 

Côc Cốc  trên màn hình nền. 

C2: Chọn Start  All Programs Cốc 

Cốc. 

+ Các  thành phần: Nút điều khiển trang, 

nút tạo trang mới (new tab), dòng ghi địa 

chỉ trang, thanh đánh dấu trang. 

+ Hiển thị trang chủ ngầm định của trình 

duyệt, có sẵn một số trang mà người dùng 

thường sử dụng, một số trang web nổi tiếng 

nhiều người hay vào. Chức năng tìm kiếm 

nằm ở giữa của trang ngầm định này. 

HS nhận xét, bổ sung. 

Thực hành trên máy, quan sát kết quả. 

Giúp đỡ các bạn thực hành. 

 

HS thực hiện nhiệm vụ 3 

HS thực hành trên máy, báo cáo kết quả: 



 

 

máy và xem kết quả khác nhau như thế 

nào? 

GV đánh giá nhận xét-> Chốt lại. 

Giúp đỡ HS trong quá trình thực hành. 

 

Chuyển giao nhiệm vụ 4 

Yêu cầu: Thực hành tìm hiểu một số 

trang web (ví dụ một số trang web bài 

2, sgk, trang 30). 

 

GV đánh giá nhận xét-> Chốt lại. 

Giúp đỡ HS trong quá trình thực hành. 

 

Chuyển giao nhiệm vụ 5 

Yêu cầu: Tìm hiểu nội dung bài 3, sgk, 

trang 30. 

+ Ý nghĩa của việc đánh dấu trang? 

+ Thực hành đánh dấu trang trên trình 

duyệt Cốc Cốc 

GV kết luận: Các trình duyệt khác cũng 

có chức năng đánh dấu trang, thực hiện 

tương tự Cốc Cốc. 

Giúp đỡ HS trong quá trình thực hành. 

 

Chuyển giao nhiệm vụ 6 

Yêu cầu: Tìm hiểu nội dung bài 4, sgk, 

trang 31. 

+ Thực hành lưu trang web, hành ảnh, 

video, … trên trình duyệt Cốc Cốc 

Giúp đỡ HS trong quá trình thực hành. 

GV đánh giá nhận xét-> Chốt lại. 

+ Khi nháy nút phải chuột và chon “mở 

liên kết trong tab mới”, thì thông tin liên 

kết sẽ hiện thị qua tab mới. 

Giúp đỡ các bạn thực hành. 

 

HS thực hiện nhiệm vụ 4 

HS thực hành trên máy, báo cáo kết quả. 

+ Gõ địa chỉ một số trang web vào trình 

duyệt, quan sát kết quả. 

Giúp đỡ các bạn thực hành. 

 

 

HS thực hiện nhiệm vụ 5 

HS thực hành trên máy, báo cáo kết quả: 

+ Đánh dấu trang lưu lại địa chỉ các trang 

để sau này có thể nhanh chóng tìm lại. 

+ Thực hành đánh dấu một số trang trên 

trình duyệt Cốc Cốc. 

Giúp đỡ các bạn thực hành. 

 

 

 

HS thực hiện nhiệm vụ 6 

HS thực hành trên máy, báo cáo kết quả: 

+ Lưu trang web, hình ảnh, video, … theo 

hướng dẫn sgk. 

Giúp đỡ các bạn thực hành. 

 

 

3.3. Hoạt động vận dụng kiến thức. 
GV chuyển giao nhiệm vụ 7  
HS thực hành trên máy. (2 HS) 

Yêu cầu: Truy cập trang web www.bepgiadinh.com, tìm hiểu thông tin các mục trên 

trên trang này. Lưu một số hình ảnh hay video yêu thích về máy. 

Giúp đỡ các bạn thực hành. 

GV đánh giá nhận xét-> Chốt lại. 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà thực hành thành thạo các thao tác đã học. chuẩn bị bài thực hành 2. 

 

Tuần 5  

Tiết: 9, 10 

Bài thực hành 2: 

http://www.bepgiadinh.com/


 

 

TÌM KIẾM THÔNG TIN TRÊN INTERNET 
 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  
- Biết tìm kiếm thông tin trên Internet nhờ máy tìm kiếm 

- Biết được các thành phần và ý nghĩa của các thành phần có trên máy tìm kiếm 

- Biết tìm kiếm thông tin trên Internet nhờ máy tìm kiếm 

- Biết được các thành phần và ý nghĩa của các thành phần có trên máy tìm kiếm 
2. Kĩ năng:  

 Biết tìm kiếm thông tin trên Internet, biết chọn lọc những thông tin hay. 

3. Thái độ: Tập trung lĩnh hội kiến thức, chủ động trong học tập. Sử dụng Internet 

một cách lành mạnh. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Giáo án, SGK, phòng máy. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: Kết hợp trong bài. 

3. Tổ chức dạy học: 

3.1. Khởi động:  

GV phân bố HS ngồi vào máy tính cho phù hợp. 

GV cùng HS nhắc lại một số trình duyệt Internet và máy tìm kiếm. 

HS khởi động máy tính. 

3.2. Hoạt động luyện tập: 

Hoạt động của GV Hoạt động của HS 

*Tìm kiếm thông tin đơn giản 

trên web.  

Chuyển giao nhiệm vụ 1 

- Yêu cầu HS thực hiện (bài 1, sgk, 

trang 32) tìm kiếm thông tin với từ 

khoá là máy tính? 

- Hãy quan sát kết quả và cho nhận 

xét về kết quả tìm được đó? 

-  Nhận xét và chốt lại. 

Giúp đỡ HS trong quá trình thực 

hành. 

 

 

 

 

 

HS thực hiện nhiệm vụ 1 

HS thực hành trên máy. 

HS báo cáo kết quả: 

B1: Mở trình duyệt Web. 

B2:  Mở máy tìm kiếm. 

B3: Gõ từ khoá vào ô tìm kiếm. 

B4: Nhấn Enter hoặc nháy vào tìm kiếm 

B5: Kết quả được hiển thị chọn địa chỉ trang 

web liên quan. 

*Nhận xét kết quả tim kiếm: 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*Cách sử dụng từ khóa để tìm 

kiếm thông tin.  

Chuyển giao nhiệm vụ 2 

Yêu cầu HS:  

+ Hãy thực hiện (bài 2, sgk, trang 

33), tìm kiếm thông tin với từ khoá 

là cảnh đẹp sapa. 

+ Quan sát kết quả và cho nhận xét 

về kết quả tìm được đó? 

GV đánh giá, nhận xét, chốt lại. 

Giúp đỡ HS trong quá trình thực 

hành. 

 

*Tìm kiếm hình ảnh, video.  

Chuyển giao nhiệm vụ 3 

Yêu cầu: Hãy thực hiện bài tập 3, 

sgk, trang 34 tìm kiếm từ khóa cây 

xanh, kết quả tìm được là hình ảnh 

hoặc video. 

GV đánh giá, nhận xét, chốt lại. 

Giúp đỡ HS trong quá trình thực 

hành. 

 

 

*Tìm video thông qua trang 

Youtube.  

Chuyển giao nhiệm vụ 4 

 
Với từng kết quả, Google hiển thị các thông 

tin có dạng: 

1/ Tiêu đề của trang web. 

2/ Đoạn văn bản trên trang web chứa từ khóa. 

3/ Địa chỉ của trang web. 

Mỗi kết quả tìm kiếm có rất nhiều trang tìm 

kiếm. Mỗi trang kết quả thường hiển thị 10 

kết quả tìm kiếm. 

 
Thực hành trên máy, quan sát kết quả. 

Giúp đỡ các bạn thực hành. 

 

HS thực hiện nhiệm vụ 2 

HS thực hành trên máy, báo cáo kết quả: 

*Nhận xét: 

Khi để cụm từ trong dấu ngoặc kép, VD: 

“cảnh đẹp Sapa”, kết quả tìm kiếm sẽ chính 

xác hơn. 

 

Giúp đỡ các bạn thực hành. 

 

 

 

 

 

 

HS thực hiện nhiệm vụ 3 

HS thực hành trên máy, báo cáo kết quả. 

Các bước thực hiện: 

B1: Gõ từ khóa cây xanh vào máy tìm kiếm. 

B2: Nháy vào mục Hình ảnh hoặc Video để 

lọc các thông tin là hình ảnh / video. 

 
 

Giúp đỡ các bạn thực hành. 



 

 

Yêu cầu: Hãy thực hiện bài tập 4, 

sgk, trang 35. 

 GV đánh giá, nhận xét, chốt lại. 

GV giúp đỡ HS trong quá trình thực 

hành. 

 

 

HS thực hiện nhiệm vụ 4 

HS thực hành trên máy, báo cáo kết quả. 

Các bước thực hiện: 

B1: Tìm địa chỉ: www.youtube.com. 

B2: Gõ từ khóa vào ô tìm kiếm  nhấn Enter. 

*Kết quả tìm được là tất cả các video có liên 

quan đến từ khóa. 

 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà thực hành thành thạo các thao tác đã học. xem trước bài mới. 

 

 

 

Tuần 6  

Tiết: 11, 12 

Bài 4: TÌM HIỂU THƯ ĐIỆN TỬ 
I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  
- Biết lợi ích của thư điện tử 

- Biết khái niệm thư điện tử và quy trình hoạt động của hệ thống thư điện tử 

- Biết tạo tài khoản thư điện tử 

- Biết các thao tác gửi, nhận, trả lời thư điện tử 
2. Kĩ năng:  

 Biết đăng ký một hộp thư điện tử mới. 

 Biết xem, soạn và gửi thư điện tử. 

3. Thái độ: Tập trung lĩnh hội kiến thức, chủ động trong học tập. Sử dụng Internet 

một cách lành mạnh. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Giáo án, SGK, ảnh mô tả. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: Kết hợp trong bài. 

3. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện cá nhân. 

Yêu cầu: 

http://www.youtube.com/


 

 

+ Từ xa xưa ông cha ta thực hiện trao đổi thông tin cần thiết bằn cách nào? 

+ Khi thực hiện trao đổi thông tin với hệ thống dịch vụ như thế thì điều gì xảy ra? 

+ Ngày này, để khắc phục các khó khăn trên thì con người sử dụng phương tiện gì 

để trao đổi? 

HS thực hiện, báo cáo kết quả: 

+ Thời xa xưa, sử dụng thư tay, bằng các hệ thống dịch vụ xã hội như bưu điện, 

chuyển phát nhanh. 

+ Quá trình trao đổi thông tin chậm, dễ sai sót. 

+ Khắc phục: Sử dụng thư điện tử nhờ vào sự ra đời của Internet với ưu điểm: 

Chi phí thấp. 

Thời gian chuyển gần như tức thời. 

Một người có thể gửi đồng thời cho nhiều người khác với một nội dung. 

Có thể gửi kèm tệp tin.  

GV, HS nhận xét. 

GV kết luận: Để gửi/nhận thư điện tử thì quá trình thực hiện như thế nào? Chúng ta 

cùng tìm hiểu. 

3.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

1. Hệ thống thư điện tử  

Chuyển giao nhiệm vụ 2 

- Yêu cầu: Em hãy quan sát hình 

1.40, sgk, trang 37 và mô tả lại quá 

trình gửi một bức thư từ Hà Nội đến 

thành phố Hồ Chí Minh bằng 

phương pháp truyền thống? 

 
Mời đại diện 1 nhóm trả lời, các 

nhóm còn lại nhận xét, bổ sung. 

GV nhận xét và kết luận: 

Với những khó khăn đã nêu trước, 

ngày nay gửi thư tay đã hạn chế 

được sử dụng, từ khi mạng máy 

tính, đặc biệt là Internet ra đời thư 

điện tử hầu như thay thế thư tay. 

 

Chuyển giao nhiệm vụ 3 

- Yêu cầu: Em hãy quan sát hình 

1.41, sgk, trang 37 và mô tả lại quá 

trình gửi thư/ nhận thư điện tử. 

 

HS thực hiện nhiệm vụ 2 

HS thực hiện nhóm nhỏ (2 HS cùng bàn) 

Báo cáo kết quả:  

1. Người bỏ thư đã có địa chỉ chính xác của 

người nhận vào thùng thư. 

2. Nhân viên bưu điện tại Hà Nội tập hợp mọi 

thư cần gửi vào thành phố Hồ Chí Minh. 

3. Thư được chuyển vào thành phố Hồ Chí 

Minh qua hệ thống vận chuyển của bưu điện. 

4. Nhân viên bưu điện tại thành phố Hồ Chí 

Minh chuyển đến tay người nhận. 

HS nhận xét. 

 

 

 

 

 

 

 

 

 

HS thực hiện nhiệm vụ 3 

HS thực hiện nhóm nhỏ (2 HS cùng bàn) 

Báo cáo kết quả:  

1/ Người gửi tạo thư gửi (trên máy tính người 

gửi). 



 

 

 
Mời đại diện 1 nhóm trả lời, các 

nhóm còn lại nhận xét, bổ sung. 

GV nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài. 

 

 

 

 

 

 

 

 

2. Tạo tài khoản, gửi và nhận thư 

điện tử.  

* Tạo tài khoản thư điện tử.  

Chuyển giao nhiệm vụ 4 

Yêu cầu HS:  

+ Đọc thông tin sgk, mục 2/a, trang 

38.  

+ Để có thể gửi/nhận thư điện tử, 

trước hết người gửi/ người nhận phải 

có gì? 

+ Có thể mở  tài khoản thư điện tử 

miễn phí với nhà cung cấp nào mà 

em biết? 

+ Sau khi mở tài khoản, nhà cung cấp 

dịch vụ cấp cho người dùng cái gì? 

+ Một hộp thư điện tử có địa chỉ như 

thế nào? 

GV đánh giá nhận xét -> Chốt kiến 

thức. 

Gv hướng dẫn HS ghi bài. 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 5 

2/ Xác định địa chỉ của người nhận, gửi thư 

qua máy chủ thư điện tử của người nhận. 

3/ Tự động gửi thư bằng đường Internet đến 

máy chủ thư điện tử người nhận. 

4/ Người nhận nhận thư trên  máy chủ thư 

điện tử người nhận. 

HS nhận xét. 

 

Ghi bài. 

+ Các máy chủ được cài đặt phần mềm quản lí 

thư điện tử, được gọi là máy chủ điện tử, sẽ 

đóng vai trò là bưu điện, còn hệ thống vận 

chuyển của bưu điện chính là mạng máy tính. 

Cả người gửi và người nhận đều sử dụng máy 

tính với các phần mềm thích hợp để soạn, gửi 

và nhận thư. 

 

 

HS thực hiện nhiệm vụ 4 

HS thực hiện cá nhân. 

Báo cáo kết quả. 

 

+ Mở  tài khoản thư điện tử. 

 

 

+ Yahoo, google, Microsoft,... 

 

 

+ Cung cấp 1 hộp thư điện tử trên máy chủ 

điện tử. 

 

+ <Tên đăng nhập>@<Tên máy chủ lưu hộp 

thư>. 

Nhận xét. 

Ghi bài  
Mở tài khoản thư điện tử: 

- Sử dụng yahoo, google,… để mở tài khoản 

điện tử miễn phí. 

- Hộp thư được gắn với một địa chỉ thư điện tử 

có dạng: <Tên đăng nhập>@<Tên máy chủ 

lưu hộp thư>. 

 

HS thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 

Báo cáo kết quả: 



 

 

Yêu cầu: Hãy phân biệt hai khái 

niệm: hộp thư điện tử và địa chỉ thư 

điện tử. 

GV đánh giá nhận xét -> Chốt kiến 

thức. 

 

* Nhận và gửi thư.  

Chuyển giao nhiệm vụ 6 

Yêu cầu: 

+ Để mở hộp thư điện tử ta làm như 

thế nào? 

 

 

 

 

 

+ Dịch vụ thư điện tử cung cấp các 

chức năng chính nào? 

 

 

 

 

 

 

+ Để gửi thư điện tử đến đúng 

người nhận, người gửi phải làm như 

thế nào? 

 

GV đánh giá nhận xét -> Chốt kiến 

thức. 

Hướng dẫn HS ghi bài. 

 

 

 

 

+ Địa chỉ thư điện tử: Dùng để phận biệt 

người dùng khác nhau trong hệ thống mạng. 

+ Hộp thư điện tử: Là nơi lưu trữ các thư 

điện tử của người dùng. 

Nhận xét. 

HS thực hiện nhiệm vụ 6 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

B1: Truy cập trang web cung cấp dịch vụ thư 

điện tử. 

B2: Đăng nhập hộp thư điện tử (gõ tên đăng 

nhập + mật khẩu), nhấn Enter hoặc nút Đăng 

nhập. 

+ Cung cấp các chức năng chính sau: 

1/ Mở  và xem danh sách các thư đã nhận và 

được lưu trong hộp thư. 

2/ Mở và đọc nội dung của một thư cụ thể. 

3/ Soạn thư và gửi thư cho một hoặc nhiều 

người. 

4/ Trả lời thư. 

5/ Chuyển tiếp thư cho một người khác. 

+ Người gửi phải ghi rõ địa chỉ thư điện tử 

của người nhận. 

Nhận xét. 

Ghi bài: 

Nhận và gửi thư: 

Các bước truy cập vào hộp thư điện tử: 

1. Truy cập trang web cung cấp dịch vụ thư 

điện tử. 

2. Đăng nhập vào hộp thư điện tử bằng cách 

gõ tên đăng nhập (tên người dùng), mật khẩu 

rồi nhấn Enter (hoặc nháy vào nút đăng 

nhập). 

 

 

3.3. Hoạt động luyện tập.  

Chuyển giao nhiệm vụ 8 

HS thực hiện nhóm nhỏ (2 HS cùng bàn). 

Yêu cầu: Thực hiện bài tập 2, sgk, trang 39. 

HS báo cáo kết quả: 



 

 

 
 

GV đánh giá nhận xét -> Chốt kiến thức. 

3.4. Hoạt động vận dụng kiến thức.  
Chuyển giao nhiệm vụ 9 

HS thực hiện nhóm nhỏ (2 HS cùng bàn). 

Yêu cầu: Thực hiện bài tập 5, sgk, trang 39. 

HS báo cáo kết quả: 

+ Mỗi địa chỉ thư điện tử bao gồm hai phần:  

<tên hộp thư/tên đăng nhập>@<tên máy chủ lưu hộp thư>.  

Vì <tên hộp thư> là duy nhất trong máy chủ thư điện tử, <tên máy chủ lưu hộp 

thư> là duy nhất trên mạng Internet, do đó  địa chỉ thư điện tử sẽ là duy nhất trên 

mạng Internet. 

GV đánh giá nhận xét -> Chốt kiến thức. 

 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà học bài cũ. Xem trước bài mới. 

 

 

Tuần 7  

Tiết: 13, 14 

BÀI THỰC HÀNH 3: 

SỬ DỤNG THƯ ĐIỆN TỬ 

I. MỤC TIÊU BÀI HỌC: 



 

 

1. Kiến thức:  
- Biết cách tạo tài khoản và đăng nhập vào hộp thư điện tử miễn phí 

- Thực hiện được các thao tác: Mở hộp thư điện tử đã đăng ký, đọc, soạn và gửi thư 

điện tử. 

- Thực hiện được các thao tác: gửi thư điện tử và trả lời thư. 
2. Kĩ năng:  

 Thực hiện các thao đăng kí hộp thư điện tử miễn phí, mở hộp thư điện tử đã đăng kí. 

3. Thái độ: Sử dụng Internet một cách lành mạnh. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

 Thực hành. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Giáo án, SGK. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ:  

Giáo viên Học sinh 

Yêu cầu: 

+ Để mở tài khoản thư điện tử, 

ta phải làm thế nào? 

+ Địa chỉ thư điện tử có dạng 

như thế nào? 

Mời 1 HS lên bảng trả lời. 

Nhận xét, đánh giá, cho điểm. 

Thực hiện yêu cầu. 

Kết quả: 

+ Để mở tài khoản thư điện tử, ta phải đăng ký 

với nhà cung cáp dịch vụ Internet hoặc với một 

nhà cung cấp dịch vụ thư điện tử trên Internet. 

+ Thư điện tử có dạng: 

<tên đăng nhập>@<tên máy chủ thư điện tử> 

HS nhận xét, sửa chữa. 

 

3. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện trên máy cá nhân. 

Yêu cầu: 

+ Khởi động máy tính. 

+ Mở website mail.google.com. 

HS thực hiện. 

3.2. Hoạt động luyện tập: 

Hoạt động của GV Hoạt động của HS 

*Tạo tài khoản thư điện tử  

Chuyển giao nhiệm vụ 2 

Yêu cầu học sinh đọc thông tin bài 1, 

sgk, trang 41. 

 

 

HS thực hiện nhiệm vụ 2 

HS thực hiện máy tính cá nhân. 



 

 

- Yêu cầu: Đăng ký tài khoản với 

Gmail. 

 

Hướng dẫn HS tạo tài khoản. 

GV nhận xét, đánh giá -> Chốt kiến 

thức 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GV nêu chú ý: Quan trọng nhất là tên 

đăng nhập và mật khẩu. Cần phải điền 

đủ và đúng thông tin trên mức  và ghi 

nhớ tên đăng nhập và mật khẩu để sử 

dụng hộp thư. 

 

Báo cáo kết quả:  

1. Truy nhập trang web www.google.com.vn  

2. Nháy chuột vào mục Gmail ở hàng trên 

cùng.  

Trang web sẽ xuất hiện. 

 

 
3. Nháy nút tạo tài khoản để đăng kí hộp thư 

mới 

4. Nhập các thông tin cần thiết vào mẫu đăng 

kí như hình: 

 

5. Nhập các kí tự để xác minh từ. 

 

6. Đọc các mục trong “ Điều khoản phục vụ, 

sau đó nháy nút tôi chấp nhận, hãy tạo tài 

khoản của tôi. 

http://www.google.com.vn/


 

 

 

 

 

 

 

 

 

 

 

 

*Đăng nhập và đọc thư.  

Chuyển giao nhiệm vụ 3 

Yêu cầu học sinh đọc thông tin bài 2, 

sgk, trang 42. 

- Yêu cầu: Đăng nhập tài khoản thư 

điện tử đã đăng ký ở bài 1, đọc các 

thư. 

Hướng dẫn HS thực hành. 

 

GV nhận xét, đánh giá -> Chốt kiến 

thức 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Giúp đỡ các bạn thực hành. 

HS thực hiện nhiệm vụ 3 

HS thực hành trên máy tính cá nhân. 

Báo cáo kết quả:  

1/ Gõ tên đăng nhập vào “ Tên người dùng và 

mật khẩu vào “ Mật Khẩu rồi nhần Enter. 

  

 
2/ Hộp thư điện tử Gmail của bạn sẽ mở ra: 

 
 

3/ Nháy chuột trên tiêu đề thư để đọc thư. 

Giúp các bạn thực hành. 

 

HS thực hiện nhiệm vụ 4 

HS thực hành máy tính cá nhân. 

Báo cáo kết quả. 

Để soạn và gửi thư, ta thực hiện: 

1/ Nháy mục soạn thư  để soạn 

một thư mới. Cửa sổ soạn thư sẽ được mở. 



 

 

 

*Soạn và gửi thư điện tử.  

Chuyển giao nhiệm vụ 4 

Yêu cầu HS:  

+ Yêu cầu học sinh đọc thông tin bài 

3, sgk, trang 43. 

+ Yêu cầu: Hãy soạn thư mới (gởi 

kèm file word bất kỳ lưu trong máy 

tính) cho người nhận có địa chỉ: 

kieudiemtk2018@gmail.com. 

Hướng dẫn HS thực hành. 

GV chú ý: Xem lại thư đã gửi ở mục 

‘đã gửi’ bên trái. 

 

 

 

 

 

 

 

 

 

*Trả lời thư.  

Chuyển giao nhiệm vụ 5 

Yêu cầu HS:  

+ Yêu cầu học sinh đọc thông tin bài 

4, sgk, trang 44. 

+ Yêu cầu: Hãy đọc một thư đến và 

trả lời thư đó. 

Hướng dẫn HS thực hành. 

GV nêu chú ý: 

+ Có thể gửi đồng thời một thữ hco 

nhiều người. Khi đó, nút lệnh trả 

lwoif thư sẽ có nhiều lựa chon Relly/ 

Relly All. 

+ Khi Không sử dụng hộp thư nữa, 

cần đăng xuất (Sign out) để đóng hộp 

thư điện tử, tránh bị người khác sử 

dụng. 

 

GV nhận xét, đánh giá -> Chốt kiến 

thức 

 
2/ Gõ địa chỉ của người nhận vào ô Tới, gõ tiêu 

đề thư vào ô chủ đề và nội dung thư vào vùng 

trống phía dưới. Chọn tệp file đính kèm bằng 

cách nháy vào nút lệnh  

3/ Nháy nút Gửi để gửi thư. 

 

HS thực hiện nhiệm vụ 5 

HS thực hành trên máy tính cá nhân. 

Báo cáo kết quả: 

1.Nháy chuột trên liên kết để mở thư cần trả 

lời. 

2. Nháy nút Trả lời (Re) . Quan sát thấy địa chỉ 

người gửi được tự điền vào ô Tới 

3. Gõ nội dung trả lời thư  vào ô phía dưới 

Nháy nút Gửi để gửi thư. 

 

Giúp đỡ các bạn thực hành. 

 

 

3.3. Hoạt động vận dụng kiến thức. 
4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  



 

 

HS về nhà thực hành thành thạo các thao tác. Xem trước bài mới. 

 

 

 

 

Tuần 8  

Tiết: 15, 16 

CHƯƠNG II: MỘT SỐ VẤN ĐỀ XÃ HỘI CỦA TIN HỌC. 

BÀI 5: BẢO VỆ THÔNG TIN MÁY TÍNH 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  
- Biết sự cần thiết phải bảo vệ thông tin máy tính 

- Biết các yếu tố cơ bản ảnh hưởng đến an toàn thông tin máy tính 

- Biết khái niệm virus máy tính 

- Biết tác hại của virus máy tính 

- Biết được các con đường lây lan của virus máy tính và nguyên tắc phòng ngừa 
2. Kĩ năng:  

 Biết bảo vệ được máy tính. Biết cách sao lưu dữ liệu và phòng tránh virus.. 

3. Thái độ: 

- Nghiêm túc trong thực hành. Nhận thức được vai trò quan trọng của máy tính. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

 Thực hành. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Giáo án, SGK, chuẩn bị phòng máy. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện nhóm nhỏ (2 bạn cùng bàn). 

Yêu cầu: Tìm hiểu nội dung hoạt động (?), sgk, trang 46. Và trả lời các câu hỏi. 

HS thực hiện. Báo cáo kết quả: 

+ Thông tin trong máy tính được lưu trữ dưới dạng các tệp và thư mục. 

+ Thông tin máy tính có thể bị mất, hư hỏng do nhiều nguyên nhân khác nhau. Cần 

quan tâm tới việc bảo vệ thông tin máy tính bằng cách sao lưu dữ liệu thường xuyên 

và phòng tránh vius. 

GV, HS nhận xét. 



 

 

GV kết luận: Bài học sẽ tìm hiểu các cách phòng ngừa các yếu tố ảnh hưởng đến an 

toàn thông tin máy tính. 

 

 

3.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

1. Một số yếu tố ảnh hưởng đến sự an 

toàn của thông tin máy tính. 

Chuyển giao nhiệm vụ 2  
Yêu cầu học sinh đọc thông tin mục 1, 

sgk, trang 47. 

Yêu cầu: 

+ Nêu các yếu tố chính ảnh hưởng đến sự 

an toàn của thông tin máy tính. 

+ Phân tích từng yếu tố. 

GV mời đại diện mỗi nhóm trình bày mỗi 

yếu tố. 

 

GV nhận xét -> chốt kiến thức. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 3  

Yêu cầu: Để hạn chế những yếu tố gây 

hại cho máy tính, ta cần có các biện pháp 

gì để phòng tránh? 

 

GV nhận xét -> chốt kiến thức. 

Nhắc nhở HS: Có ý thức sử dụng và bảo 

quản máy tính, thông tin máy tính một 

cách hợp lý. 

 

 

HS thực hiện nhiệm vụ 2 

HS thực hiện nhóm nhỏ (2 bạn cùng bàn). 

Báo cáo kết quả:  

+ Thông tin máy tính có thể bị mất hoặc hư 

hỏng do các yếu tố công nghệ - vật lý, yếu 

tố bảo quản, sử dụng hoặc virus máy tính. 

út tạo tài khoản để đăng kí hộp thư mới 

+ Phân tích các yêu tố: 

1/ Yếu tố công nghệ - vật lý: 

+ Các thiết bị điện tử được sản xuất ra chưa 

đảm bảo. 

+ Máy tính, nhất là các thiết bị lưu trữ dữ 

liệu cũng có “tuổi thọ” nhất định. Chỉ cần 

một vùng nhỏ của thiết bị lưu trữ bị hỏng 

cũng đã có thể gây ra sự cố không đọc được 

thông tin lưu trên đó. 

+ Các phần mềm có thể không tương thích 

với nhau. 

2/ Yếu tố bảo quản, sử dụng: 

+ Để máy tính nơi ẩm thấp, nhiệt độ cao, bị 

ánh nắng chiếu vào sẽ làm giảm tuổi thọ của 

máy. 

+ Máy tính bị ướt, bị va đạp mạnh. 

3/ Virus máy tính: 

Virus xâm nhập có thể làm mất thông tin 

máy tính với những hậu quả nghiệm trọng, 

đơ máy, ... 

Nhận xét. 

HS thực hiện nhiệm vụ 3 

HS thực hiện cá nhân. 

Báo cáo kết quả:  

+ Các biện pháp phòng tránh: tập thói quen 

sao lưu dữ liệu (tạo bản sao của các tệp và 

lưu ở ổ đĩa khác) và phòng chống virut máy 

tính. 

Nhận xét. 

Ghi bài. 



 

 

Hướng dẫn HS ghi bài. 

 

2. Virus máy tính và cách phòng 

tránh. 

Chuyển giao nhiệm vụ 4  
Yêu cầu hs đọc thông tin mục 2a, sgk, 

trang 48. 

+ Giới thiệu một số file trong máy bị 

nhiễm virus.  

 

 

 
 

 

+ Virus máy tính là gì ? 

+ Vật mang virus là những vật nào? 

Nhận xét. 

Hướng dẫn HS ghi bài. 

Chuyển giao nhiệm vụ 5 (20 phút) 

Yêu cầu học sinh đọc thông tin mục 2b, 

sgk, trang 48. 

Yêu cầu:  

+ Hãy nêu những tác hại của virus máy 

tính mà em biết? 

+ Cùng HS phân tích các tác tại. 

 

GV nhận xét -> chốt kiến thức. 

Hướng dẫn HS ghi bài. 

 

Chuyển giao nhiệm vụ 6  
Yêu cầu học sinh đọc thông tin mục 2c, 

sgk, trang 48. 

Yêu cầu:  

+ Em hãy kể những con đường lây lan 

của Virus máy tính mà em biết?  

+ Cùng HS phân tích. 

 

GV nhận xét -> chốt kiến thức. 

Hướng dẫn HS ghi bài. 

 

 

 

 

 

HS thực hiện nhiệm vụ 4 

HS thực hiện cá nhân. 

Báo cáo kết quả. 

+ Quan sát hình ảnh máy tính, các file bị 

nhiễm virus. 

+ Virus máy tính (gọi tắt là virus) là một 

chương trình hay đoạn chương trình có khả 

năng tự nhân bản hay sao chép chính nó từ 

đối tượng bị lây nhiễm này sang đối tượng 

khác mỗi khi đối tượng bị lây nhiễm được 

kích hoạt. 

+ Vật mang virus có thể là các tệp chương 

trình, văn bản, bộ nhớ và một số thiết bị máy 

tính (đĩa cứng, đĩa mềm, thiết bị nhớ 

flash,...). 

Nhận xét. 

Ghi bài. 

 

 

HS thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

+ Tiêu tốn tài nguyên hệ thống, phá huỷ dữ 

liệu, phá huỷ hệ thống, đánh cắp dữ liệu, mã 

hoá dữ liệu để tống tiền, gây khó chịu khác. 

Nhận xét. 

Ghi bài. 

 

 

HS thực hiện nhiệm vụ 6 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

+ Qua việc sao chép tệp đã bị nhiễm virus. 

+ Qua các phần mềm bẻ khoá, các phần 

mềm sao chép lậu. 

+ Qua các thiết bị nhớ di động. 

+ Qua mạng nội bộ, mnạg Internet, đặc biệt 

là thư điện tử. 

+ Qua "lỗ hỗng" phần mềm. 



 

 

 

Chuyển giao nhiệm vụ 7  
Yêu cầu học sinh đọc thông tin mục 2d, 

sgk, trang 48. 

Yêu cầu:  

+ Muốn phòng tránh virus em phải làm 

như thế nào?. 

+ GV giới thiệu một số phần mềm diệt 

vius. 

 

GV nhận xét -> chốt kiến thức. 

Kết luận: Cần cập nhật thường xuyên 

phần mềm diệt virus. 

 

 

 

Nhận xét. 

Ghi bài. 

HS thực hiện nhiệm vụ 7 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

1. Hạn chế việc sao chép không cần thiết và 

không nên chạy các chương trình tải từ 

Internet ... 

2. Không mở những tệp gửi kèm trong thư 

điện tử nếu có ... 

3. Không truy cập các trang web không rõ 

nguồn gốc. 

4. Thường xuyên cập nhật các bản sửa lỗi 

cho các phần mềm ... 

5. Định kì sao lưu dữ liệu để có thể khôi 

phục khi bị virus phá hoại.  

6. Định kì quét và diệt virus bằng các phần 

mềm diệt virus 

Nhận xét. 

Ghi bài. 

 

3.3. Hoạt động luyện tập.  

Tổng kết lại các kiến thức vừa học. 

GV nêu chú ý: Trong bối cảnh giao lưu thông tin ngày càng mở rộng, việc máy tính 

bị lây nhiễm virus là không thể tránh khỏi. Do vậy, không nên quá hốt hoảng, trong 

chừng mực nào đó, phải biết sống chung với virus máy tính nhưng cũng không được 

quá chủ quan. Điều cơ bản nhất là cần biết cách phòng tránh và tìm diệt kịp thời bằng 

phần mềm diệt virus. 

3.4. Hoạt động vận dụng kiến thức. 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà thực hành thành thạo các thao tác. Xem trước bài mới. 

 

 

 

 

Tuần 9  

Tiết: 17 

ÔN TẬP GIỮA KỲ I 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

 - Hs nắm một số kiến thức, kỹ năng cơ bản phổ thông về mạng, Internet và lợi ích của 

mạng máy tính. 

 - Biết khái niệm về mạng máy tính, mạng thông tin toàn cầu Internet và lợi ích của 

chúng. 



 

 

 - Biết các khái niệm Siêu văn bản, trang Web, địa chỉ trang Web, địa chỉ Website. 

 - Biết chức năng trình duyệt Web. 

 - Biết cách sử dụng máy tìm kiếm, đăng nhập, soạn thư , gửi thư điện tử 

 - Biết bảo vệ thông tin máy tính. 

2. Kỹ năng:  

- Sử dụng được trình duyệt Web. 

- Thực hiện được việc tìm kiếm thông tin trên Internet để xem và tìm kiếm thông tin 

trên Internet. 

- Thực hiện được việc tạo hộp thư, gửi và nhận thư điện tử trên mạng Internet. 

3. Thái độ: 

- Có thái độ nghiêm túc khi học và làm việc trên máy tính. 

- Có ý thức trong việc sử dụng thông tin trên Internet để ứng dụng trong việc học tập 

vui chơi giải trí hằng ngày. 

- Thông qua Internet HS hiểu biết thêm và có ý thức trong việc sử dụng máy tính đúng 

mục đích và cách bảo vệ virus máy tính 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

 Thực hành. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Giáo án, SGK, chuẩn bị phòng máy. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1. Hoạt động khởi động: 

3.2. Hoạt động hình thành kiến thức: 

 

Hoạt động của GV Hoạt động của HS 

Bài 1 – Từ máy tính đến mạng máy tính 

Chuyển giao nhiệm vụ 1  
Dùng hệ thống câu hỏi để ôn tập cho HS 

- Khái niệm mạng máy tính và các thành 

phần của mạng máy tính? 

- Lợi ích của mạng máy tính? 

GV nhận xét, chốt lại 

HS thực hiện nhiệm vụ 1 

HS thực hiện cá nhân. 

- Học sinh trả lời câu hỏi, nhận xét 

và ghi nhớ nội dung bài học. 

Bài 2 – Mạng thông tin toàn cầu Internet 

Chuyển giao nhiệm vụ 2  HS thực hiện nhiệm vụ 2 



 

 

- Khái niệm mạng Internet? 

- Liệt kê một số dịch vụ trên Internet và 

lợi ích khi sử dụng các dịch vụ này? 

- Liệt kê một số ứng dụng trên Internet 

và lợi ích khi sử dụng các ứng dụng 

này? 

GV nhận xét, chốt lại 

HS thực hiện cá nhân. 

- Học sinh trả lời câu hỏi, nhận xét 

và ghi nhớ nội dung bài học 

Bài 3 – Tổ chức và truy cập thông tin trên Internet 

Chuyển giao nhiệm vụ 3  
- Siêu VB là gì? 

- Trang Web là gì? Địa chỉ trang Web là 

gì? 

- Website là gì? Địa chỉ Website là gì? 

- Chức năng của trình duyệt Web? 

- Trình bày cách thực hiện các bước để: 

+ Truy cập vào trang web?  

+ Sử dụng máy tìm kiếm? 

GV nhận xét, chốt lại 

HS thực hiện nhiệm vụ 3 

HS thực hiện cá nhân. 

- Học sinh trả lời câu hỏi, nhận xét 

và ghi nhớ nội dung bài học 

Bài 4 – Tìm hiểu thư điện tử 

Chuyển giao nhiệm vụ 4  

- Khái niệm thư điện tử? 

- Thao tác đăng nhập, mở đọc thư, gửi 

thư? (Y/c hs lên thực hiện trên máy tính) 

- Y/c hs nêu lên các bước để mở hộp thư 

điện tử. 

- Dịch vụ thư điện tử cung cấp các chức 

năng chính nào? Phân biệt khái niệm hộp 

thư và địa chỉ thư điện tử. 

- Việc tạo và gửi thư điện tử giữa các nhà 

cung cấp dịch vụ thư điện tử. (ví dụ: hai 

nhà cung cấp dịch vụ thư điện thử khác 

nhau có tạo tên đăng nhập giống nhau hay 

gửi thư cho nhau được không) 

GV nhận xét, chốt lại 

HS thực hiện nhiệm vụ 3 

HS thực hiện nhóm. 

- Làm theo y/c 

 

 

- Làm theo y/c 

Bài 5 – Bảo vệ thông tin máy tinh 

Chuyển giao nhiệm vụ 5  
- Virus máy tính là gì?  

- Nêu các tác hại của virus máy tính và 

các con đường lây lan của virus máy 

tính? 

HS thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 

- Học sinh trả lời câu hỏi, nhận xét 

và ghi nhớ nội dung bài học 



 

 

- Nguyên tắc chung cơ bản nhất để 

phòng tránh virus là gì? 

GV nhận xét, chốt lại 

 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

- Các em ôn lại tất cả những kiến thức đã học. 

- Tiết sau kiểm tra giữa học kì I. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tuần 9  

Tiết: 18 

 

KIỂM TRA GIỮA KÌ I 
I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Củng cố và kiểm tra được việc lĩnh hội kiến thức của học sinh qua các bài đã học 



 

 

2. Kỹ năng: Rèn cho hs kỹ năng trình bày bài làm, vận dụng kiến thức đã học vào để 

trả lời từng câu hỏi cụ thể. 

3. Thái độ: Giáo dục hs tính cẩn thận, chính xác, ý thức kỷ luật, nghiêm túc trong 

kiểm tra thi cử. 

4. Định hướng phát triển năng lực cho HS: 

Năng tự chủ chủ và tự học 

II. CHUẨN BỊ: 

 1. Giáo viên: Ma trận, bảng đặc tả, đề kiểm tra giữa kỳ I, đáp án, biểu điểm cụ thể. 

 2. Học sinh: Kiến thức, đồ dùng học tập. 

III. HÌNH THỨC ĐỀ KIỂM TRA 

- Hình thức: TNKQ + Tự luận. 

- Học sinh làm bài trên máy tính. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 
MA TRẬN ĐỀ KIỂM TRA GIỮA HỌC KÌ I 

 NĂM HỌC 2023 - 2024 

MÔN: TIN HỌC LỚP 9  – THỜI GIAN LÀM BÀI: 45 phút  

 

 

TT 

(1) 

Chương/ 

chủ đề  

(2) 

Nội dung/đơn vị 

kiến thức 

(3) 

Mức độ nhận thức 

 

Tổng 

% điểm 

 

Nhận biết Thông hiểu Vận dụng Vận dụng cao  

TNKQ TL TNKQ TL TNKQ 
TL 

TNKQ 
TL 

 

1 

Chương 1: 

Mạng máy 

tính và 

internet 

Bài 1: Từ mạng 

máy tính đén mạng 

máy tính 

1  1      
1 điểm 

10% 

Bài 2: Mạng thông 

tin toàn cầu 

internet 

2  1      
1.5 điểm 

15% 

Bài 3: Tổ chức và 

truy cập thông tin 

trên internet 

2     1   
2 điểm 

20% 

Bài 4: Tìm hiểu thư 

điện tử 

 

1  1     1 
2.5 điểm 

25% 



 

 

BTH3: Sử dụng 

thư điện tử 
     1   

0.5 điểm 

5% 

     2 Chương 2: 

Một số vấn 

đề xã hội 

của tin học 

Bài 5: Bảo vệ thông 

tin máy tính 
 1 1 1     

2.5 điểm 

25% 

Tổng câu 6 1 4 1  2  1 15 

Tổng điểm 4 3 2 1 10 

Tỉ lệ % 40% 30% 20% 10% 100% 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

BẢNG ĐẶC TẢ  ĐỀ KIỂM TRA GIỮA HỌC KÌ I 

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9  – THỜI GIAN LÀM BÀI 45 phút 

 

 

Chủ đề Nội dung Mức độ đánh giá 

Số câu hỏi theo mức độ nhận 

thức 

Nhận 

biết 

Thông 

hiểu 

Vận 

dụng 

Vận 

dụng 

cao 

Chương 

1: Mạng 

máy tính 

và 

internet 

Bài 1: Từ mạng 

máy tính đén mạng 

máy tính 

Nhận biết 

-Biết được các thiết bị của các thành phần kết nối vào mạng. 

Thông hiểu 

- Công dụng các lợi ích của mạng máy tính 

 

1TN 1TN   

Bài 2: Mạng thông 

tin toàn cầu 

internet 

Nhận biết 

-Biết khái niệm internet 

-Biết tác dụng của các dịch vụ và ứng dụng trên internet. 

Thông hiểu 

Hiểu các dịch vụ và ứng dụng trên internet 

2TN 1TN   

Bài 3: Tổ chức và 

truy cập thông tin 

trên internet 

Nhận biết 

Biết khái niệm website; trang web; các trình duyệt web 

Vận dụng 

Các thao tác tìm thông tin bằng máy tìm kiếm; truy cập một trang 

web; 

2TN  1TL  

Bài 4: Tìm hiểu thư 

điện tử 

 

Nhận biết 

Biết nhận dạng địa chỉ thư điện tử 

Thông hiểu 

1TN 1 TN  1TL 



 

 

Hiểu các lỗi trong quá trình gửi thư; 

Vận dụng cao 

Đăng kí tài khoản thư điện tử và gửi thư với các nhà cung cấp 

dịch vụ thư điện tử khác nhau 

BTH3: Sử dụng thư 

điện tử 

Vận dụng 

Các bước mở hộp thư  điện tử;  

Soạn và gửi thư điện tử 

  1TL  

Chương 

2: Một số 

vấn đề xã 

hội của 

tin học 

Bài 5: Bảo vệ thông 

tin máy tính 

Nhận biết 

Virus máy tính. Nguyên tắc chung cơ bản phòng tránh virus 

Thông hiểu 

- Biểu hiện của các tác hại virus máy tính 

- Tác hại của virus và các con đường lây lan của virus máy tính. 

1TL 
1TN 

+1TL 
  

Tổng số câu 
6TN 

+1TL 

4TN 

+1TL 
2TL 1TL 

Tổng số điểm 4 3 2 1 

Tỉ lệ % 40% 30% 20% 10% 

 

 



 

 

(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1. Trong các thiết bị dưới đây, thiết bị nào không phải là thiết bị kết nối 

mạng?  

A. Modem. B. Vỉ mạng. C. Webcam. D. Hub. 

Câu 2. Người dùng có thể tiếp cận và chia sẻ thông tin một cách nhanh chóng, tiện 

lợi, không phụ thuộc vào vị trí địa lý khi người dùng kết nối vào đâu?   

A. Laptop. B. Máy tính. C. Mạng máy tính. D. Internet. 

Câu 3. Truy cập internet để nghe các bài giảng, trao đổi hoặc các tài liệu học tập 

khác thuộc ứng dụng nào trên internet.  

A. Mạng xã hội. B. Đào tạo qua mạng.  

C. Hội thảo trực tuyến. D. Các diễn đàn. 

Câu 4. Trang web là gì?  

A. Một siêu văn bản được gắn địa chỉ truy cập trên internet. 

B. Một phần mềm ứng dụng giúp người dùng giao tiếp với hệ thống www. 

C. Một hoặc nhiều trang chủ trên internet. 

D. Một hoặc nhiều trang web có chung địa chỉ truy cập trên internet. 

Câu 5. Virus có thể thiết lập các chế độ ẩn cho tệp tin và thư mục thuộc tác hại 

nào của virus máy tính?  

A. Gây các hiện tượng khó chịu khác  B. Tiêu tốn tài nguyên hệ thống 

C. Đánh cắp dữ liệu D. Phá hủy hệ thống  

Câu 6. Vì sao việc mở các tệp không rõ nguồn gốc đính kèm theo thư điện tử có 

thể có những tác hại nguy hiểm?  

A. Vì các tệp đính kèm theo thư điện tử thường là nguồn lây nhiễm của virus máy tính. 

B. Vì khi mở tệp đính kèm, em phải trả thêm tiền dịch vụ. 

C. Vì các tệp đính kèm theo thư điện tử chiếm dung lượng trên đĩa cứng. 

 D. Vì việc mở tệp đính kèm sẽ chiếm hết dung lượng đường truyền. 

Câu 7. Đâu không phải là một trình duyệt Web? 

A. Cốc cốc.        B. Google.com.vn.  C. Opera. D. Firefox. 

Câu 8. Chia sẻ máy in, bộ nhớ, các ổ đĩa để người dùng trên mạng có thể dùng 

chung thuộc lợi ích gì của mạng máy tính?  

A. Dùng chung dữ liệu. B. Trao đổi thông tin. 

C. Dùng chung các phần mềm. D. Dùng chung các thiết bị phần cứng. 

Câu 9. Khi đặt mua bộ quần áo qua Internet, em đã sử dụng ứng dụng nào?  

A. Trò chuyện trực tuyến. B. Tìm kiếm thông tin trên Internet. 

C. Hội thảo trực tuyến. D. Thương mại điện tử. 

Họ và tên:……………………….…… 

 Lớp: …..…                   MÃ ĐỀ A 

 KIỂM TRA GIỮA KÌ I NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút 

        (Không kể thời gian giao đề)    

Điểm 



 

 

Câu 10. Trình bày cú pháp địa chỉ thư điện tử tổng quát:  

A. < lop9.2 > @ < yahoo.com > 

B. < Tên đăng nhập > @ < Tên máy chủ thư  điện tử> 

C. < Tên đăng nhập > @ < gmail.com > 

D. < Tên đăng nhập > và < Tên máy chủ thư điện tử> 

II. Phần tự luận: (5 điểm) 

Câu 11. (1 điểm) Virus máy tính là gì?  

Câu 12. (1 điểm) Nêu các tác hại của virus máy tính?  

Câu 13. (1 điểm) Em hãy trình bày cách thực hiện các bước để: Sử dụng máy tìm kiếm? 

Câu 14. (1 điểm) Em hãy trình bày cách thực hiện các bước để: Mở hộp thư  điện tử? 

Câu 15. (1 điểm) Bạn Trang đã đăng kí một tài khoản thư điện tử trên trang 

web mail.google.com. Trang cho rằng mình không thể gửi thư điện tử cho Long, vì 

Long chỉ có hộp thư điện tử trên outlook.com.vn,  nghĩa là chỉ có thể gửi được thư điện 

tử cho những người có hộp thư được đăng kí với cùng nhà cung cấp dịch vụ (trong 

trường hợp này là Gmail). Theo em, ý kiến của bạn Trang có đúng không? Vì sao? 

 

-------------- Hết ---------- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 



 

 

Câu 1. Máy tính có hiện tượng chạy rất chậm, bị treo hoặc tự động tắt máy hay 

khởi động lại thuộc tác hại nào của virus máy tính?  

A. Tiêu tốn tài nguyên hệ thống B. Phá hủy dữ liệu 

C. Phá hủy hệ thống D. Đánh cắp dữ liệu 

Câu 2. Em sưu tầm được nhiều ảnh đẹp muốn gửi cho bạn bè ở nhiều nơi em 

dùng dịch vụ gì?  

A. Tìm kiếm thông tin trên internet. B. Thư điện tử.  

C. Tổ chức và khai thác thông tin trên web. D. Thương mại điện tử. 

Câu 3. Có thể trao đổi thông tin giữa các máy tính thông qua thư điện tử hoặc 

phần mềm trò chuyện trực tuyến thuộc lợi ích gì của mạng máy tính?  

A. Dùng chung các thiết bị phần cứng.  B. Dùng chung dữ liệu.  

C. Trao đổi thông tin. D. Dùng chung các phần mềm. 

Câu 4. Hệ thống kết nối các máy tính và mạng máy tính ở quy mô toàn thế giới 

gọi là gì?  

A. Thương mại điện tử.    B. Trao đổi thông tin.  

C. Internet. D. Mạng máy tính.  

Câu 5. Sau khi gửi thư điện tử cho bạn, em nhận được thông báo từ hệ thống thư 

điện tử cho biết không thể chuyển thư điện tử em đã gửi tới người nhận. Hãy 

chọn lí do đúng.  

A. Em ghi sai địa chỉ hộp thư điện tử của người nhận mà địa chỉ này không tồn tại trên 

mạng. 

B. Người nhận đã dùng một địa chỉ thư điện tử khác. 

C. Người nhận chưa mở thư ra đọc. 

D. Máy chủ thư điện tử của bạn khác với máy chủ thư điện tử của em. 

Câu 6. Website là:  

A. Một phần mềm ứng dụng giúp người dùng giao tiếp với hệ thống www. 

B. Một hoặc nhiều trang web liên quan tổ chức dưới một địa chỉ truy cập chung. 

C. Gồm nhiều trang web liên quan với nhau. 

D. Một hoặc nhiều trang chủ trên internet. 

Câu 7. Đâu là một trình duyệt web? 

A. Pascal. B. Yahoo.com.vn.      

C. Google.com.vn.   D. FireFox. 

Câu 8. Trong các thiết bị dưới đây, thiết bị nào không phải là thiết bị đầu cuối?  

A. Máy in. B. Máy tính. C. Tivi. D. Modem. 

Câu 9. Dịch vụ được nhiều người sử dụng nhất để xem thông tin trên internet:  

A. Tổ chức và khai thác thông tin trên web.   B. Thư điện tử. 

C. Tìm kiếm thông tin trên internet.    D. Facebook, zalo. 

Câu 10. Địa chỉ thư điện tử được phân cách bởi kí hiệu: 

A. $ B. @ C. # D. & 

II. Phần tự luận: (5 điểm) 

Họ và tên:……………………….…… 

 Lớp: …..…                   MÃ ĐỀ B 

 KIỂM TRA GIỮA KÌ I NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút 

        (Không kể thời gian giao đề)    

Điểm 



 

 

Câu 11. (1 điểm)  Nguyên tắc chung cơ bản nhất để phòng tránh virus máy tính là gì?  

Câu 12. (1 điểm)  Nêu các con đường lây lan của virus máy tính? 

Câu 13. (1 điểm) Em hãy trình bày cách thực hiện các bước để: Truy cập vào trang 

web?  

Câu 14. (1 điểm) Em hãy trình bày cách thực hiện các bước để: Soạn và gửi thư điện 

tử ? 

Câu 15. (1 điểm) Bạn Trang đã đăng kí một tài khoản thư điện tử trên trang 

web mail.google.com với tên tài khoản là Trang_thcs_cva@gmail.com. Nhưng Giáo 

viên bắt tạo tài khoản mail outlook của Microsoft, Trang định lấy tên 

Trang_thcs_cva@outlook.com.vn. Theo em, bạn Trang có thể sử dụng tên tài khoản 

outlook trùng với tên tài khoản Gmail được không? Vì sao? 

 

-------------- Hết ---------- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

ĐÁP ÁN ĐỀ KIỂM TRA GIỮA HỌC KÌ I  

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9 

Thời gian: 45 phút (không kể thời gian giao đề) 

 

MÃ ĐỀ A 

I. Phần trắc nghiệm (5 điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án C D B A A A B D D B 

 

II. Phần tự luận: (5 điểm) 

 



 

 

Câu Đáp án, hướng dẫn chấm Điểm 

11 

(1đ) 

* Virus máy tính (gọi tắt là virus) là một chương trình hay đoạn 

chương trình có khả năng tự nhân bản hay sao chép chính nó từ đối 

tượng bị lây nhiễm này sang đối tượng khác mỗi khi đối tượng bị 

lây nhiễm (vật mang virus) được kích hoạt. 

 

 

1 

 

 

12 

(1đ) 

* Các tác hại của virus máy tính: 

- Tiêu tốn tài nguyên hệ thống. 

- Phá hủy dữ liệu. 

- Phá hủy hệ thống. 

- Đánh cắp dữ liệu. 

- Mã hóa dữ liệu để tống tiền. 

- Gây các hiện tượng khó chịu khác. 

1 

13 

(1đ) 

* Cách sử dụng máy tìm kiếm: 

◦ Truy cập máy tìm kiếm.( ví dụ google) 

◦ Gõ từ khóa vào ô dành để nhập từ khoá. 

 ◦ Nhấn phím Enter hoặc nháy nút Tìm kiếm. 

 

0.25 

0.5 

0.25 

14 

(1đ) 

*Truy cập vào hộp thư  điện tử như sau: 

 ◦ 1. Truy cập trang web cung cấp dịch vụ thư điện tử. 

 ◦ 2. Đăng nhập vào hộp thư điện tử bằng cách gõ tên đăng nhập, 

mật khẩu rồi nhấn Enter (hoặc nháy nút Đăng nhập) 

 

0.25 

 

0.75 

15 

(1đ) 

Ý kiến của bạn Trang không đúng. Chúng ta có thể gửi thư điện tử 

cho bất cứ người nào có địa chỉ thư điện tử, không phụ thuộc địa 

chỉ đó được đăng kí với nhà cung cấp dịch vụ nào.  

1 

 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

ĐÁP ÁN ĐỀ KIỂM TRA GIỮA HỌC KÌ I  

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9 

Thời gian: 45 phút (không kể thời gian giao đề) 

 

MÃ ĐỀ B 

I. Phần trắc nghiệm (5 điểm)  mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án A B C C A B D D A B 

 

II. Phần tự luận: (5 điểm) 

 

Câu Đáp án, hướng dẫn chấm Điểm 



 

 

11 

(1đ) 

* Nguyên tắc chung cơ bản nhất để phòng tránh virus: 

Luôn cảnh giác và ngăn chặn virus trên chính những đường lây 

lan của chúng. 

 

 

1 

 

12 

(1đ) 

* Các con đường lây lan của virus: 

- Qua việc sao chép tệp đã bị nhiễm virus. 

- Qua các phần mềm bẻ khóa, các phần mềm sao chép lậu. 

- Qua các thiết bị nhớ di động. 

- Qua mạng nội bộ, mạng Internet, đặc biệt là thư điện tử. 

- Qua các "lỗ hổng" phần mềm. 

1 

13 

(1đ) 

 * Muốn truy cập một trang web : 

1. Nhập địa chỉ của trang web (https://shopee.vn ) vào ô địa chỉ. 

2.Nhấn enter. 

 

 

0.75 

0.25 

14 

(1đ) 

* Cách soạn và gửi thư điện tử  

1. Đăng nhập vào hộp thư, sau đó nháy lên nút soạn thư (compose) 

ở khung cửa sổ bên trái để mở cửa sổ soạn thảo thư. 

2. Khi soạn xong nội dung, nháy chuột lên nút Gửi (Send) để gửi 

thư. 

 

0.75 

 

0.25 

15 

(1đ) 

Bạn Trang được phép tạo tên tài khoản giống nhau vì hai tài 

khoản được tạo trên hai máy chủ thư điện tử khác nhau nên vẫn 

có thể sử dụng tên tài khoản giống nhau.  

1 

 

 

 

Tuần 10  

Tiết: 19, 20 

Bài thực hành 4 

SAO LƯU DỰ PHÒNG VÀ QUÉT VIRUS 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  
- Biết các thao tác sao lưu các tệp/thư mục bằng sao chép thông thường 

- Hiểu ý nghĩa các tùy chọn trên một số phần mềm quét virus máy tính 
2. Kĩ năng:  

 Thực hiện thành thạo các thao tác sao lưu và diệt virus máy tính. 

3. Thái độ: 

- Nghiêm túc trong thực hành. Nhận thức được vai trò quan trọng của máy tính. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

https://shopee.vn/


 

 

 Thực hành. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

c. Giáo viên: Giáo án, SGK, chuẩn bị phòng máy. 

d. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

5. Ổn định:  

6. Kiểm tra bài cũ: (không) 

7. Tổ chức dạy học: 

7.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện cá nhân. 

Yêu cầu: Nêu 2 thao tác cơ bản để bảo vệ an toàn thông tin máy tính? 

HS thực hiện. Báo cáo kết quả: 

+ Thực hiện sao lưu dữ liệu thường xuyên. 

+ Quét virus máy tính. 

GV, HS nhận xét. 

GV kết luận: Bài học hôm nay chúng ta sẽ thực hành sao lưu dữ liệu dự phòng và 

quét virus. 

 

 

 

 

 

 

 

7.2. Hoạt động luyện tập: 

 

Hoạt động của GV Hoạt động của HS 

 

Bài 1. Lưu trữ dự phòng bằng 

phương pháp sao chép thông 

thường. 

Chuyển giao nhiệm vụ 2  
Yêu cầu HS đọc thông tin (phần đầu 

bài 1, sgk, trang 52). 

Giới thiệu cho HS vì sao các dữ liệu 

lưu trữ trên ổ đĩa C dễ bị mất, hư hỏng 

nhất. 

Chuyển giao nhiệm vụ 3  
Yêu cầu:  

+ Đọc và tìm hiểu các bước sao lưu dữ 

liệu sgk, trang 52. Cho biết sao lưu dữ 

liệu là thực hiện công việc gì? 

 

 

HS thực hiện nhiệm vụ 2 

HS thực hiện cá nhân. 

Nghiên cứu nội dung sgk theo yêu cầu GV. 

Lắng nghe và khắc sâu kiến thức. 

 

 

 

 

 

HS thực hiện nhiệm vụ 3 

HS thực hiện cá nhân. 

Tìm hiểu các bước thực hiện sao lưu dữ liệu. 

Báo cáo kết quả: 

+ Sao lưu dữ liệu là sao chép các tệp/ thư 

mục ra nhiều vị trí khác nhau trong máy tính, 



 

 

Nhận xét, chốt lại kiến thức. 

 

+ Nhắc lại cách tạo một thư mục mới, 

sao chép, dán tệp/ thư mục? 

Nhận xét, chốt lại kiến thức. 

 

 

 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 4  
+ Hướng dẫn lại các bước HS cần 

thực hiện trên bảng. 

Giúp đỡ HS thực hành. 

 

 

 

 

 

 

 

 

 

 

 

Bài 2. Quét Virus.  

Chuyển giao nhiệm vụ 5  

+ Gv giới thiệu một số phần mềm diệt 

virus. 

+ Yêu cầu: HS đọc nội dung Bài 2 

trang 52+53, SGK. 

+ Giới thiệu sơ lược lại cách sử dụng 

phần mềm Bkav. 

+ Khởi động phần mềm BkavHome 

và thực hành các thao tác. 

Nêu lưu ý:  

+ Không chọn Xóa tất cả Macro vì 

các chương trình ứng dụng trong MS 

Office và các kết quả làm việc có thể 

hoặc từ máy tính sang các thiết bị nhớ khác 

như đĩa, USB, … 

+ Tạo thư mục mới: 

1/ Tìm tới ổ đĩa cần tạo thư mục mới (My 

Computer/ File Explorer). 

2/ Nháy nút ‘New Folder’ trên thanh chọn. 

hoặc nháy chuột phải  new  Folder. Thực 

hiện đổi tên thư mục. 

Nhận xét. 

+ Sao chép: 

Chọn tệp/ thư mục cần sao chép  nháy 

chuột phải chọn Copy (Ctrl+C) tới vị trí 

cần lưu  nháy chuột phải chọn Paste 

(Ctrl+V). 

Nhận xét. 

HS thực hiện nhiệm vụ 4 

+ HS khởi động máy tính và thực hiện các 

thao tác. 

1- Khởi động Windows Explorer, tạo thư 

mục Tailieu_hoctap trên ổ đĩa C:\. Sao chép 

một vài tập tin vào thư mục vừa tạo; 

2- Tạo một thư mục mới trên ổ đĩa D:\ với tên 

Sao_luu; 

3- Sao chép các tập tin trong thư mục 

Tailieu_hoctap vào thư mục Sao_luu. 

Giúp đỡ các bạn thực hành. 

 

 

 

 

 

HS thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 

Nghiên cứu nội dung theo yêu cầu. 

Tìm hiểu cơ bản cách sử dụng phần mềm 

Bkav. 

1- Khởi động chương trình quét và diệt virus 

BKAV. 



 

 

chứa nhiều macro (những đoạn 

chương trình tiện ích) hữu ích. 

+ Thườn xuyên vào địa chỉ  
http://www.bkav.vn/home/Download.aspx 

để tải về bản mới nhất. 

 

Hướng dẫn, quan sát HS thực hành. 

 

Nhận xét, chốt lại kiến thức. 

Sau khi khởi động màn hình làm việc của 

BKAV xuất hiện như sau: 

 

2- Chọn tùy chọn Tất cả ổ cứng và USB để 

quét virus. 

Lưu ý: không nên chọn Xóa tất cả Macro. 

3- Quan sát quá trình quét virus của chương 

trình. Cuối cùng nháy nút Thoát để kết thúc 

quá trình diệt virus. 

Lưu ý: có thể tải BKAV từ địa chỉ:  

http://www.bkav.vn/home/Download.aspx 

Thực hành, giúp đỡ các bạn thực hành. 

 

8. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà thực hành thành thạo các thao tác. Xem trước bài mới. 

 

 

 

 

 

Tuần 11  

Tiết: 21, 22 

BÀI 6: TIN HỌC VÀ XÃ HỘI 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

 Nhận thức được tin học và máy tính ngày nay là  động lực cho sự phát triển xã hội 

 Biết được xã hội tin học hóa là nền tảng cơ bản cho sự phát triển nền kinh tế tri 

thức 

 Xu hướng nổi bật của cuộc cách mạng công nghiệp lần thứ tư 

 Nhận thức được thông tin là tài sản chung của mọi người, của toàn xã  hội và mỗi 

cá nhân trong xã hội tin học hoá cần có trách nhiệm đối với thông tin được đưa lên 

mạng và Internet 

2. Kĩ năng:  

 Tích cực tìm tòi; có ý thức ứng dụng tin học trong học tập và đời sống. 

http://www.bkav.vn/home/Download.aspx
http://www.bkav.vn/home/Download.aspx


 

 

3. Thái độ: 

- Nghiêm túc, tích cực trong học tập. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: Giáo án, SGK. 

b. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1. Khởi động:  

Chuyển giao nhiệm vụ 1 

HS thực hiện nhóm nhỏ (2 bạn cùng bàn). 

Yêu cầu: Trả lời các câu hỏi 

+ Em có thể kể ra những ứng dụng của tin học trong thực tế mà em biết? 

+ Ngoài các máy tính còn có nhiều thiết bị gắn các bảng mạch có thể điều khiển dược 

bằng phần mềm cũng được coi là các thiết bị máy tính. Em có biết thiết bị nào như 

vậy không? 

HS thảo luận. 

GV mời đại diện 2 nhóm trả lời 2 câu hỏi. 

Báo cáo kết quả: 

+Ứng dụng tin học: Học tập trên internet; liên lạc với bạn bè qua facebook; các công 

ty quản lý nhân viên bằng phần mềm trên máy tính; … 

+ VD: Máy rửa chén tự động; Robot lau nhà tự động; cửa tự động đóng mở; ... 

GV, HS nhận xét. 

GV kết luận: Tin học là lĩnh vực rất non trẻ, song hiện đang đóng vai trò hết sức to lớn 

trong xã hội. Trong bài học hôm nay chúng ta sẽ đi tìm hiểu về Vai trò của Tin học và 

máy tính trong xã hội hiện đại. 

3.2. Hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

1. Tin học trong xã hội hiện đại.  

 

Chuyển giao nhiệm vụ 2  
Yêu cầu học sinh tim hiểu thông tin 

mục 1a, sgk, trang 54. 

Yêu cầu: 

+ Hãy nêu một số ứng dụng của tin 

học trong đời sống? Cho ví dụ. 

GV mời đại diện mỗi nhóm trình bày 

mỗi ứng dụng. 

 

 

HS thực hiện nhiệm vụ 2 

HS thực hiện nhóm nhỏ (2 bạn cùng bàn). 

Báo cáo kết quả:  

+ Tin học đã được ứng dụng trong mọi lĩnh 

vực của xã hội như: nhu cầu cá nhân, quản lý, 

điều hành và phát triển kinh tế của đất nước. 

Trong gia đinh như: các thiết bị thông minh. 



 

 

 

GV đánh giá, nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài. 

 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 3 

Yêu cầu học sinh tim hiểu thông tin 

mục 1b, sgk, trang 55, 56. 

Yêu cầu: 

+ Nêu những tác động của tin học đối 

với xã hội. Phân tích từng nội dung. 

GV mời đại diện mỗi tác động và 

phân tích. 

 

GV đánh giá, nhận xét -> Chốt lại. 

Tóm lại: Tin học và máy tính ngày 

nay đã thật sự trở thành động lực và 

lực lượng sản xuất, góp phần phát 

triển kinh tế và xã hội. 

Hướng dẫn HS ghi bài. 

 

2. Kinh tế tri thức và xã hội tin học 

hóa.  

Chuyển giao nhiệm vụ 4  
Yêu cầu hs đọc thông tin mục 2a, sgk, 

trang 57. 

Yêu cầu: 

+ Em hãy cho biết mục đích học của 

em để làm gì? 

+ Em hiểu kinh tế tri thức là gì? 

 

GV đánh giá, nhận xét -> Chốt lại. 

Kết luận: Tin học và máy tính là cơ sở 

của sự ra đời và phát triển của nền 

kinh tế tri thức. 

 

 

 

Chuyển giao nhiệm vụ 5  

+ Sự phát triển các mạng máy tính, đặc biệt là 

Internet, làm cho việc ứng dụng tin học ngày 

càng phổ biến. Vd: Ứng dụng văn phòng hay 

thiết kế; mua hàng online; ứng dụng điều 

khiển các thiết bị phức tạp như tên lửa, tàu vũ 

trụ, ... 

+ Tin học và mạng máy tính đang thúc đẩy 

việc truyền bá thông tin và tri thức. Vd: Giúp 

con người vượt qua sự ngăn cách về địa lí, sự 

hạn chế về thời gian; hàng triệu trang web 

giúp kết nối như Facebook, Zalo, ... 

Nhận xét. 

HS thực hiện nhiệm vụ 3 

HS thực hiện cá nhân. 

Báo cáo kết quả:  

1/ Ứng dụng tin học giúp tăng hiệu quả sản 

xuất, hiệu quả cung cấp dịch vụ và quản lý. 

2/ Sự phát triển của tin học cũng làm thay đổi 

nhận thức và cách thức tổ chức, vận hành các 

hoạt động xã hội. 

3/ Thay đổi phong cách sống của con người. 

4/ Tin học và máy tính ngày nay cũng đang 

góp phần thúc đẩy sự phát triển mạnh mẽ của 

hầu hết các lĩnh vực khoa học công nghệ 

cũng như khoa học xã hội. 

 Phân tích từng tác động cụ thể. 

Nhận xét. 

Ghi bài. 

 

 

HS thực hiện nhiệm vụ 4 

HS thực hiện cá nhân. 

Báo cáo kết quả. 

+ Tim hiểu nội dung GV yêu cầu. 

+ Học để có kiến thức, có kiến thức có thể 

làm giàu cho bản thân và góp phần vào sự 

phát triển của xã hội. Vậy nên kiến thức (tri 

thức) có ảnh hưởng rất lớn đến sự phát triển 

kinh tế, xã hội của đất nước. 

+ Kinh tế tri thức là nền kinh tế mà trong đó 

tri thức là yếu tố quan trọng trong việc tạo ra 

của cải vật chất và tinh thần của xã hội. Trong 

đó tin học và máy tính đóng vai trò chủ đạo. 

Nhận xét. 

Ghi bài. 



 

 

Yêu cầu học sinh đọc thông tin mục 

2b, sgk, trang 57. 

Yêu cầu:  

+ Xã hội tin học hóa là gì? 

 

+ Việc ứng dụng tin học trong xã hội 

tin học hóa đem lại lợi ích gì? 

 

GV đánh giá, nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài. 

 

 

 

*Cuộc cách mạng công nghiệp lần 

thứ tư.  

Chuyển giao nhiệm vụ 6  
Yêu cầu học sinh đọc thông tin mục 3, 

sgk, trang 57. 

Yêu cầu:  

+Em hãy cho biết cuộc cách mạng 

công nghiệp lần thứ nhất, thứ 2, thứ 

3? 

+ Cho biết cuộc cách mạng công 

nghiệp lần thứ 4 (hay còn gọi công 

nghiệp thế hệ 4.0)? 

GV đánh giá, nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài. 

 

3. Con người trong xã hội tin học 

hóa  
Giới thiệu: Sự ra đời của internet đã 

tạo ra không gian mới đó là không 

gian điện tử. 

Chuyển giao nhiệm vụ 7  
Yêu cầu học sinh đọc thông tin mục 4, 

sgk, trang 58. 

Yêu cầu:  

+ Không gian điện tử là gì? 

 

 

+ Xã hội tin học hóa là gì? 

 

+ Kể một tình huống mà em cho là 

đẹp (chưa đẹp) trong ứng xử văn hóa 

HS thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

+ Xã hội tin học hóa là xã hội mà các hoạt 

động chính của nó được điều hành với sự hỗ 

trợ của các hệ thống tin học, các mạng máy 

tính kết nối thông tin liên vùng, liên quốc gia. 

+ Tin học được ứng dụng vào mọi lĩnh vực 

đời sống của xã hội, nâng cao hiệu quả công 

việc, giảm nhẹ công việc chân tay, nặng nhọc, 

nguy hiểm … giúp nâng cao chất lượng cuộc 

sống của con người. 

Nhận xét. 

Ghi bài. 

 

 

HS thực hiện nhiệm vụ 6 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

+ Hai cuộc cách mạng đầu tiên gắn với sự ra 

đời của đầu máy hơi nước và máy phát điện 

để hổ trợ sức lao động bằng cơ bắp. 

+ Cuộc cách mạng lần thứ ba gắn với sự ra 

đời của máy tính điện tử. 

+ Cuộc cách mạng lần thứ tư kết hợp giữa thế 

giới ảo và các thực thể, vạn vật kết nối 

Internet và các hệ thống kết nối Internet. 

Nhận xét. 

Ghi bài. 

 

 

 

 

 

HS thực hiện nhiệm vụ 7 

HS thực hiện cá nhân. 

Tìm hiểu nội dung yêu cầu. 

Báo cáo kết quả: 

+ Không gian điện tử là khoảng không gian 

của nền kinh tế tri thức, sự lưu thông hàng 

hóa diễn ra toàn cầu. 

+ Xã hội tin học hóa là xã hội mà các hoạt 

động chính của nó được điều hành với sự hỗ 

trợ của tin học và mạng máy tính. 



 

 

giữa các thành viên tham gia diễn 

đàn? 

+ Mỗi cá nhân khi tham gia vào 

internet cần tuân thủ điều gì? 

 

 

 

 

 

 

GV đánh giá, nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài 

+ HS kể tình huống. 

+ Mỗi cá nhân cần: 

1/ Có ý thức bảo vệ thông tin và các nguồn tài 

nguyên thông tin. 

2/ Có trách nhiệm với thông tin đưa lên mạng 

internet. 

3/ Có văn hóa trong ứng xử trên môi trường 

internet và có ý thức tuân thủ pháp luật (Luật 

Giao dịch điện tử, Luật Công nghệ thông tin) 

4/ Cần cảnh giác hiện tượng lừa đảo, xuyên 

tạc, thông tin không chính xác trên internet. 

Nhận xét. 

Ghi bài. 

 

3.3. Hoạt động luyện tập.  

Chuyển giao nhiệm vụ 8 

Yêu cầu HS trả lời câu hỏi 3, sgk, trang 59. 

HS trả lời: 

Trong nền kinh tế tri thức, tri thức – sản phẩm của tư duy, của lao động trí óc đóng 

vai trò chủ đạo. Trong xã hội tin học hóa, việc ứng dụng tin học giúp nâng cao năng 

suất và hiệu quả công việc, giải phóng lao động chân tay, đặc biệt là những công việc 

nguy hiểm, nặng nhọc, để con người có thể tập trung vào những công việc đòi hỏi tư 

duy. 

GV, HS nhận xét.  

3.4. Hoạt động vận dụng kiến thức.  
Chuyển giao nhiệm vụ 9 

Yêu cầu HS trả lời câu hỏi 4, sgk, trang 59. 

HS trả lời: 

Thông tin là tài sản chung, là nguyên liệu để tạo tri thức, là nguồn lực phát triển xã 

hội loài người. Cùng với sự phát triển của Internet, sẽ không có biên giới nào ngăn 

cản các dòng thông tin trên mạng. Mỗi thông tin bất kì được đưa lên mạng chỉ sau vài 

giây đã có hàng chục người đọc được và con số này có thể tăng với tốc độ hàm mũ 

theo thời gian. Do vậy phải có trách nhiệm với mỗi thông tin đưa lên mạng. 

HS, GV nhận xét. 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới:  

HS về nhà học bài cũ. Xem trước bài mới. 

 

 

Tuần 12  

Tiết: 23, 24 

CHƯƠNG III: PHẦN MỀM TRÌNH CHIẾU 

Bài 7: PHẦN MỀM TRÌNH CHIẾU  
I. MỤC TIÊU: 

1. Kiến thức 



 

 

- Biết được mục đích sử dụng các công cụ hỗ trợ trình bày và phần mềm trình chiếu 

là công cụ hỗ trợ hiệu quả nhất 

- Biết được một số chức năng chính của phần mềm trình chiếu nói chung 

- Biết được các thành phần cơ bản của màn hình làm việc trong phần mềm trình chiếu 

PowerPoint 

- Biết một số lĩnh vực có thể sử dụng phần mềm trình chiếu một cách hiệu quả 

2. Kỹ năng:  

- Nhận biết một số phần mềm trình chiếu để sử dụng vào việc học tập trình chiếu 

3. Thái độ: 

- Học sinh nhận thức được vai trò của phần mềm trình chiếu như là một cộng cụ 

hiệu quả để hỗ trợ trình bày, thuyết trình. 

II. CHUẨN BỊ: 

- Giáo viên: Giáo án + tài liệu tham khảo 

- Học sinh: tham khảo trước nội dung ở nhà 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ: kiểm tra thông qua bài học 

3. Bài mới 

3.1 Hoạt động khởi động:  
GV: Em hãy kể những hoạt động trao đổi thông tin trong giao tiếp hằng ngày diễn ra 

quanh em 

HS: thảo luận, báo cáo kết quả 

HS khác nhận xét, bổ sung 

GV: nhận xét, kết luận 

GV giới thiệu bài mới ‘phần mềm trình chiếu’ 

3.2 Hoạt động hình thành kiến thức: 

Hoạt động của giáo viên Hoạt động của học sinh 

1. Tìm hiểu trình bày và công cụ hổ trợ trình bày 

Chuyển giao nhiệm vụ 1 

Yêu cầu: 

 

- Trình bày là gì? Nêu vài ví dụ minh 

họa? 

 

 

 

- Em thường sử dụng những công cụ 

hổ trợ nào khi trình bày? 

- Em hãy nêu một vài công cụ hỗ trợ 

trình bày mà em biết? 

- Để máy tính trở thành công cụ hổ 

trợ trình bày có hiệu quả thì máy tính 

cần có gì? 

- Phần mềm trình chiếu là gì? 

HS thực hiện nhiệm vụ 1 

HS thảo luận nhóm đôi 

Báo cáo kết quả 

- Trình bày là hình thức chia sẻ kiến thức 

hoặc ý tưởng với một hoặc nhiều người 

khác 

Ví dụ: giải bài toán trên bảng cho cả lớp 

cùng theo dõi,... 

- Em thường sử dụng những công cụ hổ 

trợ như: bảng, hình vẽ, biểu đồ khi trình 

bày 

- Một vài công cụ hỗ trợ trình bày mà em 

biết: đèn chiếu, bản đồ trên khổ giấy lớn...  

- Phần mềm trình chiếu là công cụ hổ trợ 

trình bày một cách hiệu quả. 



 

 

GV quan sát, giải đáp thắc mắc khi 

HS cần 

→ Nhận xét chốt lại 

- Hướng dẫn HS ghi bài  

- Phần mềm trình chiếu là chương trình 

máy tính giúp tạo các bày trình chiếu 

dưới dạng điện tử và trình chiếu các trang 

chiếu. 

Nhóm khác, nhận xét bổ sung (nếu có) 

Ghi nhận kiến thức 

HS ghi bài 

2. Tìm hiểu chức năng của phần mềm trình chiếu 

Chuyển giao nhiệm vụ 2 

Yêu cầu: 

- Phần mềm trình chiếu có những 

chức năng cơ bản nào? 

→ Nhận xét, bổ sung (nếu cần) 

- Giáo viên nhấn mạnh học sinh sự 

khác nhau giữa khái niệm "Bài trình 

chiếu" và "Trang chiếu" 

 

Chuyển giao nhiệm vụ 3 

GV chiếu mô hình  

 

 

 

 

 

 

 

 

 

 

Giải thích mô hình 

Yêu cầu: 

- Ta có thể in bài trình chiếu ra giấy 

không? 

- Sử dụng bài trình chiếu dưới dạng 

điện tử có những lợi ích gì? 

→ Nhận xét, bổ sung (nếu cần) 

→ Chốt lại 

Hướng dẫn HS ghi bài. 

HS thực hiện nhiệm vụ 2 

Thực hiện cá nhân. 

Báo cáo kết quả: 

- Dựa vào SGK nêu các chức năng của 

phần mềm trình chiếu. 

Biết được "Bài trình chiếu" có thể chứa 

nhiều "Trang chiếu" 

Nhận xét. 

 

HS thực hiện nhiệm vụ 3 

 

Quan sát mô hình 

- Hiểu được mô hình 

 

  

 

 

 

 

 

 

*Thảo luận nhóm đôi, báo cáo kết quả 

-Ta có thể in bài trình chiếu ra giấy và 

phát cho người nghe để dễ theo dõi nội 

dung trình bày 

- Lợi ích: dễ chỉnh sửa, màu sắc phong 

phú, nội dung trình bày dễ hiểu, sinh 

động và hấp dẫn hơn 

* Nhóm khác nhận xét, bổ sung 

Ghi bài. 

3. Tìm hiểu phần mềm trình chiếu Powerpoint  

Giới thiệu: Có nhiều phần mềm 

trình chiếu khác nhau, trong đó phần 

mềm Powerpoint của Microsoft hiện 

đang được sử dụng phổ biến nhất. 

 

Lắng nghe. 

 

Quan sát. 

 

 

 



 

 

Giới thiệu biểu tượng của phần mềm 

Powerpoint , màn hình làm 

việc chính (hình 3.4). 

Chuyển giao nhiệm vụ 4 

Yêu cầu: 

- Nêu các cách khởi động 

Powerpoint? 

→ Nhận xét chốt lại 

Hướng dẫn HS ghi bài. 

 

 

 

 

Chuyển giao nhiệm vụ 5 

Yêu cầu: 

+ Quan sát hình 3.4, sgk, trang 64. 

 

+ Ngoài các dải lệnh và một số lệnh 

quen thuộc giống như Word và 

Excel thì Powerpoint còn có thêm 

các đặc điểm gì? 

 

GV đánh giá, nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài. 

 

 

 

HS thực hiện nhiệm vụ 4 

HS thực hiện cá nhân. 

Báo cáo kết quả 

- Cách 1: Nháy biểu tượng  trên 

màn hình để khởi động. 

- Cách 2: Start  All program  

Micorossoft Office  Powerpoint. 

Nhận xét. 

HS ghi bài. 

HS thực hiện nhiệm vụ 5 

Thực hiện nhóm đôi. 

Báo cáo kết quả. 

+ Trang chiếu: Nằm ở vùng chính của cửa 

sổ, được hiển thị sẵn sàng để nhập nội 

dung. 

+ Các dải lệnh đặc trưng của phần mềm 

trình chiếu: 

Dải lệnh SlideShow: Gồm các lệnh dùng 

để thiết đặt bài trínhi chếu. 

Dải lệnh Animations: Gồm các lệnh dùng 

để tạo các hiệu ứng chuyển động của các 

đối tượng trên trang tính. 

Dải lệnh Transitions: Gồm các lệnh dùng 

để tạo các hiệu ứng chuyển tiếp các trang 

chiếu khi trình chiếu. 

Nhận xét. 

Ghi bài. 

4. Ứng dụng của phần mềm trình chiếu 

Chuyển giao nhiệm vụ 6 

Yêu cầu: 

- Nêu các ứng dụng của phần mềm 

trìn chiếu mà em biết. 

 

 

 

 

GV đánh giá, nhận xét -> Chốt lại. 

Hướng dẫn HS ghi bài. 

 

HS thực hiện nhiệm vụ 6 

Thực hiện cá nhân. 

Báo cáo kết quả: 

- Trong nhà trường: Tạo các bài giảng 

điện tử phục vụ dạy và học, các bài kiểm 

tra trắc nghiệm,.. 

 Sử dụng  các cuộc họp, hội thảo,.. 

- Tạo các Album ảnh, Album ca nhạc nhờ 

các hiệu ứng. 

- In các tờ rơi, tờ quảng cáo. 

Nhận xét. 



 

 

Ghi bài. 

 

3.3 Hoạt động luyện tập: 

Chuyển giao nhiệm vụ 7:  

Yêu cầu: Ngoài bảng viết và hình vẽ, hãy liệt kê thêm một số công cụ hỗ trợ trình 

bày mà em biết? 

HS thảo luận cá nhân, báo cáo kết quả 

VD: Slide, máy chiếu, micro, sơ đồ, thí nghiệm, ... 

HS nhận xét, bổ sung  

GV nhận xét, chốt kết quả. 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới  

- Yêu cầu học sinh về nhà học bài, xem trước bài 8 chương 3 

 

 

 

Tuần 13  

Tiết: 25, 26 

Bài 8: BÀI TRÌNH CHIẾU. 
I. MỤC TIÊU: 

1. Kiến thức 

- Biết được bài trình chiếu gồm các trang chiếu và một số thành phần nội dung có thể 

có của một trang chiếu 

- Biết được các kiểu bố trí nội dung khác nhau  trên trang chiếu và phân biệt được các 

mẫu bố trí, cũng như tác dụng của chúng 

- Nhận biết được các thành phần trên giao diện của phần mềm trình chiếu PowerPoint 

- Biết  nhập nội dung văn bản vào các khung văn bản có sẵn trên trang chiếu 

2. Kỹ năng:  

- Nhận biết các thành phần trên giao diện của phần mềm trình chiếu Powerpoint và 

các chế độ hiển thị trình chiếu. 

3. Thái độ: 

- Học sinh nhận thức được vai trò của phần mềm trình chiếu như là một cộng cụ 

hiệu quả để hỗ trợ trình bày, thuyết trình. 

5. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

c. Giáo viên: Giáo án, SGK. 

d. Học sinh: Sách giáo khoa, vở ghi. 

IV. TIẾN TRÌNH DẠY HỌC: 

5. Ổn định:  

6. Kiểm tra bài cũ:  



 

 

GV nêu câu hỏi: Màn hình làm việc của phần mềm Powerpoint có các đặc điểm 

riêng gì? 

Gọi 1 HS lên bảng trình bày: 

+ Trang chiếu: Nằm ở vùng chính của cửa sổ, được hiển thị sẵn sàng để nhập nội 

dung. 

+ Các dải lệnh đặc trưng của phần mềm trình chiếu: 

Dải lệnh SlideShow: Gồm các lệnh dùng để tạo các hiệu ứng chuyển động của các 

đối tượng trên trang tính. 

Dải lệnh Animations: Gồm các lệnh dùng để tạo các hiệu ứng chuyển tiếp các trang 

chiếu khi trình chiếu. 

HS nhận xét. 

GV nhận xét, cho điểm. 

 

 

7. Tổ chức dạy học: 

7.1. Khởi động:  

GV yêu cầu HS tìm hiểu hoạt động (?), sgk, trang 67. 

HS tìm hiểu trả lời. 

GV kết luận: Thực tế cho thấy, việc coi nhẹ bất cứ yếu tố nào cũng đều có thể làm 

cho bài trình bày kém hiệu quả. Phần mềm trình chiếu hiện nay được xem là một 

công cụ hết sức hiệu quả cho hoạt động trình bày. 

3.2 Hoạt động hình thành kiến thức: 

Hoạt động của giáo viên Hoạt động của học sinh 

1. Bài trình chiếu và nội dung trang chiếu 

Chuyển giao nhiệm vụ 1 

Yêu cầu: 

 

- Bài trình chiếu được tạo ra bằng cách 

nào? 

- Quan sát hình 3.6, sgk, trang 68. Cho 

biết: 

+ Các trang chiếu được đánh số trang 

như thế nào? 

+ Các dạng nội dung hiển thị trên trang 

chiếu? 

→ Nhận xét chốt lại 

Hướng dẫn HS ghi bài. 

 

HS thực hiện nhiệm vụ 1 

HS thực hiện cá nhân. 

Báo cáo kết quả 

- Bài trình chiếu là tập hợp các trang 

chiếu và được lưu trên máy tính dưới 

dạng một tệp. 

- Các trang chiếu được đánh số thứ tự 1, 

2,3….. từ trang đầu tiên đến trang cuối 

cùng. 

- Nội dung trên các trang chiếu có thể là 

văn bản, hình ảnh, âm thanh, đoạn 

phim,… hoặc các dạng kết hợp của các 

đối tượng đó. 

Nhận xét. 

HS ghi bài. 

2. Bố trí nội dung trên trang chiếu 

Chuyển giao nhiệm vụ 2 

Yêu cầu: 

- Bố trí nội dung trên trang chiếu là 

thực hiện những công việc gì? 

HS thực hiện nhiệm vụ 2 

Thực hiện cá nhân. 

Báo cáo kết quả: 



 

 

 

 

 

 

→ Nhận xét chốt lại 

Hướng dẫn HS ghi bài. 

 

Chuyển giao nhiệm vụ 3 

Tương tự như một cuốn sách, một bài 

trình chiếu gồm có trang đầu tiên và 

người ta thường gọi là trang tiêu đề. 

Các trang còn lại là trang nội dung. 

Yêu cầu HS: 

+ Quan sát một số trang chiếu có sự bố 

trí khác nhau trên một trang. Và ý 

nghĩa cách bố trí đó. 

 

→ Nhận xét chốt lại 

Hướng dẫn HS ghi bài. 

 

 

 

- Bố trí nội dung trên trang chiếu là cách 

sắp xếp vị trí các đối tượng (văn bản, hình 

ảnh, biểu tượng tệp âm thanh, tệp 

phim,...) trên trang chiếu cũng như các 

thiết đặt định dạng (phông chữ, cỡ chữ, 

...) của các đối tượng đó. 

Nhận xét. 

Ghi bài. 

HS thực hiện nhiệm vụ 3 

Thực hiện cá nhân. 

Báo cáo kết quả: 

+ Trang đầu tiên của bài trình chiếu 

thường là trang tiêu đề giới thiệu nội dung 

tổng quát của bài, những trang còn lại là 

những trang trình bày nội dung chi tiết. 

+ Mỗi trang chi tiết có thể bố trí nội dung 

khác nhau. 

+ Các phần mềm thường có sẵn các mẫu 

bố trí trang chiếu (Layout). Quan sát một 

số mẫu bố trí (sgk, trang 69). 

+ Có thể thay đổi bố trí nội dung trang 

chiếu một cách nhanh chóng mà không 

cần nhập lại nội dung. 

Nhận xét. 

Ghi bài. 

3. Nhập nội dung văn bản cho trang chiếu 

Chuyển giao nhiệm vụ 4 

Yêu câu: 

- Trên một trang chiếu, thành phần nào 

là quan trong nhất? 

 

 

- Văn bản thường nằm ở đâu? 

 

GV gọi 1 vài nhóm trả lời 

GV nhận xét, chốt lại 

 

 

Chuyển giao nhiệm vụ 5 

Yêu cầu: 

- Khung văn bản có hình dạng như thế 

nào? 

- Có mấy kiểu khung văn bản? 

Thực hiện nhiệm vụ 4 

HS thảo luận nhóm đôi 

HS báo cáo kết quả: 

- Trang chiếu chỉ gồm hình ảnh, nhưng 

nội dung dạng văn bản là quan trọng nhất 

và không thể thiếu trong một bài trình 

chiếu. 

- Văn bản thường nằm trong khung văn 

bản. 

 

HS nhận xét, bổ sung 

 

Thực hiện nhiệm vụ 5 

HS hoạt động cá nhân: 

- Khung văn bản là các khung với đường 

biên kẻ chấm mờ.  



 

 

 

- Làm sao để nhập nội dung văn bản 

vào khung văn bản? 

 

- GV: gọi HS trình bày câu trả lời 

- GV nhận xét, chốt lại 

* Các thao tác soạn thảo nội dung trong 

các khung văn bản tương tự trong 

chương trình soạn thảo văn bản, kể cả 

việc chỉnh sửa, sao chép và gõ chữ có 

dấu của tiếng việt. 

- Có 2 kiểu khung văn bản: khung tiêu đề 

và khung nội dung 

- Để nhập nội dung văn bản vào khung 

văn bản, ta nháy chuột trên khhung đó, 

sau đó dùng bàn phím để gõ văn bản. 

 

- HS: lắng nghe và bổ sung ý kiến 

 

- HS ghi bài 

4. Trình chiếu  

Chuyển giao nhiệm vụ 6 

Yêu cầu: 

Quan sát hình 3.9 sgk trang 71 

- Khi tạo xong bài trình chiếu, Sử 

dụng biểu tượng nào để trình chiếu? 

 

- Để chiếu các trang chiếu tiếp theo em 

làm thế nào? 

 

- Làm sao để thoát khỏi chế độ trình 

chiếu? 

Nhận xét, chốt lại 

* Nếu muốn trình chiếu từ trang chiếu 

đầu tiên, em mở dải lệnh Slide Show 

và chọn lệnh From Beginning trong 

nhóm lệnh Start Slide Show 

Thực hiện nhiệm vụ 6 

HS quan sát, trả lời câu hỏi của GV đưa 

ra 

- Để trình chiếu, em nháy chuột vào nút  

 ở góc phải phía dưới màn hình (trên 

thanh công việc) 

- Để chiếu lần lượt các trang chiếu tếp 

theo em chỉ cần nháy chuột hoặc nhấn 

phím  trên bàn phím 

- Để thoát khỏi chế độ trình chiếu nhấn 

phím ESC. 

 

- HS: lắng nghe và bổ sung ý kiến 

 

 

3.3 Hoạt động luyện tập: 

Chuyển giao nhiệm vụ 7: 
Yêu cầu: làm bài tập 4 sgk trang 72 

Hs thảo luận nhóm 

HS báo cáo kết quả 

- Theo em, ý kiến ‘nội dung trình chiếu nên là dàn ý của nội dung bài thuyết trình’ 

là không sai.  

- Tuy nhiên trong một số trường hợp như trong một phần của bài thuyết trình khó 

hiểu thì nên thêm nội dung để diễn giải phần đó cho người nghe có thể hiểu được trọn 

vẹn nội dung bài thuyết trình. 

HS theo dõi, nhận xét, bổ sung 

GV nhận xét, chốt kết quả 

3.4 Hoạt động vận dụng:  

Chuyển giao nhiệm vụ 8:  



 

 

Yêu cầu: cho HS đọc và thực hiện bài tập 5 sgk trang 71 

GV hướng dẫn: em có thể mở trình  duyệt Cốc Cốc và truy cập trang 

web www.google.com.vn, gõ từ khóa “Danh lam thắng cảnh + tên quê hương em” 

vào ô tìm kiếm, sau đó nháy chuột vào mục Hình ảnh để tìm kiếm các hình ảnh danh 

lam thắng cảnh của quê hương em và lưu các hình em thấy vừa ý lại để chuẩn bị cho 

các bài tập sau. 

HS thực hiện ở nhà: Ví dụ quê em là Tam Xuân 2 – Núi Thành thì em có thể tìm 

kiếm với từ khóa “Danh lam thắng cảnh Tam Xuân 2 – Núi Thành” và nháy chuột 

chọn mục Hình ảnh, em sẽ được kết quả 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới  

- Yêu cầu học sinh về nhà học bài. 

- Xem trước bài thực hành 5. 

- Chuẩn bị nội dung : Tạo bài trình chiếu gồm 5 trang nội dung chủ đề giới thiệu di 

tích lịch sử quê hương em chuẩn bị cho tiết sau thực hành. 

 

 

 

Tuần 14  

Tiết: 27, 28 

Bài thực hành 5 : BÀI TRÌNH CHIẾU ĐẦU TIÊN CỦA EM 

I. MỤC TIÊU: 

1. Kiến thức: 

- Khởi động và kết thúc PowerPoint, màn hình làm việc của PowerPoint 

- Tạo thêm được trang chiếu mới, nhập nội dung đoạn văn bản trên trang chiếu và 

hiển thị bài trình chiếu trong các chế độ hiển thị khác nhau. 

- Tạo được bài trình chiếu gồm vài trang chiếu đơn giản 

2. Kỹ năng: 

-Tạo được bài trình chiếu gồm vài trang chiếu đơn giản. 

3. Thái độ: 

- Mạnh dạn trong tìm tòi, nghiên cứu, tự khám phá, học hỏi. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Trực quan 

 Thảo luận nhóm. 

 Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: sách giáo khoa, giáo án, sách bài tập. 

b. Học sinh: sách giáo khoa, vở ghi, sách bài tập. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  



 

 

2. Kiểm tra bài cũ: (không) 

3. Tổ chức dạy học: 

3.1 Hoạt động luyện tập:  

 

Hoạt động của Giáo viên Hoạt động của Học sinh 

Khởi động và làm quen với POWERPOINT  

Chuyển giao nhiệm vụ 1 

- Yêu cầu học sinh đọc yêu cầu Bài 1 SGK 

trang 73. 

- Yêu cầu học sinh thảo luận nêu lên thắc mắc 

của mình. 

 

→ Giải đáp thắc mắc (nếu có), chốt kiến thức 

Thực hiện nhiệm vụ 1 

- Đọc Bài 1 

 

- Thảo luận đưa ra nêu thắc mắc. 

- Ghi nhớ cách thực hiện 

HS thực hiện thao tác của bài 1 

Thực hành  

Chuyển giao nhiệm vụ 2 

- Yêu cầu học sinh vào máy thực hành 

- Quan sát theo dõi quá trình thực hành của học 

sinh, hướng dẫn thêm nếu thấy cần. 

 

→ Giải đáp thắc mắc (nếu có), chốt kiến thức 

Thực hiện nhiệm vụ 2 

- Vào máy thực hành nội dung 

vừa thảo luận 

- Ghi chép các nội dung cần ghi 

nhớ từ thực hành 

 

 

Nhập nội dung cho bài trình chiếu 

Chuyển giao nhiệm vụ 3 

- Yêu cầu học sinh đọc yêu cầu Bài 2 SGK 

trang 75. 

- Yêu cầu học sinh thảo luận nêu lên thắc mắc 

của mình. 

- Xác định trang tiêu đề 

- Tiêu đề trang ? 

- Nội dung trang chiếu được trình bày ở dạng 

nào ? 

→ Giải đáp thắc mắc (nếu có), chốt kiến thức 

Thực hiện nhiệm vụ 3 

- Đọc Bài 2 

 

- Thảo luận đưa ra nêu thắc mắc. 

- Ghi nhớ cách thực hiện 

- HS chỉ ra được theo yêu cầu 

GV 

- HS liệt kê các dạng 

Thực hành  

Chuyển giao nhiệm vụ 4 

- Cho học sinh vào máy thực hành. 

- Quan sát theo dõi quá trình thực hành của học 

sinh, hướng dẫn thêm nếu thấy cần. 

 

Thực hiện nhiệm vụ 4 

- Vào máy thực hành nội dung 

vừa thảo luận 

- Kiểm tra lại nội dung trước khi 

trình chiếu 

Kiểm tra kết quả thực hành 

Chuyển giao nhiệm vụ 5 

- Yêu cầu HS thực hiện một vài thao tác liên 

quan đến nội dung thực hành → ghi điểm một 

vài học sinh 

Thực hiện nhiệm vụ 5 

- Thực hiện thao tác theo yêu 

cầu giáo viên 

- Các nhóm quan sát, nhận xét, 

bổ sung nếu có 



 

 

GV đánh giá quá trình thực hành của các em 

qua các mặt: thái độ thực hành của hs, nề nếp, 

sự chuẩn bị của hs…nêu ra những khuyết điểm 

và cách khắc phục những khuyết điểm đó 

 

Thảo luận nội dung thực hành 

Chuyển giao nhiệm vụ 6 

- GV kiểm tra sự chuẩn bị bài ở nhà của 

học sinh 

- Gọi một số nhóm đọc sự chuẩn bị của 

nhóm mình 

- Gv bổ sung cho các nhóm 

- Xác định trang tiêu đề 

- Tiêu đề trang ? 

- Nội dung trang chiếu được trình bày ở 

dạng nào ? 

→ GV nhận xét, chốt lại 

Thực hiện nhiệm vụ 6 

- Đọc đọc nội dung chuẩn bị của nhóm 

 

- Thảo luận đưa ra nêu thắc mắc. 

- HS thống nhất cách trình bày 

- HS chỉ ra được theo yêu cầu GV 

 

Thực hành 

Chuyển giao nhiệm vụ 7 

 

- Cho học sinh vào máy thực hành. 

- Quan sát theo dõi quá trình thực hành 

của học sinh, hướng dẫn thêm nếu thấy 

cần. 

- GV nhận xét, bổ sung, chốt kến thức 

Thực hiện nhiệm vụ 7 

 

- Vào máy thực hành nội dung vừa thảo 

luận 

- Kiểm tra lại nội dung trước khi trình 

chiếu 

- HS nhận xét, bổ sung 

Kiểm tra kết quả thực hành 

Chuyển giao nhiệm vụ 8 

 

- Yêu cầu học sinh thực hiện một vài 

thao tác liên quan đến nội dung thực 

hành → ghi điểm một vài học sinh 

- GV nhận xét, kết luận 

Thực hiện nhiệm vụ 8 

 

- Thực hiện thao tác theo yêu cầu giáo 

viên 

- HS nhận xét, bổ sug 

 

4. Hướng dẫn học bài cũ, chuẩn bị bài mới  

- Xem trước bài Định dạng trang chiếu, ôn lại thao tác định dạng văn bản. 

Tuần 15  

Tiết: 29, 30 

BÀI 9 : ĐỊNH DẠNG TRANG CHIẾU 

 
V. MỤC TIÊU BÀI HỌC: 

5. Kiến thức:  

 Biết cách định dạng nội dung văn bản trên trang chiếu. 

 Biết vai trò của màu nền trang chiếu và cách tạo nền cho trang chiếu. 



 

 

 Hiểu được mục đích và tác dụng của việc sử dụng các mẫu định dạng. 

 Biết áp dụng các mẫu định dạng có sẵn cho 1 hoặc nhiều trang chiếu. 

6. Kĩ năng:  

 Định dạng được trang trình chiếu 

7. Thái độ:  

 Giáo dục thái độ học tập nghiêm túc. 

 Nhận thức được vấn đề bản quyền trên mạng. 

8. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác, năng lực giải quyết vấn đề. 

VI. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

 Trực quan 

 Thảo luận nhóm. 

 Hỏi đáp. 

VII. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

a. Giáo viên: sách giáo khoa, giáo án, sách bài tập. 

b. Học sinh: sách giáo khoa, vở ghi, sách bài tập. 

VIII. TIẾN TRÌNH DẠY HỌC: 

4. Ổn định:  

5. Kiểm tra bài cũ: (không) 

6. Tổ chức dạy học: 

3.1. Khởi động:  
 GV cho hs quan sát hai bài trình chiếu: Một bài hình nền đơn giản, một bài hình nền 

là hình ảnh 

? Cách trình bày nào sinh động hơn? Hấp dẫn người đọc hơn? 

HS quan sát và trả lời theo cảm nhận 

GV nhận xét, bổ sung và đặt vần đề vào bài mới. 

3. 2 Hoạt động hình thành kiến thức: 

 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

1. Màu nền trang chiếu 

 Chuyển giao nhiệm vụ 1: 

? Cho hs xem hình có 4 màu nền khác 

nhau (hình 3.14 sgk trang 76) 

? Em có nhận xét gì về 4 dạng nền 

trên.? 

 

? Quan sát thông tin sgk nêu các bước 

tạo màu nền cho trang chiếu? 

 

   

 

  

 

 

Thực hiện nhiệm vụ 1 

HS thảo luận 

Báo cáo kết quả 

+ Màu đơn sắc (a), hiệu ứng màu chuyển của 

hai hoặc ba màu (b), mẫu có sẵn (c) hoặc 

hình ảnh (d). 

+ Nêu được 4 bước: 

1.   Chọn trang chiếu trong ngăn bên trái 

(ngăn Slide). 

2. Chọn lệnh Format  Background.  

3. Nháy mũi tên  và chọn màu thích hợp. 

4. Nháy nút Apply trên hộp thoại. 

 



 

 

? Nếu nháy chuột vào nút Apply to all 

và nút Close điều gì xảy ra khi nháy 

mỗi nút lệnh? 

? Có nên áp dụng mỗi trang một màu 

nền không? Vì sao? 

GV nhận xét. 

GV chốt lại đưa ra kiến thức cho 

phần lưu ý 

+ Như em đã thấy khi tạo các trang 

chiếu nếu em sử dụng màu sắc thì sẽ 

làm cho trang chiếu thêm sinh động và 

hấp dẫn. Vậy trên trang chiếu chủ yếu 

ta có thể chọn màu sắc cho các đối 

tượng nào? 

+ Mặc dù có thể đặt nền khác nhau cho 

từng trang chiếu, nhưng để có một bài 

trình chiếu nhất quán  ta chỉ nên đặt 

một màu nền cho toàn bộ bài trình 

chiếu 

Nhận xét, hướng dẫn HS ghi bài. 

+ Apply to all: Việc định dạng màu nền 

trang được áp dụng cho tất cả các trang 

chiếu 

Close: Việc định dạng màu nền trang được 

áp dụng cho trang được chọn. 

Giải thích theo ý hiểu  

Nhận xét. 

 

 

 

Chủ yếu là màu nền trang chiếu và màu chữ 

(văn bản) 

 

Lưu ý: Mặc dù cú thể đặt nền khác nhau cho 

từng trang chiếu, nhưng để cú một bài trình 

chiếu nhất quán, ta chỉ nên đặt một màu nền 

cho toàn bộ bài trình chiếu. 

 

 

Nhận xét, ghi bài. 

2. Định dạng nội dung văn bản 

Chuyển giao nhiệm vụ 2:  
? Hãy nêu một số khả năng định dạng 

văn bản mà các em quan sát được (?, 

sgk, trang 78)? 

Nhận xét. 

 

GV chốt lại đưa ra kiến thức:  

Liên hệ đến các định dạng của chương 

trình sọan thảo MS Word đã học ở lớp 

6. Để thực hiện định dạng, ta thực hiện 

thao tác nào?  

   ? Em hãy minh họa các thao tác định 

dạng dựa trên các nút lệnh trên thanh 

công cụ. (Hình 3.17) 

 
   GV Có thể hướng dẫn Hs thao tác 

làm xuất hiện thanh công cụ định dạng 

(Formatting) 

Thực hiện nhiệm vụ 2: 

Quan sát, báo cáo kết quả. 

- Phông chữ, cỡ chữ, kiểu chữ và màu chữ. 

- Căn lề (căn trái, căn phải, căn giữa trong 

khung chứa).  

- Tạo các danh sách dạng liệt kê. 

Nhận xét, bổ sung. 

 

HS: Nêu các bước:  

- Chọn phần văn bản muốn định dạng bằng 

thao tác kéo thả chuột 

- Sử dụng các nút lệnh trên thanh công cụ 

(Formatting) 
 

Nhận biết các nút lệnh. 

 

 

 

 

 

 

Quan sát và ghi vào vở 



 

 

? Việc chọn màu chữ và màu nền nên 

thực hiện như thế nào? 

 + Lưu ý cho hs : 

Nên chọn màu chữ tương phản với 

màu nền để dễ đọc, chẳng hạn chọn 

màu vàng tươi làm màu chữ nếu em đã 

đặt nền màu xanh sẫm hay nâu sẫm, 

nếu nền màu sáng thì nên chọn màu 

chữ đen hoặc màu sẫm. 

 

 

 

 

HS: Nên chọn màu chữ tương phản với 

màu nền để dễ đọc. 

 

Lắng nghe . 

3. Sử dụng mẫu định dạng 

Chuyển giao nhiệm vụ 3: 

Yêu cầu: 

+ Tìm hiểu nội dung mục 3, sgk, trang 

79. 

+ Mẫu định dạng đã thiết đặt sẵn 

những định dạng nào? 

+ Sử dụng mẫu định dạng có ưu điểm 

gì? 

GV chốt lại đưa ra kiến thức 

 

Chuyển giao nhiệm vụ 4:  
Yêu cầu: 

+ Nêu các bước chọn mẫu định dạng 

có sẵn cho một hoặc nhiều trang 

chiếu? 

Lưu ý: Hiển thị thêm nhiều mẫu định 

dạng   nháy nút More ngay bên 

phải danh sách các mẫu. 

GV chốt lại đưa ra kiến thức 

Nhận xét, hướng dẫn HS ghi bài. 

Thực hiện nhiệm vụ 3 

HS thực hiện cá nhân. 

Báo cáo kết quả 

+ Tìm hiểu nội dung. 

+ Mẫu định dạng gồm các thiết đặt màu sắc 

cho nền trang chiếu và các đối tượng khác 

trên trang chiếu như phông chữ, cỡ chữ,  

màu sắc, … 

+ Sử dụng mẫu trình chiếu, chỉ cần nhập nội 

dung cho các trang chiếu  tiết kiệm thời 

gian, công sức. 

Nhận xét. 

Thực hiện nhiệm vụ 4: 

Thực hiện cá nhân. 

Báo cáo kết quả: 

+ Các bước chọn mẫu định dạng có sẵn cho 

một hoặc nhiều trang chiếu: 

1/ Chọn các trang chiếu (trong ngăn bên 

trái) cần áp dụng mẫu. 

2/ Mở dải lệnh Design và chọn mẫu định 

dạng em muốn trong nhóm Themes. 

Nhận xét, ghi bài. 

3.3 Hoạt động luyện tập:  

Chuyển giao nhiệm vụ 5: 

Yêu cầu: Mở một bài trình chiếu bất kỳ lưu ở bài thực hành 5. Thực hiện định dạng 

màu nền trang chiếu và định dạng nội dung văn bản. 

HS thực hành trên máy. 

GV hướng dẫn, dám sát HS thực hành. 

GV chốt lại đưa ra kiến thức 

3.4 Hoạt động vận dụng: 

Chuyển giao nhiệm vụ 6: 

Yêu cầu: Tìm hiểu bài tập 4, sgk, trang 81. 

HS thực hiện cá nhân. 

Tìm hiểu và báo cáo kết quả. 



 

 

HS, GV phân tích, nhận xét. 

GV nhắc nhở: Công việc đầu tiên quan trọng nhất là chuẩn bị nội dung cho bài trình 

chiếu. Nội dung được chuẩn bị một cách cẩn thận và hợp lý sẽ giúp tiết kiệm thời gian 

và công sức cho các bước sau. Có thể chuẩn bị bước này trên phần mềm soạn thảo, sau 

đó Copy và Paste vào trang chiếu. 

4. Hướng dẫn học ở nhà: 

 - Xem lại các thao tác, và thực hành trên máy tính ở nhà. 

 

 

 

Tuần 16  

Tiết: 31, 32 

ÔN TẬP 

 I. MỤC TIÊU: 

1. Kiến thức: 

- Ôn tập chương I, II,III 

 - Ôn tập, củng cố lại các kiến thức đã học để chuẩn bị cho kì thi học kì I. 

2. Kĩ năng:  

 Hs thực hiện được: 

 - Vận dụng tốt các kiến thức đã học vào việc giải các câu hỏi bài tập. 

 -  Thực hiện việc nêu, củng cố lại được các kiến thức trọng tâm đã được học trong 

chương I và chương II. 

 Hs thực hiện thành thạo: 

- Vận dụng tốt các kiến thức đã học vào việc giải các câu hỏi bài tập. 

- Thực hiện thành thạo việc nêu, củng cố lại được các kiến thức trọng tâm đã được 

học trong chương I và chương II. 

3. Thái độ 

-  Học sinh thói quen tự rèn luyện, ôn tập trong của môn học có ý thức học tập bộ 

môn, ham thích tìm hiểu về tư duy khoa học.  

-  Thái độ học tập nghiêm túc, yêu thích môn học. 

II. CHUẨN BỊ 

Giáo viên: Kế hoạch bài dạy, sgk 

 Học sinh: Đọc trước bài cũ ở nhà. 

III. TIẾN TRÌNH LÊN LỚP: 

1. Ổn định lớp.  

Giáo viên ổn định tổ chức và kiểm tra sỉ số học sinh. 

2.Kiểm tra bài cũ. 

Lồng ghép trong quá trình ôn tập. 

3.Tiến trình bài học: 

3.1 Hoạt động luyện tập: 



 

 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Bài 1:   Từ máy tính đến mạng 

máy tính 

Chuyển giao nhiệm vụ 1 

Yêu cầu: 

+ Khái niệm mạng máy tính 

(MMT)? 

 

 

 

+ Các thành phần của mạng? 

+ Vai trò và lợi ích của mạng máy 

tính? 

 

GV nhận xét, chốt lại 

Bài 2: Mạng thông tin toàn cầu 

Internet  

Chuyển giao nhiệm vụ 2 

Yêu cầu : 

+  Internet là gì?  

(Học sinh hoạt động cá nhân)  

+ Một số dịch vụ trên Internet ? 

(Học sinh hoạt động nhóm) 

+ Làm thế nào để kết nối internet ? 

(Học sinh hoạt động cá nhân)  

GV nhận xét, chốt lại 

 

 

Bài 3.   Tổ chức và truy cập  thông 

tin trên Internet  

 

 

 

Thực hiện nhiệm vụ 1 

Học sinh hoạt động cá nhâ 

* MMT được hiểu là tập hợp các MT kết 

nối với nhau theo một phương thức nào 

đó thông qua các phương tiện truyền dẫn 

tạo thành 1 hệ thống cho phép người 

dùng chia sẻ tài nguyên như dữ liệu, phần 

mềm máy in, máy fax …  

* Bao gồm:   

+ Các thiết bị đầu cuối ( MT, máy in ..) 

+ Môi trường truyền dẫn. 

Vai trò và lợi ích của mạng máy tính: 

+ Dùng chung dữ liệu. – Dùng chung các 

thiết bị phần cứng. – Dùng chung các 

phần mềm. – Trao đổi thông tin. 

HS nhận xét, bổ sung 

 

Thực hiện nhiệm vụ 2 

 

* Là hệ thống kết nối MT và MMT ở qui 

mô toàn thế giới. 

+ Tổ chức khai thác thông tin trên web.  

+ Tìm kiếm thông tin trên Internet.  

+ Trao đổi thông tin qua thư điện tử.  

+ Hội thảo trực tuyến.  

+ Đào tạo qua mạng.  

+Thương mại điện tử. 

* Người dùng kết nối internet thông qua 

nhà cung cấp dịch vụ internet. 

 

HS nhận xét, bổ sung 

 

 



 

 

Chuyển giao nhiệm vụ 3 

+ Siêu văn bản là gì ? phân biệt sự 

khác nhau giữa siêu văn bản và 

trang web ? 

(Học sinh hoạt động cá nhân) 

+ Khái niệm về địa chỉ trang web, 

website, địa chỉ website và trang 

chủ ? 

(Học sinh hoạt động nhóm) 

+ Trình duyệt web là gì ? 

(Học sinh hoạt động cá nhân) 

+ Cách truy cập trang web ? 

(Học sinh hoạt động nhóm) 

+ Máy tìm kiếm là gì? 

(Học sinh hoạt động nhóm) 

 

 

 

+ Cách sử dụng máy tìm kiếm ? 

(Học sinh hoạt động nhóm) 

 

 

 

 

 

 

Bài 4:   Thư điện tử  

Chuyển giao nhiệm vụ 4 

+  Thư điện tử là gì? 

(Học sinh hoạt động cá nhân) 

 

Thực hiện nhiệm vụ 3 

- Siêu văn bản là loại văn bản tích hợp 

nhiều dạng dữ liệu khác nhau như văn 

bản, hình ảnh, âm thanh, video ... và các 

siêu liên kết tới các siêu văn bản khác.  

-Trang web là 1 siêu văn bản được gán 

địa chỉ truy cập trên internet. 

- Địa chỉ truy cập được gọi là địa chỉ 

trang web.      

- Website là nhiều trang web liên quan 

được tổ chức dưới 1 địa chỉ. 

-Trang chủ: Mỗi khi truy cập vào một 

website, bao giờ cũng có một trang web 

đc mở ra đầu tiên, được gọi là trang chủ.  

* Là phần mền giúp con người truy cập 

các trang web và khai thác tài nguyên trên 

Internet. 

* Truy cập trang web ta cần thực hiện: 

- Nhập địa chỉ trang web vào ô địa chỉ . 

- Nhấn enter. 

* Là công cụ hộ trợ tìm kiếm TT trên 

mạng Internet theo yêu cầu của người 

dùng. 

* Một số máy tìm kiếm:  

- Google- Yahoo- Microsoft 

* Các bước tìm kiếm: - vào máy tìm 

kiếm.  - Ví dụ : 

http://www.google.com.vn 

- Gõ từ khóa vào ô dành để nhập từ khóa. 

- Nhấn enter hoặc nháy nút tìm kiếm 

Kết quả tìm kiếm liệt kê dưới dạng danh 

sách các liên kết. 

 

Thực hiện nhiệm vụ 4 

* Thư điện tử là một ứng dụng của 

Internet cho phép gửi và nhận thư trên 

mạng máy tính thông qua các hộp thư 

điện tử. 



 

 

+ Hệ thống thư điện tử ? 

(Học sinh hoạt động cá nhân) 

+ Cách mở tài khoản, gửi và nhận 

thư diện tử? 

(Học sinh hoạt động nhóm) 

+ Cách nhận và gửi thư điện tử? 

(Học sinh hoạt động nhóm) 

 

 

 

 

 - Mở tài khoản thư điện tử 

  Để gửi và nhận thư chúng ta cần phải 

mở một tài khoản thư điện tử. Sau đó nhà 

cung cấp dịch vụ thư điện tử sẽ cung cấp 

một hộp thư điện tử. 

- Mọi địa chỉ thư điện tử luôn gồm hai 

phần: 

 <tên đăng nhập>@<tên máy chủ lưu 

hộp thư> 

Vd: nguyenkhoa0011@gmail.com.vn 

- Mỗi địa chỉ thư điện tử là tên của một 

hộp thư điện tử và là duy nhất trên toàn 

thế giới. 

- Mở hộp thư điện tử: 

+ Bước 1: Truy cập trang web cung cấp 

dịch vụ thư điện tử. 

+ Bước 2: Gõ tên đăng nhập, gõ mật 

khấu rồi nhấn Enter. 

Bài tập: 

1. Tạo một hộp thư điện tử. 

 Hs thực hành trên máy tính nối 

mạng. 

2. Tạo một bài trình chiếu giới 

thiệu về gia đình em. 

 

1. Tạo một hộp thư điện tử. 

2. Thực hành tạo bài trình chiếu giới 

thiệu về gia đình.  

Hs:  Thực hiện tìm kiếm trên Google 

hình ảnh. 

4. Hướng dẫn học tập ở nhà.  

-  Nắm chắc các kiến thức đã được học từ trước đến nay.  

-  Ôn lại tất cả các kiến thức về thư điện tử, tìm kiếm thông tin trên internet;  

- HS Tắt máy tính. 

 

Tuần 17  

Tiết: 33 

ÔN TẬP 

 I. MỤC TIÊU: 

1. Kiến thức: 

- Ôn tập chương I, II,III 

 - Ôn tập, củng cố lại các kiến thức đã học để chuẩn bị cho kì thi học kì I. 

2. Kĩ năng:  

 Hs thực hiện được: 

mailto:%20nguyenkhoa0011@gmail.com


 

 

 - Vận dụng tốt các kiến thức đã học vào việc giải các câu hỏi bài tập. 

 -  Thực hiện việc nêu, củng cố lại được các kiến thức trọng tâm đã được học trong 

chương I và chương II. 

 Hs thực hiện thành thạo: 

- Vận dụng tốt các kiến thức đã học vào việc giải các câu hỏi bài tập. 

- Thực hiện thành thạo việc nêu, củng cố lại được các kiến thức trọng tâm đã được 

học trong chương I và chương II. 

3. Thái độ 

-  Học sinh thói quen tự rèn luyện, ôn tập trong của môn học có ý thức học tập bộ 

môn, ham thích tìm hiểu về tư duy khoa học.  

-  Thái độ học tập nghiêm túc, yêu thích môn học. 

II. CHUẨN BỊ 

Giáo viên: Kế hoạch bài dạy, sgk 

 Học sinh: Đọc trước bài cũ ở nhà. 

III. TIẾN TRÌNH LÊN LỚP: 

1. Ổn định lớp.  

Giáo viên ổn định tổ chức và kiểm tra sỉ số học sinh. 

2.Kiểm tra bài cũ. 

Lồng ghép trong quá trình ôn tập. 

3.Tiến trình bài học: 

3.1 Hoạt động luyện tập: 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Bài tập: 

1. Tạo bài trình chiếu gồm 5-7 

trang tuyên truyền về tệ nạn 

bạo lực học đường. 

 Hs thực hành trên máy tính nối 

mạng. 

 

Hs:  Thực hiện tìm kiếm trên Google 

hình ảnh. 

4. Hướng dẫn học tập ở nhà.  

-  Nắm chắc các kiến thức đã được học từ trước đến nay.  

-  Ôn lại tất cả các kiến thức về tạo bài trình chiếu.  

- HS Tắt máy tính. 

 

 

 

Tiết: 34 

KIỂM TRA HỌC KỲ I 



 

 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Củng cố và kiểm tra được việc lĩnh hội kiến thức của học sinh qua các bài đã học 

2. Kỹ năng: Rèn cho hs kỹ năng trình bày bài làm, vận dụng kiến thức đã học vào để 

trả lời từng câu hỏi cụ thể. 

3. Thái độ: Giáo dục hs tính cẩn thận, chính xác, ý thức kỷ luật, nghiêm túc trong 

kiểm tra thi cử. 

4. Định hướng phát triển năng lực cho HS: 

Năng tự chủ chủ và tự học 

II. CHUẨN BỊ: 

 1. Giáo viên: Ma trận, bảng đặc tả, đề kiểm tra kỳ I, đáp án, biểu điểm cụ thể. 

 2. Học sinh: Kiến thức, đồ dùng học tập. 

III. HÌNH THỨC ĐỀ KIỂM TRA 

- Hình thức: TNKQ + Tự luận. 

- Học sinh làm bài trên máy tính. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

MA TRẬN ĐỀ KIỂM TRA CUỐI HỌC KÌ I 

 NĂM HỌC 2023 - 2024 

MÔN: TIN HỌC LỚP 9  – THỜI GIAN LÀM BÀI: 45 phút  

 

 

TT 

(1) 

Chương/ 

chủ đề  

(2) 

Nội dung/đơn vị 

kiến thức 

(3) 

Mức độ nhận thức Tổng 

% điểm 
Nhận biết Thông hiểu Vận dụng 

Vận dụng 

cao 

TNKQ TL TNKQ TL TNK

Q 

TL TNK

Q 

TL  

1 

Chương 1: 

Mạng máy 

tính và 

internet 

Bài 1: Từ mạng 

máy tính đén 

mạng máy tính 

2        
1 điểm 

10% 

Bài 2: Mạng 

thông tin toàn cầu 

internet 

1        
0.5 điểm 

5% 

Bài 3: Tổ chức và 

truy cập thông tin 

trên internet 

1        
0.5 điểm 

5% 

Bài 4: Tìm hiểu 

thư điện tử 

 

1  1      
1 điểm 

10% 



 

 

     2 Chương 2: 

Một số vấn 

đề xã hội 

của tin học 

Bài 5: Bảo vệ 

thông tin máy 

tính 

1        
0.5 điểm 

5% 

3 Chương 3: 

Phần mềm 

trình chiếu 

Bài 7. Phần mềm 

trình chiếu 
2   1     

3 điểm 

30% 

Bài 8. Bài trình 

chiếu 
  1   1   

2.5 điểm 

25% 

Bài 9. Định dạng 

trang chiếu 
       1 

1 điểm 

10% 

Tổng câu 8  2 1  1  1 13 

Tổng điểm 4 3 2 1 10 

Tỉ lệ % 40% 30% 20% 10% 100% 

 

 

 

 

 

 

 

 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

BẢNG ĐẶC TẢ  ĐỀ KIỂM TRA CUỐI HỌC KÌ I 

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9  – THỜI GIAN LÀM BÀI 45 phút 

 

 

Chủ đề Nội dung Mức độ đánh giá 

Số câu hỏi theo mức độ nhận 

thức 

Nhận 

biết 

Thông 

hiểu 

Vận 

dụng 

Vận 

dụng 

cao 

Chương 

1: Mạng 

máy tính 

và 

internet 

Bài 1: Từ mạng 

máy tính đén 

mạng máy tính 

Nhận biết 

- Biết được mạng LAN và mạng WAN 

- Biết các thành phần của mạng. 

2TN 

(C1, 2) 
   

Bài 2: Mạng 

thông tin toàn cầu 

internet 

Nhận biết 

- Biết một số dịch vụ có trên internet 

1TN 

(C3) 
   

Bài 3: Tổ chức và 

truy cập thông tin 

trên internet 

Nhận biết 

- Biết khái niệm website; trang web; các trình duyệt web 

1TN 

(C4) 
   

Bài 4: Tìm hiểu 

thư điện tử 

 

Nhận biết 

- Biết nhận dạng địa chỉ thư điện tử 

Thông hiểu 

- Hiểu các hoạt động trong quá trình gửi thư; 

1TN 

(C5) 

1 TN 

(C6) 
  



 

 

Chương 

2: Một 

số vấn 

đề xã 

hội của 

tin học 

Bài 5: Bảo vệ 

thông tin máy tính 

Nhận biết 

- Biết được cách bảo vệ máy tính  

1TN 

(C7) 
   

Chương 

3: Phần 

mềm 

trình 

chiếu 

Bài 7. Phần mềm 

trình chiếu 

Nhận biết 

- Biết phần mềm tạo trình chiếu 

Thông hiểu 

- Hiểu được cách trình bày 1 trang chiếu 

- Định dạng màu chữ, màu nền sao cho bài trình chiếu thêm 

sinh động hấp dẫn. 

2TN 

(C8, 9) 

1TH 

(C12) 
  

Bài 8. Bài trình 

chiếu 

Thông hiểu 

- Hiểu được bài trình chiếu hoạt động như thế nào 

Vận dụng 
- Vận dụng nhập nội dung văn bản cho trang chiếu 

 
1TN 

(C10) 

1TH 

(C11) 
 

Bài 9. Định dạng 

trang chiếu 

Vận dụng cao 

- Sử dụng mẫu bố cục và mẫu bài trình chiếu. 
   

1TH 

(C13) 

Tổng số câu 8TN 
2TN 

+1TH 
1TH 1TH 

Tổng số điểm 4 3 2 1 

Tỉ lệ % 40% 30% 20% 10% 

 

 



 

 

(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1: Mô hình mạng phổ biến hiện nay là gì? 

A. LAN B. Internet C. Khách – chủ D. Ngang hàng 

Câu 2: Các thiết bị Vỉ mạng, Hub, bộ chuyển mạch thuộc thành phần nào của 

mạng máy tính? 

A. Thiết bị kết nối mạng  B. Môi trường truyền dẫn  

C. Thiết bị đầu cuối  D. Giao thức  truyền  thông 

Câu 3: Dịch vụ nào dưới dây không phải là dịch vụ trên Internet?  

A. Tra cứu thông tin trên web B. Chuyển phát nhanh  

C. Thư điện tử D. Hội thoại trực tuyến 

Câu 4: Phần mềm được sử dụng để truy cập các trang web và khai thác tài nguyên 

trên internet được gọi là gì?  

A. Trình lướt web B. Trình soạn thảo web   

C. Trình thiết kế web D. Trình duyệt web. 

Câu 5: Khi không sử dụng hộp thư nữa, để không bị người khác sử dụng ta cần 

đóng hộp thư bằng cách nào? 

A. Nháy chuột vào nút Đăng nhập  B. Nháy chuột vào nút Đăng xuất 

C. Thoát khỏi Internet D. Truy cập vào một trang Web khác 

Câu 6: Để có thể sử dụng dịch vụ thư điện tử, trước hết ta phải làm gì? 

A. Đăng kí mở tài khoản thư điện tử với nhà cung cấp dịch vụ thư điện tử  

B. Đăng kí với bưu điện. 

C. Đăng kí mở tài khoản với ngân hàng 

D. Không cần đăng kí 

Câu 7: Trong các phần mềm sau, phần mềm nào là phần mềm diệt virus máy 

tính? 

A. Pascal  B. Office  C. Bkav  D. Kompozer. 

Câu 8: Đâu là phần mềm trình chiếu trong các phần mềm sau? 

A. Microsoft Word   B. Microsoft Excel       

C. Microsof Access      D. Microsoft PowerPoint 

Câu 9: Công cụ nào dưới đây không thể được xem là công cụ hỗ trợ trình bày? 

A. Biểu đồ được vẽ trên giấy khổ lớn           B. Vở và bút viết 

C. Máy tính, phần mềm trình chiếu và bài trình chiếu D. Microphone 

Câu 10: Khi chèn thêm trang chiếu mới vào bài trình chiếu, trang chiếu mới sẽ 

như thế nào? 

Họ và tên:…………………………… 

 Lớp: …..…                   MÃ ĐỀ A 

KIỂM TRA CUỐI HỌC KÌ I  

NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút (Không kể thời gian giao đề) 

Điểm 



 

 

A. Luôn được chèn vào sau trang chiếu cuối cùng 

B. Luôn được chèn trước trang chiếu đầu tiên 

C. Có thể được thêm vào trước hoặc sau một trang chiếu hiện có 

D. Luôn chèn vào trước trang chiếu đang chọn 

II. Phần thực hành: (5 điểm) Hãy thực hành trên máy tính  

Câu 11. (2 điểm) Sử dụng phần mềm Powerpoint để thiết kế bài trình chiếu gồm 5-8 

trang giới thiệu danh lam thắng cảnh khu du lịch Bãi Rạng – Núi Thành.  

Câu 12. (2 điểm) Định dạng màu chữ, màu nền sao cho bài trình chiếu thêm sinh 

động hấp dẫn. 

Câu 13. (1 điểm) Sử dụng mẫu bố cục và mẫu bài trình chiếu. 

 

* Lưu ý: Khởi động máy tính vào ổ đĩa D Tạo thư mục có tên là:  

 + HOVATEN-LOP(VD:  NGUYENGIABAO91) 

(với HOVATEN  và LOP là tên và lớp của thí sinh). 

+ Được sử dụng Internet để tìm thông tin, hình ảnh. 

 

-------------- Hết ---------- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(* Lưu ý: Học sinh làm bài trên máy tính) 

 



 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1: Theo em, mạng máy tính là gì? 

A. Là máy tính cùng các thiết bị liên quan như: máy in, scaner, máy ảnh,.. 

B. Là tập hợp các máy tính được kết nối với nhau theo phương thức nào đó dùng để 

chia sẻ tài nguyên. 

C. Là 5 máy tính kết nối với nhau theo dạng hình sao. 

D. Là 5 máy tính kết nối với nhau theo dạng vòng. 

Câu 2: Dựa vào môi trường truyền dẫn người ta phân mạng máy tính thành hai 

loại là nào?  

A. Mạng nhiều máy tính và một máy tính B. Mạng Khách – Chủ 

C. Mạng không dây và mạng có dây D. LAN và WAN 

Câu 3: Phần mềm được sử dụng để truy cập các trang web và khai thác tài nguyên 

trên internet được gọi là gì?  

A. Trình duyệt web. B. Trình lướt web 

C. Trình thiết kế web D. Trình soạn thảo web 

Câu 4: Dịch vụ nào của Internet được nhiều người sử dụng nhất để xem thông 

tin? 

A. WWW B. Tìm kiếm thông tin trên Internet 

C. Thư điện tử D. Tổ chức và khai thác thông tin trên Web 

Câu 5: Khi đăng nhập thư điện tử thì bắt buộc phải có các thành phần nào? 

A. Mật khẩu và tên đăng nhập          B. Họ và tên          

C. Tên đăng nhập          D. Mật khẩu  

Câu 6: Em sưu tầm được nhiều ảnh đẹp muốn gửi cho bạn bè ở nhiều nơi em dùng 

dịch vụ gì?  

A. Thương mại điện tử B. Đào tạo qua mạng  

C. Thư điện tử đính kèm tệp D. Tìm kiếm thông tin. 

Câu 7: Virus máy tính là gì? 

A. Một gián điệp máy tính B. Một chương trình máy tính 

C. Một thiết bị máy tính D. Một loại sâu máy tính 

Câu 8: Nội dung cơ bản trên các trang chiếu có các dạng nào? 

A. Văn bản, Âm thanh   B. Hình ảnh  

C. Văn bản   D. Văn bản, hình ảnh, âm thanh 

Câu 9: Khi chèn thêm trang chiếu mới vào bài trình chiếu, trang chiếu mới sẽ như 

thế nào? 

A. Luôn được chèn trước trang chiếu đầu tiên 

B. Luôn được chèn vào sau trang chiếu cuối cùng  

C. Luôn chèn vào trước trang chiếu đang chọn 

D. Có thể được thêm vào trước hoặc sau một trang chiếu hiện có 

Họ và tên:……………………….…… 

 Lớp: …..…                   MÃ ĐỀ B 

KIỂM TRA CUỐI HỌC KÌ I 

NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút (Không kể thời gian giao đề) 

Điểm 



 

 

Câu 10: Chức năng nào sau đây không phải của phần mềm PowerPoint? 

A. Tạo bài giảng điện tử   

B. Soạn thảo văn bản và tạo bảng tính  

C. Tạo tệp trình chiếu gồm các trang chiếu  

D. Trình chiếu một số hoặc tất cả các trang chiếu 

II. Phần thực hành: (5 điểm) Hãy thực hành trên máy tính  

Câu 11. (2 điểm) Sử dụng phần mềm Powerpoint để thiết kế bài trình chiếu gồm 5-8 

trang giới thiệu danh lam thắng cảnh khu du lịch Hố Giang Thơm – Núi Thành.  

Câu 12. (2 điểm) Định dạng màu chữ, màu nền sao cho bài trình chiếu thêm sinh 

động hấp dẫn. 

Câu 13. (1 điểm) Sử dụng mẫu bố cục và mẫu bài trình chiếu. 

 

* Lưu ý: Khởi động máy tính vào ổ đĩa D Tạo thư mục có tên là:  

 + HOVATEN-LOP(VD:  NGUYENGIABAO91) 

(với HOVATEN  và LOP là tên và lớp của thí sinh). 

+ Được sử dụng Internet để tìm thông tin, hình ảnh. 

 

-------------- Hết ---------- 

 

 

 

 

 

 

 

 

 

 

 

 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

ĐÁP ÁN ĐỀ KIỂM TRA CUỐI HỌC KÌ I  

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9 

Thời gian: 45 phút (không kể thời gian giao đề) 

 

MÃ ĐỀ A 

I. PHẦN LÝ THUYẾT : (5điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 



 

 

Đáp án C A B D B A C D B C 

 

MÃ ĐỀ B 

I. PHẦN LÝ THUYẾT : (5điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án B C A D A C B D D B 

 

II. PHẦN THỰC HÀNH: (5 điểm) 

Câu 11: Tạo được bài trình chiếu đúng theo yêu cầu  2 điểm 

Câu 12: Tạo hiệu ứng trang trình chiếu sao cho sáng tạo, làm cho bài trình chiếu 

thêm sinh động hấp dẫn  2 điểm 

Câu 13: Định dạng được màu chữ , màu nền hoặc hình nền ( sử dụng mẫu bố cục và 

mẫu bài trình chiếu)  1 điểm 

 

 

 

 

Tuần 18  

Tiết: 35, 36 

Bài thực hành 6 

THÊM MÀU SẮC VÀ ĐỊNH DẠNG TRANG CHIẾU 

I. MỤC TIÊU: 

1. Kiến thức:  

- Hiểu được các bước cơ bản để tạo nội dung cho bài trình chiếu; thêm màu sắc cho 

bài trình chiếu của mình. 

- Hiểu được tác dụng của mẫu bài trình chiếu và cách áp dụng mẫu bài trình chiếu có 

sẵn. 

- Biết được các bước cơ bản để tạo nội dung cho bài trình chiếu. 

2. Kỹ năng:  Định dạng được trang trình chiếu 

3. Thái độ: Giáo dục thái độ học tập nghiêm túc, tích cực nghiên cứu, làm quen với 

phần mềm  

II. CHUẨN BỊ: 

- GV: Giáo án, sách giáo khoa, phòng máy.  

- HS: Xem bài mới trước ở nhà, vở ghi, sách giáo khoa. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ: (Thông qua) 

3. Bài mới:  

3.1 Hoạt động khởi động:  

Yêu cầu: 

+ Khởi động máy tính. 



 

 

+ Khởi động phần mềm PowerPoint. 

HS thực hiện. 

GV giám sát, giúp đở. 

3. 2 Hoạt đọng luyện tập, vận dụng: 

 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Bài 1: Tạo màu nền cho trang 

chiếu  

Chuyển giao nhiệm vụ 1: 

Yêu cầu: 

+ Nhắc lại màu nền trên trang chiếu 

có những dạng nào? 

+ Mở hộp thoại FormatBackground 

định dạng màu sắc trên trang chiếu 

và cho biết các nút lệnh tương ứng? 

+ Thực hiện các thao tác Bài 1. 

Nhận xét. 

Quan sát, giúp đở HS. 

GV lưu ý 2 trường hợp: Định dạng 

màu nền cho trang chiếu bằng hình 

ảnh (Format →Background  

Picture or Texture fill) khác nhau 

như thế nào với việc chọn Insert  

Picture. 

 

 

 

 

Bài 2: Áp dụng mẫu định dạng.  

Chuyển giao nhiệm vụ 2:  
Yêu cầu: 

+ Khi chỉnh sửa và định dạng nội 

dung trang chiếu Powerpoint 

thường có mấy loại? 

Lưu ý: Nếu chọn định dạng thông 

qua mẫu thì trước khi áp dụng 

không nên thực hiện bất cứ thao tác 

chỉnh sửa nào  tránh mất thời 

gian. Hoặc nên chọn mẫu định dạng 

trước các thao tác soạn thảo. 

+ Thực hành các thao tác Bài 2. 

Nhận xét. 

Quan sát, gúp đở HS thực hành. 

Thực hiện nhiệm vụ 1 

HS thực hiện cá nhân. 

Báo cáo kết quả 

+ Màu nền trang chiếu: 

1/ Đơn sắc. 

2/ Màu nền trộn từ hai màu. 

3/ Nền là mẫu có sẵn. 

4/ Nền là một hình ảnh có sẵn. 

+ Mở hộp thoại FormatBackground trên 

dải lệnh Design. 

 Solid fill: Màu đơn sắc. 

 

 Gradient fill: Hiệu ứng chuyển màu. 

 Picture or Texture fill: Hình ảnh hoặc 

mẫu có sẵn. 

 

+ Thực hiện yêu cầu bài 1: 

 
Nhận xét. 

Thực hành trên máy. 

Giúp đỡ các bạn. 

Thực hiện nhiệm vụ 2: 
Thực hiện cá nhân. 

Báo cáo kết quả: 

+ Có 2 loại: 

1/ Chỉnh sửa trực tiếp. (ví dụ dùng chuột 

để thay đổi vị trí kích thước, chọn khung 

văn bản, định dạng chữ) 

2/ Chỉnh sửa thông qua mẫu. (Design  

Chọn các mẫu định dạng trong nhóm 

Themes) 

+ Thực hành bài 2. 

Giúp đỡ các bạn. 



 

 

Bài 3 : Thêm màu nền cho bài 

trình chiếu có sẵn và định dạng 

văn bản  

Chuyển giao nhiệm vụ 3 

- Yêu cầu học sinh đọc yêu cầu Bài 

3 SGK trang 86. 

Y/c bài 3. 

1. Mở bài Hanoi.PPt ( Bài TH5) 

2. Chọn màu nền cho 2 trang chiếu. 

( trang chiếu có 2 màu) 

3. Định dạng văn bản: 

- Phông chữ 

- Màu chữ 

- Kiểu chữ 

- Thay đổi vị trí khung văn bản theo 

hình 3.25 

→Giải đáp thắc mắc (nếu có) 

 

 

Thực hiện nhiệm vụ 3 

Thực hiện cá nhân 

- Đọc Bài 3 

 

- Thảo luận đưa ra nêu thắc mắc. 

- Ghi nhớ cách thực hiện 

Chuyển giao nhiệm vụ 4 

Kiểm tra kết quả thực hành 

- Yêu cầu học sinh thực hiện một vài 

thao tác liên quan đến nội dung thực 

hành → ghi điểm một vài học sinh 

- GV đánh giá quá trình thực hành 

của các em qua các mặt: thái độ 

thực hành của hs, nề nếp, sự chuẩn 

bị của hs, kết quả thực hành… 

Thực hiện nhiệm vụ 4 

Thực hiện nhóm đôi 

- Thực hiện thao tác theo yêu cầu giáo viên 

HS nhận xét 

4. Hướng dẫn học ở nhà:  

- Ôn lại nội dung đã học làm lại các bài thực hành. 

- Tắt máy tính. 

 

 

 

Tuần 19  

Tiết: 37, 38 

Bài 10. THÊM HÌNH ẢNH VÀO TRANG CHIẾU 
I. MỤC TIÊU: 

1. Kiến thức: 



 

 

- Vai trò của hình ảnh và các đối tượng khác trên trang chiếu và cách chèn các đối 

tượng đó vào trang chiếu. 

- Biết được 1 số thao tác cơ bản để xử lí các đối tượng chèn vào trang chiếu như thay 

đổi vị trí và kích thước của hình ảnh. 

- Biết được một số thao tác cơ bản để xử lý các đối tượng được chèn vào trang chiếu 

như thay đổi thứ tự xuất hiện của hình ảnh. 

2. Kỹ năng: Thấy được việc sử dụng hình ảnh vào trang chiếu sẽ làm cho bài trình 

chiếu hấp dẫn và sinh động hơn. 

3. Thái độ:  Nghiêm túc tìm hiểu kiến thức mới. 

II. CHUẨN BỊ: 

 GV: Máy chiếu, máy vi tính cài phần mềm Microsoft Powerpoint 2010 trở lên, 

phiếu học tập, bảng nhóm 

 HS: SGK, xem trước nội dung bài 11. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC :  

1. Ổn định lớp  

2. Kiểm tra bài cũ: (Thông qua) 

3. Bài mới : 

3.1. Hoạt động khởi động  
- GV: Chiếu 1 bài trình chiếu, có hình ảnh và bảng. 

 

Các em thấy gì ở bài trình chiếu vừa rồi? 

HS. trả lời ( hình ảnh, đoạn phim, bảng …) 

- GV: Theo các em những hình ảnh đó, có tác dụng gì? 

HS trả lời: Làm cho nội dung sinh động, hấp dẫn, lôi cuốn,… 

- GV nhận xét: Hình ảnh là dạng thông tin trực quan và dễ gây ấn tượng nhất. Hình 

ảnh thường được dùng để minh họa nội dung dạng văn bản. Trên các trang chiếu hình 

ảnh còn làm cho bài trình chiếu hấp dẫn và sinh động. Ngoài hình ảnh, chúng ta còn có 

thể chèn các đối tượng khác vào trang chiếu như: tệp âm thanh, đoạn phim, bảng và 

biểu đồ,… 

Các em có thể mở bộ sưu tập hình ảnh, Clip Art có sẵn trong PowerPoint 

- GV đặt vấn đề vào bài mới 

3.2. Hoạt động hình thành kiến thức: 

  

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Chèn hình ảnh và các đối tượng khác vào trang chiếu  

Chuyển giao nhiệm vụ 1 Thực hiện nhiệm vụ 1 

Thực hiện cá nhân 

 

 



 

 

Yêu cầu: Trong Word, để chèn hình ảnh 

vào, em thực hiện như thế nào? 

 GV nhận xét và gợi nhớ lại kiến thức cho 

học sinh. 

GV kết luận: Các thao tác chèn hình ảnh, 

tệp âm thanh hoặc đoạn phim vào trang 

chiếu là như nhau. 

Chuyển giao nhiệm vụ 2 

Yêu cầu: Hãy nêu các thao tác chèn hình 

ảnh vào trang chiếu? 

 

 

GV quan sát các nhóm thảo luận 

 

Gọi đại diện nhóm báo cáo kết quả 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GV nhận xét, bổ sung 

 

 

 

 

 Ngoài ra, theo các em mình có thể chèn 

hình ảnh vào trang chiếu bằng cách nào? 

 

 

- GV chốt lại: Kết quả chèn hình ảnh 

được thể hiện ngay trên trang chiếu, có 

thể chèn nhiều hình ảnh khác nhau vào 

trang chiếu. 

* Lưu ý: Có thể chèn nhiều loại hình ảnh 

vào trang chiếu. Ngoài cách trên, ta có thể 

HS trả lời theo trí nhớ của mình. 

HS theo dõi. 

 

 

 

Thực hiện nhiệm vụ 2 

Thực hiện nhóm đôi (2 bạn ngồi cùng 

bàn) 

Thảo luận nhóm, đại diện báo cáo kết 

quả 

+ B1: Chọn trang chiếu cần chèn hình 

ảnh vào. 

+ B2: Chọn lệnh Insert  Picture 

trong nhóm Images. Hộp thoại Insert 

Picture xuất hiện. 

                
 

+ Chọn thư mục lưu tệp hình ảnh trong 

ô Look in. 

 
 

+ Nháy chọn tệp đồ họa cần thiết và 

nháy Insert. 

 

HS nhận xét, bổ sung 

HS trả lời: Có thể dùng các lệnh Copy, 

Paste để chèn hình ảnh vào trang 

chiếu. 

 



 

 

dùng các lệnh Copy, Paste để chèn hình 

ảnh vào trang chiếu. 

 

Tìm hiểu các thay đổi vị trí và kích thước hình ảnh.  

Chuyển giao nhiệm vụ 3 

Yêu cầu: Để thay đổi kích thước một hình 

ảnh nào đó, đầu tiên ta cần làm gì? 

- GV nhận xét: Để chọn một hình 

ảnh đã được chèn trên trang chiếu, ta chỉ 

cần nháy chuột trên hình ảnh đó. Khi hình 

ảnh được chọn, hình ảnh đó được hiển thị 

với đường viền bao quanh cùng với các 

nút tròn nhỏ nằm trên đường viền đó. 

 

 

- GV: Sau khi đã chọn hình ảnh, các em 

có thể thực hiện những thao tác nào? 

 

- Gv: Ngoài ra, ta còn có thể thay đổi thứ 

tự lớp của các hình ảnh mà không cần 

thay đổi vị trí của chúng bằng các bước 

sau: 

+ Chọn hình ảnh cần chuyển lên lớp trên 

(hoặc đưa xuống lớp dưới). 

+ Nháy nút phải chuột lên hình ảnh để mở 

bảng chọn tắt. 

+ Nháy vào chọn Bring to Front để 

chuyển hình ảnh lên trên hoặc Send to 

Back để đưa xuống dưới. 

Thực hiện nhiệm vụ 3 

Thực hiện cá nhân 

HS trả lời: Em cần chọn hình ảnh 

muốn thay đổi kích thước. 

 

+ Thay đổi vị trí: Đưa con trỏ chuột 

lên trên hình ảnh và kéo thả để di 

chuyển đến vị trí khác. 

 

+ Thay đổi kích thước: Đưa con trỏ 

chuột lên trên nút vuông nhỏ nằm giữa 

cạnh viền của hình ảnh và kéo thả để 

tăng hoặc giảm kích thước chiều 

ngang (hoặc chiều đứng). Nếu kéo thả 

nút tròn nhỏ nằm ở góc, kích thước 

của hình ảnh sẽ được thay đổi nhưng 

giữ nguyên được tỉ lệ giữa các cạnh. 

 

+ Thay đổi thứ tự lớp của hình ảnh: 

Khi chèn nhiều hình ảnh lên một trang 

chiếu, có thể hình ảnh chèn vào sau sẽ 

che lấp hoàn toàn hoặc một phần hình 

ảnh khác đã có sẵn, kể cả các nội dung 

trong khung văn bản. Vì thế chúng ta 

thường phải thay đổi vị trí của các 

hình ảnh. 

+ Xóa hình ảnh: Nhấn Delete 

 



 

 

 
- Gv chốt lại: Có thể sử dụng các thao tác 

chọn, thay đổi vị trí, kích thước và thứ tự 

nói trên cho mọi đối tượng khác trên 

trang chiếu (như văn bản, đoạn phim,…) 

Tìm hiểu cách sao chép và di chuyển trang chiếu  

 Gv: Một bài trình chiếu thường gồm 

nhiều trang chiếu. Khi tạo bài trình chiếu, 

không phải lúc nào trang chiếu cũng được 

thêm đúng thứ tự trình bày. Với phần 

mềm trình chiếu, ta có thể dễ dàng sao 

chép và di chuyển các trang chiếu để có 

đúng thứ tự cần thiết. Cách thức thuận 

tiện nhất để sao chép và di chuyển các 

trang chiếu là hiển thị bài trình chiếu 

trong chế độ sắp xếp bằng cách nháy nút 

 ở góc trái, bên dưới cửa sổ. 

 

Chuyển giao nhiệm vụ 4: 

- GV: Trong chế độ sắp xếp ta có thể thực 

hiện các thao tác nào với trang chiếu? 

 

GV nhận xét, bổ sung 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Thực hiện nhiệm vụ 4 

Thực hiện cá nhân: 

+ Chọn trang chiếu: Nháy chuột trên 

trang chiếu cần chọn. Nếu muốn chọn 

đồng thời nhiều trang chiếu, cần nhấn 

giữ Ctrl trong khi nháy chuột. 

+ Sao chép toàn bộ trang chiếu: Chọn 

trang chiếu cần sao chép và nháy nút 



 

 

- GV kết luận: Với các thao tác trên, 

chúng ta không chỉ sao chép hoặc di 

chuyển các trang chiếu trong một bài 

trình chiếu mà còn có thể sao chép hoặc 

di chuyển trang chiếu từ một bài trình 

chiếu sang một bài trình chiếu khác, nếu 

cả hai bài trình chiếu đồng thời được mở. 

Trong chế độ hiển thị sắp xếp này chúng 

ta cũng có thể thêm trang chiếu mới, xóa 

trang chiếu hiện có hoặc một số thao tác 

khác. 

Lưu ý: Tương tự như khi soạn thảo văn 

bản, em cũng có thể thực hiện thao tác 

kéo thả chuột thay cho sử dụng các nút 

lệnh nói trên. 

 

Copy   trên thanh công cụ, sau đó 

nháy chuột vào vị trí cần sao chép giữ 

hai trang chiếu, khi đó con trỏ có dạng 

vạch đứng dài nhấp nháy) và nháy nút 

Paste . 

+ Di chuyển toàn bộ trang chiếu: 

tương tự như thao tác sao chép, nhưng 

sử dụng nút Cut  thay cho nút Copy 

. 

 

HS nhận xét , bổ sung 

HS theo dõi và ghi vào vở 

3.3. Hoạt động luyện tập, vận dụng kiến thức: 

Chuyển giao nhiệm vụ 5:  

Yêu cầu HS đọc câu hỏi 2 SGK/94. 

+ Tại sao hình ảnh này che lấp hình ảnh kia? 

+ Để hiển thị đầy đủ cả hai hình ảnh trên cùng trang chiếu, ta cần thực hiện thao tác 

gì? 

HS thảo luận nhóm 

HS báo cáo kết quả: 

+ Vì PowerPoint mặc định chèn các hình ảnh tại cùng một vị trí trên một trang chiếu 

nên hình ảnh thứ hai thêm vào sẽ chèn đè lên hình ảnh đầu tiên. 

+ Để hiển thị đầy đủ cả hai hình ảnh trên cùng một trang chiếu, em cần thực hiện các 

thao tác thay đổi kích cỡ và di chuyển hình ảnh. 

HS nhận xét, bổ sung 

GV nhận xét, chốt lại 

Chuyển giao nhiệm vụ 6:  

Yêu cầu HS đọc câu hỏi 3 SGK/94. 

HS thực hiện. 

GV: Đưa bài trình diễn PowerPoint có thể giống như trong SGK, sau đó yêu cầu hs 

thực hành trên máy. 

a) Sao chép (hoặc di chuyển) trang chiếu số 1 vào ngay sau trang chiếu số 2. 

b) Trang chiếu số 2 vào vị trí cuối cùng. Các trang chiếu được sao chép hay di chuyển 

sẽ có màu nền gì? Nêu nhận xét của riêng em. 

Hs thực hành trên máy, quan sát và đưa ra nhận xét. 

Gv quan sát và nhật xét. 

4. Hướng dẫn bài cũ, chuẩn bị bài mới : 



 

 

- Học bài và trả lời câu hỏi còn lại SGK/94, 94 

- Xem nội dung BTH7 “Trình bày thông tin bằng hình ảnh”. 

 

Tuần 20  

Tiết: 39, 40 

Bài thực hành 7: 

TRÌNH BÀY THÔNG TIN BẰNG HÌNH ẢNH 

I. MỤC TIÊU : 

1. Kiến thức :   

- Chèn hình ảnh theo mẫu, thêm trang chiếu mới và nhập nội dung theo mẫu. 

-Thêm hình ảnh minh họa thích hợp, thay đổi trật tự các trang chiếu để có thứ tự hợp 

lí.  

- Chèn hình ảnh theo mẫu, thêm trang chiếu mới và nhập nội dung theo mẫu. 

-Thêm hình ảnh minh họa thích hợp, thay đổi trật tự các trang chiếu để có thứ tự hợp 

lí 

2. Kỹ năng :  Tạo hứng thú học tập, khả năng tư duy, sáng tạo. 

3. Thái độ : Nghiêm túc trong thực hành 

II. CHUẨN BỊ : 

- GV : Giáo án, sách giáo khoa. 

- HS : Xem bài mới trước ở nhà, vở ghi, sách giáo khoa. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ : (kiểm tra trong quá trình thực hành) 

3. Bài mới:  

3. 1 Hoạt động luyện tập: 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Bài 1: Thêm hình ảnh minh họa vào trang chiếu  

 Chuyển giao nhiệm vụ 1: 

Yêu cầu: 

Mở bài trình chiếu đã được chỉnh sửa và lưu 

với tên HaNoi trong Bài TH 6. Chèn một tập 

tin hình ảnh về Hà Nội (có sẵn trên máy tính 

hoặc tải về từ internet) vào trang chiếu 1. 

GV quan sát HS thực hành, hướng dẫn 

những nhóm chưa hoàn thành 

GV nhận xét, bổ sung 

Thực hiện nhiệm vụ 1 

Thực hiện cặp đôi (2 HS/ 1máy) 

Có thể chèn theo 2 cách: 

+ Cách 1: Chèn ảnh làm nền cho trang 

chiếu 

+ Cách 2: Chèn ảnh trên nền trang 

chiếu( giữ nguyên màu nền), nhưng 

chuyển hình ảnh xuống dưới khung 

văn bản. 

 

HS thực hiện 



 

 

GV kết luận: Thay đổi vị trí, kích thước và 

định dạng màu văn bản, nếu cần, để tiêu đề 

nổi bật trên hình ảnh. Kết quả nhận được có 

thể tương tự như hình 3.39 sgk/96 

Chuyển giao nhiệm vụ 2:  

Áp dụng mẫu bố trí hai cột cho trang chiếu 

thứ 3 (Vị trí địa lí). 

 Chèn hình ảnh bản đồ Hà Nội vào cột bên 

trái. Kết quả có thể tương tự như hình 3.39. 

 

Nhận xét, hướng dẫn HS thực hành. 

GV chốt lại 

Chuyển giao nhiệm vụ 3:  

Yêu cầu: thêm các trang chiếu mới với thứ 

tự nội dung như sau: 

Trang 4: Danh thắng (chỉ có tiêu đề trang) 

Trang 5: Hồ Hoàn Kiếm  

- Nằm ở trung tâm Hà Nội  

- Diện tích khoảng 12 ha 

- Có Tháp Rùa giữa hồ 

Trang 6: Hồ Tây  

- Hồ lớn nhất ở Hà Nội (500 ha) 

- Từng là một nhánh của sông Hồng 

và trở thành hồ khi sông đổi dòng 

GV nhận xét các nhóm thực hành 

GV chốt lại 

Chuyển giao nhiệm vụ 4:  

Yêu cầu: Áp dụng các mẫu bố trí thích hợp 

và chèn các hình ảnh minh hoạ vào các trang 

chiếu mới. Kết quả tương tự như hình dưới 

 

 

 

 

 

 

Các nhóm nhận xét lẫn nhau. 

 

 

Thực hiện nhiệm vụ 2: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS thảo luận, thực hành.  

 

Nhóm khác  nhận xét 

 

 

 

 

Thực hiện nhiệm vụ 3: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS: thực hành.  

HS báo cáo kết quả thực hành 

Nhóm khác  nhận xét 

 

 

 

 

 

 

 

 

 

 

 

Thực hiện nhiệm vụ 4: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS: thực hành.  

HS báo cáo kết quả thực hành 

 

Nhóm khác  nhận xét 

 

 

  



 

 

 

GV quan sát hs thực hành, hỗ trợ nếu cần 

GV nhận xét, bổ sung kết quả thực hành của 

hs 

GV chốt lại 

Chuyển giao nhiệm vụ 5:  

Yêu cầu: Trình chiếu (nhấn F5), kiểm tra kết 

quả, chỉnh sửa. 

GV: nhận xét. Minh hoạ lại thao tác. 

 

 

 

 

 

 

Thực hiện nhiệm vụ 5: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS: thực hành.  

 

Bài 2: THÊM NỘI DUNG VÀ SẮP XẾP  BÀI TRÌNH CHIẾU  

Chuyển giao nhiệm vụ 6: 

1. Tiếp tục với bài trình chiếu HaNoi (đã 

gồm 6 trang chiếu). Thêm các trang chiếu 

mới với thứ tự và nội dung như sau: 

Trang 7: Lịch sử 

- Năm 1010, Vua Lý Thái Tổ dời đô từ Hoa 

Lư đến Đại La và đổi tên thành Thăng Long 

- Năm 1831 vua Minh Mạng triều Nguyễn 

đặt lại tên là Hà Nội 

Trang 8: Văn Miếu 

- Nằm trên phố Quốc Tử Giám 

- Được xây dựng năm 1070 dưới thời Vua 

Lý Thánh Tông 

- Được xem là trường Đại học đầu tiên của 

nước ta (1076) 

- Có 82 tấm bia tiến sĩ ghi lại tên những 

người đỗ trong 82 khoa thi từ 1442 đến 1789  

Từ đó, GV thực hiện mẫu bài thực hành 

GV: Quan sát và sửa lỗi cho HS. 

GV chốt lại 

 

Chuyển giao nhiệm vụ 7: 

1. Thêm các hình ảnh thích hợp để minh hoạ 

nội dung các trang chiếu mới. Thay đổi thứ 

tự nội dung của các trang chiếu (nếu cần 

thiết) 

Thực hiện nhiệm vụ 6: 

Thực hiện cặp đôi (2 HS/ 1máy) 

Các nhóm thảo luận 

HS: quan sát sau đó thực hành trên 

máy. 

 

HS báo cáo kết quả thực hành 

 

HS nhận xét, bổ sung 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Thực hiện nhiệm vụ 7: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS thảo luận các yêu cầu 

HS: thực hành trên máy. 



 

 

2. Thay đổi trật tự của các trang chiếu để có 

thứ tự hợp lí. Kết quả nhận được có thể 

giống như hình 93. 

3. Thêm các trang chiếu mới, với nội dung 

tự tham khảo được về Hà Nội, bổ sung cho 

bài trình chiếu và lưu kết quả. 

GV: khi HS đã hoàn thành xong, yêu cầu 

HS lưu bài trình chiếu vào máy với tên là 

HaNoi. 

GV: nêu cách lưu bài trình chiếu trên. 

GV chốt lại 

 

 

 

HS báo cáo kết quả thực hành 

 

HS nhận xét, bổ sung 

 

HS lưu bài vào máy 

H: trả lời và thực hiện. 

Bài 3: Trình chiếu bài trình chiếu để kiểm tra kết quả  

Chuyển giao nhiệm vụ 8: 

GV yêu cầu các nhóm chiếu bài thực 

hành của mình để kiểm tra kết quả  

 

GV kiểm tra bài trình chiếu của từng 

nhóm 

Nhận xét, sửa lỗi nếu có 

GV chốt lại 

 

 

Thực hiện nhiệm vụ 8: 

Thực hành nhóm đôi, thực hiện các việc sau 

Tiếp tục với bài trình chiếu đã tạo trong bài 

2 

1.  Nháy nút Slide Show ở phía dưới bên 

phải thanh trạng thái (hoặc mở dải lệnh Slide 

Show và sử dụng lệnh From Beginning 

trong nhóm Start Slide Show để trình chiếu. 

2. Kiểm tra nội dung trên từng trang chiếu, 

sự hợp lí của vị trí các hình ảnh trên trang 

chiếu, các lỗi có thể có và trở lại chế độ soạn 

thảo. 

3. Lưu bài trình chiếu với tên tùy ý sau khi 

đã chỉnh sửa hết lỗi. 

 

4. Hướng dẫn học ở nhà:  
- GV đánh giá chung tiết thực hành. 

- HS tắt máy tính. 

- Thực hiện thêm các thao tác trong bài thực hành. 

- Xem trước bài 11 ‘Tạo các hiệu ứng động’. 
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Bài 11 : TẠO CÁC HIỆU ỨNG ĐỘNG 
I. MỤC TIÊU: 

1. Kiến thức: Giúp Hs nắm đựoc những kiến thức cơ bản: 

- Biết tạo các hiệu ứng động chuyển trang chiếu và hiệu ứng có sẵn cho bài trình 

chiếu và sử dụng khi trình chiếu. 

- Biết sử dụng các hiệu ứng một cách hợp lí. 

- Hiểu được vai trò và tác dụng của các hiệu ứng động khi trình chiếu và phân biệt 

được hai dạng hiệu ứng động. 

- Biết sử dụng hiệu ứng động có sẵn cho bài trình chiếu và lợi ích của việc tạo các 

hiệu ứng động. 

2. Kỹ năng:  Tạo được các hiệu ứng động 

3. Thái độ:  Nghiêm túc, tích cực nghiên cứu tìm hiểu kiến thức mới. 

II. CHUẨN BỊ: 

 GV:  Giáo án, phòng máy. 

  HS: SGK, xem trước nội dung bài 11. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC :  

1. Ổn định lớp  

2. Kiểm tra bài cũ: (Thông qua) 

3. Bài mới : 

3.1. Hoạt động khởi động  
GV: Cho HS tìm hiểu phần khởi động sgk trang 100 

GV: Theo có mấy loại hiệu ứng động? 

HS trả lời: 2 loại đó là hiệu ứng động và hiệu ứng chuyển trang chiếu 

GV đặt vấn đề vào bài mới từ câu trả lời của HS 

3.2. Hoạt động hình thành kiến thức: 

  

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

 1. Hiệu ứng động cho đối tượng trên trang chiếu  

Chuyển giao nhiệm vụ 1 

Yêu cầu: Đọc thông tin trong hình 3.44-SGK 

và nêu các bước tạo hiệu ứng cho các đối 

tượng trên trang chiếu. 

GV quan sát cá nhóm thảo luận 

Gọi đại diện nhóm báo cáo kết quả 

GV nhận xét, bổ sung 

GV chốt lại 

 

 

 

Thực hiện nhiệm vụ 1 

Thực hiện nhóm đôi (2 bạn ngồi 

cùng bàn) 

Thảo luận nhóm, đại diện báo cáo 

kết quả 

+ B1: Chọn đối tượng trên trang 

chiếu cần áp dụng hiệu ứng động 

+ B2: Mở dải lệnh Animations 

+ B3: Nháy chọn hiệu ứng động 

thích hợp trong nhóm Animations 

HS nhận xét, bổ sung 

2. Hiệu ứng chuyển trang chiếu.  

Chuyển giao nhiệm vụ 2 Thực hiện nhiệm vụ 2 



 

 

GV trình chiếu cho học sinh quan sát 2 bài 

trình chiếu, một bài có hiệu ứng chuyển 

trang, một bài không có 

Yêu cầu:  

? Em có nhận xét gì về cách trình bày của 

hai bài trình chiếu trên? 

? Hiệu quả của bài trình chiếu đó? 

GV nhận xét, bổ sung 

 

GV chốt lại 

 

Chuyển giao nhiệm vụ 5 

GV: Cho HS quan sát trên màn hình. 

GV: Yêu cầu HS đọc SGK và nêu các bước 

đặt hiệu ứng chuyển trang? 

GV: Bổ sung và đưa ra các bước . 

GV: Giới thiệu hình 96, SGK cho HS quan 

sát và giải thích thêm về các tùy chọn điều 

khiển việc chuyển trang chiếu 

- Duration: thiết lập thời gian thực hiện 

chuyển trang 

- On Mouse Click: nháy chuột thì trang 

chiếu mới xuất hiện 

- After: tự động chuyển trang sau một 

khoảng thời gian 

 

GV chốt nội dung 

 

Thực hiện cá nhân 

 

HS quan sát 

 

HS nhận xét theo quan sát 

 

 

 

 

 

 

Thực hiện nhiệm vụ 5 

HS thảo luận nhóm 

HS báo cáo kết quả: 

* Các bước tạo hiệu ứng: 

1. Chọn các trang chiếu cần tạo 

hiệu ứng. 

2. Mở dải lệnh Trasitions và chọn 

kiểu hiệu ứng chuyển trang chiếu 

trong nhóm Trasitions to this 

Slide. 
3. Nháy lệnh Apply to All trong 

nhóm Timing  

 

 

HS nhận xét, bổ sung 

3.3. Hoạt động luyện tập, vận dụng kiến thức: 

Tích hợp Stem 

Yêu cầu: Cho HS thực hành trên máy tính cá nhân 

 Thực hành tạo hiệu ứng động cho phần văn bản liệt kê trên trang chiếu hình 3.45 

GV quan sát các nhóm thực hành, giúp đỡ khi hs cần  

HS thực hành theo nhóm (2hs/1 máy) 

Các nhóm báo cáo kết quả thực hành 

Đại diện nhóm nhận xét, bổ sung 

- GV chốt lại: Sau khi tạo hiệu ứng động, bên trái mỗi nội dung văn bản trong khung 

sẽ xuất hiện các số 1, 2, 3, … Các số này biểu thị thứ tự xuất hiện của đối tượng tương 

ứng khi trình chiếu 

* Lưu ý: Chỉ một số hiệu ứng thường dùng được hiển thị sẵn trên dải lệnh. Nếu chưa 

ưng ý với các hiệu ứng động đó em có thể nháy nút More để lựa chọn các hiệu ứng 

khác. 

4. Hướng dẫn bài cũ, chuẩn bị bài mới : 



 

 

- Học bài và trả lời câu hỏi còn lại SGK/104 

- Xem nội dung tiếp theo của bài. 
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BÀI THỰC HÀNH 8: 

HOÀN THIỆN BÀI TRÌNH CHIẾU  

VỚI HIỆU ỨNG ĐỘNG   

I. MỤC TIÊU: 

1. Kiến thức:   

- Biết cách khởi động phần mềm và tạo được các hiệu ứng động cho các trang chiếu 

và cho các đối tượng. 

2. Kỹ năng:  Tạo được các hiệu ứng động cho các trang chiếu. 

3. Thái độ: Nghiêm túc trong thực hành 

II. CHUẨN BỊ: 

GV: Giáo án, sách giáo khoa. 

HS: Xem bài mới trước ở nhà, vở ghi, sách giáo khoa. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ: (thực hiện trong quá trình thực hành) 

3. Bài mới:  

3.1 Hoạt động khởi động:  

GV yêu cầu HS khởi động máy tính. 

HS khởi động máy tính. 

3. 2 Hoạt động luyện tập: 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Hoạt động 1:Thêm các hiệu ứng động cho bài trình chiếu  

 Chuyển giao nhiệm vụ 1: 

Yêu cầu: 

- Hs mở file HaNoi đã lưu trong bài thực hành 7. 

GV: y/c HS trình chiếu toàn bộ nội dung của file 

để nhận xét (chưa có điều chỉnh hiệu ứng theo nhu 

cầu).  

GV: Các trang chiếu được xuất hiện 1 cách lần 

lượt theo mặc định của phần mềm trình chiếu. Vậy 

Thực hiện nhiệm vụ 1 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS Mở file HaNoi 

 

HS thực hiện 

Các nhóm nhận xét lẫn nhau. 

 

 



 

 

để các đối tượng trong trang chiếu xuất hiện theo 

yêu cầu và tăng thêm phần sinh động cho nội 

dung, chúng ta thường tạo thêm các hiệu ứng 

động. Chúng ta cần thực hiện trong bài học này. 

 

Chuyển giao nhiệm vụ 2:  

GV cho HS chọn và áp dụng 1 hiệu ứng chuyển 

khác cho tất cả trang chiếu. 

GV cho HS thay đổi 1 vài hiệu ứng với các tốc độ 

xuất hiện khác nhau. 

Cuối cùng GV cho HS chọn 1 hiệu ứng thích hợp 

và áp dụng cho mọi trang chiếu 

GV nhận xét, hướng dẫn HS thực hành. 

GV chốt nội kiến thức 

Chuyển giao nhiệm vụ 3:  

GV cho Hs chọn 1 hiệu ứng ưng ý và cho áp dụng 

hiệu ứng duy nhất cho mọi trang chiếu 

GV quan sát hs thực hành, hỗ trợ nếu cần 

GV nhận xét, bổ sung kết quả thực hành và cho 

điểm. 

 

 

 

 

Thực hiện nhiệm vụ 2: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS thảo luận, thực hành.  

 

Nhóm khác  nhận xét 

 

 

Thực hiện nhiệm vụ 3: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS: thực hành.  

HS báo cáo kết quả thực hành 

Nhóm khác  nhận xét 

 

 

4. Hướng dẫn học ở nhà:  

- Thực hiện thêm các thao tác trong bài thực hành. 

- Xem trước bài 2 trang 108. 

- HS tắt máy tính. 

 

 

 

 

Tuần 22  

Tiết: 43, 44 

BÀI THỰC HÀNH 8: 

HOÀN THIỆN BÀI TRÌNH CHIẾU  

VỚI HIỆU ỨNG ĐỘNG   
I. MỤC TIÊU: 

1. Kiến thức:   

- Biết cách khởi động phần mềm và tạo các hiệu ứng động cho các trang chiếu cho bộ 

sưu tập hoa. 

2. Kỹ năng:  Tạo được các hiệu ứng động cho các trang chiếu. 



 

 

3. Thái độ: Nghiêm túc trong thực hành 

II. CHUẨN BỊ: 

- GV: Giáo án, sách giáo khoa. 

- HS: Xem bài mới trước ở nhà, vở ghi, sách giáo khoa. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ: (thực hiện trong quá trình thực hành) 

3. Bài mới:  

3. 1 Hoạt động luyện tập: 

 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Chuyển giao nhiệm vụ 1:  

Gv y/c Hs cần chọn trang chiếu để tạo hiệu  

ứng động có sẵn. 

Gv: Muốn tạo hiệu ứng động, ta làm ntn? 

Gv: Làm mẫu. 

 
 

Quan sát, kiểm tra quá trình thực hiện của 

HS. 

GV nhận xét các nhóm thực hành 

GV chốt kến thức. 

 

Thực hiện nhiệm vụ 1: 

Thực hiện cặp đôi (2 HS/ 1máy) 

HS báo cáo kết quả  

- Chọn trang trình chiếu cần áp 

dụng hiệu ứng động có sẵn. 

- Mở bảng chọn Slide Show và 

chọn Animation Schemes. 

- Nháy chọn hiệu ứng thích hợp 

trong ngăn bên phải của cửa sổ. 

Nhóm khác  nhận xét 

Hs: Thực hiện. 

Hs: Hoàn thành và trình chiếu, quan 

sát các hiệu ứng động. 

 

Bài 2 Tạo bộ sưu tập ảnh 

Chuyển giao nhiệm vụ 2: 

Hướng dẫn HS lấy bộ sưu tập ảnh trên mạng 

hoặc trên máy có sẵn và tạo thành 1 bài trình 

chiếu. 

Quan sát, hướng dẫn. 

Yêu cầu HS lưu bài tập “Bộ sưu tập ảnh”. 

Thực hiện nhiệm vụ 2: 
Thực hiện cặp đôi (2 HS/ 1máy) 

HS: quan sát sau đó thực hành trên 

máy. 

HS báo cáo kết quả thực hành 

2 HS trình chiếu bài tập “Bộ sưu tập 

ảnh”. 



 

 

Quan sát và sửa lỗi cho HS. 

GV ghi điểm thực hành 

Cả lớp cùng quan sát, nhận xét và 

đánh giá. 

Bài 3: Tạo bài trình chiếu 

Chuyển giao nhiệm vụ 3 : 

GV yêu cầu các nhóm tạo bài trình chiếu theo 

yêu cầu bài 3 sgk trang 108 

 

GV kiểm tra bài trình chiếu của từng nhóm 

Nhận xét, sửa lỗi nếu có 

GV ghi điểm vài nhóm thực hành tốt 

GV chốt lại 

Thực hiện nhiệm vụ 3: 

Thực hành nhóm đôi, thực hiện các 

việc sau 

- Tạo bài trình chiếu gồm vài trang 

và trang tiêu đề 

- Tạo màu nền cho trang tiêu đề 

bằng hình ảnh và các trang khác có 

màu tùy ý 

- Nhập nội dung văn bản đã chuẩn 

bị trong bài tập 6, bài 9/ trang 81 

vào các trang chiếu 

- Lưu kết quả 

 

 

4. Hướng dẫn học ở nhà:  
- Thực hiện thêm các thao tác trong bài thực hành. 

- Xem trước “Bài 12: Thông tin đa phương tiện”. 
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Bài 12: THÔNG TIN ĐA PHƯƠNG TIỆN 

I. MỤC TIÊU: 

1. Kiến thức:  

- Biết khái niệm đa phương tiện và ưu điểm của đa phương tiện 

- Nắm được một số ví dụ về đa phương tiện 

- Biết các thành phần của đa phương tiện. 

- Biết một số lĩnh vực ứng dụng của đa phương tiện  

trong cuộc sống. 

2. Kỹ năng:  Phân biệt được các dạng thông tin đa phương tiện. 

3. Thái độ:  Nghiêm túc, tích cực nghiên cứu tìm hiểu kiến thức mới. 

II. CHUẨN BỊ: 

GV:  Giáo án, phòng máy. 

 HS: SGK, xem trước nội dung bài 12. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC :  

1. Ổn định lớp : Ổn định lớp học. 

2. Kiểm tra bài cũ: (không) 



 

 

3. Bài mới : 

3.1. Hoạt động khởi động : 

GV yêu cầu HS: 

+ Tìm hiểu hoạt động vào bài trong sgk, trang 114. 

+ Hãy nêu các dạng thông tin mà em đã được học 

HS nhận xét, bổ sung. 

GV đánh giá, đặt vấn đề: Trong cuộc sống hàng ngày chúng ta tiếp nhận thông tin  chỉ 

thuộc một dạng cơ bản hoặc là kết hợp của nhiều dạng. Chúng ta sẽ đi tìm hiểu những 

điểm đặc biệt của các dạng thông tin trên. 

3.2. Hoạt động hình thành kiến thức: 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

Tìm hiểu khái niệm đa phương tiện. 

 Chuyển giao nhiệm vụ 1: 

Yêu cầu: 

+ Cho ví dụ tiếp nhận thông tin 

dưới 1 dạng? Và nhiều dạng kết 

hợp? 

+ Khái niệm đa phương tiện?  

+ Sản phẩm đa phương tiện? 

Nhận xét. 

GV chốt lại 

Thực hiện nhiệm vụ 1 

HS thực hiện nhóm cặp đôi. 

Báo cáo kết quả: 

+ Thông tin dưới 1 dạng: đọc thư. (xem văn 

bản) 

+ Thông tin kết hợp nhiều dạng: xem 

phim.(xem hình ảnh, nghe âm thanh). 

+ Đa phương tiện (multimedia) được hiểu như 

là thông tin kết hợp từ nhiều dạng thông tin và 

được thể hiện một cách đồng thời. 

+ Sản phẩm đa phương tiện:  là sản phẩm được 

tạo bằng máy tính và phần mềm máy tính. 

  

HS nhận xét. 

 

Một số ví dụ về đa phương tiện. 

Chuyển giao nhiệm vụ 2 

Yêu cầu: 

+ Em hãy lấy ví dụ về đa 

phương tiện khi không sử dụng 

máy tính? 

+ Lấy ví dụ về đa phương tiện 

khi sử dụng máy tính? 

Nhận xét. 

Kết luận: Các sản phẩm đa 

phương tiện được tạo bằng máy 

tính có thể là phần mềm, tệp 

Thực hiện nhiệm vụ 2 

HS thực hiện nhóm cặp đôi. 

Báo cáo kết quả: 

+ Ví dụ nghe thầy giảng bài, xem múa hát,… 

+ Bài trình chiếu giảng bài của giáo viên, xem 

video, … 

Nhận xét, bổ sung 

Ghi bài. 

 

 

 

 



 

 

hoặc hệ thống các phần mềm và 

thiết bị. 

 

Ưu điểm của đa phương tiện 

Chuyển giao nhiệm vụ 3 

Yêu cầu: HS nghiên cứu sách 

giáo khoa trả lời: 

+ Đa phương tiện có ưu điểm 

gì? 

Nhận xét. 

GV chốt lại 

Thực hiện nhiệm vụ 3 

Thực hiện cá nhân. 

Báo cáo kết quả: 

+ Đa phương tiện có ưu điểm: 

 Đa phương tiện thể hiện thông tin tốt hơn. 

 Đa phương tiện thu hút sự chú ý hơn. 

 Đa phương tiện thích hợp với việc sử dụng 

máy tính. 

 Đa phương tiện phù hợp cho việc giải trí và 

dạy học. 

Nhận xét, bổ sung 

Ghi bài. 

 

Tìm hiểu các thành phần của đa phương tiện. 

 Chuyển giao nhiệm vụ 4: 

Yêu cầu: 

+ Hãy liệt kê các thành phần 

chính của sản phẩm đa phương 

tiện ? 

+ Phân tích thêm từng thành 

phần. 

Nhận xét. 

GV chốt lại 

Hướng dẫn HS ghi bài. 

Thực hiện nhiệm vụ 4 

HS thực hiện cá nhân. 

Báo cáo kết quả: 

Các dạng thành phần chính của sản phẩm đa 

phương tiện: 

a) Văn bản: là dạng thông tin cơ bản trong biểu 

diễn thông tin bao gồm các kí tự và được thể hiện 

với nhiều dáng vẻ khác nhau. 

b) Âm thanh: là thành phần điển hình của đa 

phương tiện. 

c) Ảnh tĩnh: là một tranh ảnh thể hiện cố định 

một nội dung nào đó. 

d) Ảnh động: Là sự kết hợp nhiều ảnh tĩnh trong 

khoảng thời gian ngắn. 

e) Phim: là thành phần rất đặc biệt của đa 

phương tiện, là dạng tỏng hợp tất cả các thông tin 

vừa trình bày ở trên. 

Nhận xét. 

Theo dõi và ghi vào vở 

Ứng dụng của đa phương tiện. 

Chuyển giao nhiệm vụ 5 

Yêu cầu: 

Thực hiện nhiệm vụ 5 

HS thực hiện cá nhân. 



 

 

+ Các em thấy đa phương tiện 

có ứng dụng trong cuộc sống ở 

những lĩnh vực nào? 

+ Phân tích từng lĩnh vực. 

GV nhận xét, bổ sung. 

GV chốt nội dung 

 

Báo cáo kết quả: 

+ Đa phương tiện có rất nhiều ứng dụng trong 

các lĩnh vực khác nhau của cuộc sống như: 

a. Trong nhà trường.  

b. Trong khoa học. 

c. Trong Y tế.  

d. Trong thương mại; 

e. Trong quản lí xã hội. 

f. Trong nghệ thuật. 

g. Trong công nghiệp, giải trí. 

+ Phân tích từng lĩnh vực. 

Nhận xét, bổ sung 

Ghi bài. 

3.3. Hoạt động luyện tập: 

Chuyển giao nhiệm vụ 6:  

Yêu cầu HS nhắc lại khái niệm đa phương tiện? cho một số ví dụ về đa phương tiện 

được tạo ra khi không sử dụng và sử dụng máy tính. 

HS trả lời cá nhân. 

HS nhận xét. 

GV đánh giá, nhận xét. 

3.4. Hoạt động vận dụng kiến thức: 

Chuyển giao nhiệm vụ 7:  

Yêu cầu HS trả lời câu hỏi 2, sgk, trang 121. 

HS thực hiện cá nhân: 

HS trẩ lời: 

+ Theo em, thông tin nhận được qua công nghệ thực tế ảo là đa phương tiện. Vì 

công nghệ thực tế ảo mô tả một môi trường bằng máy tính, các môi trường thực tại ảo 

gồm hình ảnh, và một số hiệu ứng giác quan như âm thanh, xúc giác,… nên nó là sự 

kết hợp của nhiều dạng thông tin với nhau và được thể hiện đồng thời. 

HS nhận xét, bổ sung. 

GV Nhận xét. 

Lưu ý: Đây là câu hỏi mở cho HS có thể tranh luận và đưa cho các ý kiến riêng của 

mình. 

Chuyển giao nhiệm vụ 8:  

Yêu cầu HS trả lời câu hỏi 3, sgk, trang 121. 

HS thực hiện nhóm đôi: 

HS trả lời: 

Ảnh động và video: 

- Giống nhau: Đều tạo cho mắt người cảm giác các chi tiết chuyển động. 

- Khác nhau: 



 

 

   + Ảnh động: Chỉ có thể cảm nhận thông tin được bằng thị giác và thường có thời 

gian chạy nội dung ngắn, thường là vài giây. 

   + Video: Có thể cảm nhận thông tin bằng cả thị giác và thính giác và có thời 

gian chạy nội dung đa dạng, có thể vài giây cũng có thể nhiều giờ. 

HS nhận xét, bổ sung 

GV nhận xét, bổ sung. 

GV chốt lại. 

Chuyển giao nhiệm vụ 9:  

GV yêu cầu HS trả lời câu hỏi 5, sgk, trang 121. 

HS thực hiện cá nhân: 

+ Những thông tin em thu nhận được là đa phương tiện vì các thông tin em thu 

nhận được được thể hiện đồng thời dưới nhiều dạng thông tin như hình ảnh, âm 

thanh,… 

HS nhận xét, bổ sung 

GV nhận xét, bổ sung. 

GV chốt lại. 

4. Hướng dẫn bài cũ, chuẩn bị bài mới: 

- Xem bài cũ. 

- Tìm hiểu bài 13 
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CHƯƠNG IV: ĐA PHƯƠNG TIỆN 

BÀI 13: PHẦN MỀM GHI ÂM VÀ XỬ LÍ ÂM THANH AUDACITY. 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Biết nguyên tắc chính tạo ra các tệp âm thanh. 

- Biết sử dụng phần mềm để tạo ra một dự án âm thanh hoàn chỉnh bằng phần 

mềm Audacity (hoặc một phần khác tương đương). 

2. Kĩ năng:  

- Thực hiện thao tác thu âm trực tiếp trên phần mềm. 

- Thực hiện các lệnh tạo tệp mới, mở tệp, ghi tệp audacity project file. 

3. Thái độ: Có ý thức sử dụng phần mềm để tạo ra các tệp âm thanh để sử dụng với 

nhiều mục đích khác nhau  

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 



 

 

- Thực hành. 

- Thảo luận nhóm. 

- Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

 1. Giáo viên: Phòng máy sẵn sàng để phục vụ cho việc dạy học. 

     Phần mềm Audacity đã cài đặt sẵn. 

2. Học sinh: Chuẩn bị trước bài 13: Phần mềm ghi âm và xử lí âm thanh Audacity 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: 

3. Tổ chức dạy học: 

3.1. Khởi động:  

GV: Giới thiệu phần mềm Audacity 

Audacity là phần mềm xử lí âm thanh miễm phí nhưng chuyên nghiệp, dễ sử dụng 

và rất phổ biến. Chỉ với kiến thức đơn giản về âm thanh số, em có thể tạo ra được các 

tệp âm thanh để sử dụng với các mục đích khác nhau. Trong thời đại công nghệ số và 

truyền thông, âm thanh, âm nhạc là thông tin đa phương tiện không thể thiếu. 

 

 

 

3.2. Hoạt động hình thành kiến thức: 

Hoạt động của giáo viên Hoạt động của HS 

Bắt đầu với Audacity 

Chuyển giao nhiệm vụ 1: 

GV hướng dẫn HS thao tác khởi động 

Audacity. 

GV giới thiệu giao diện của phần mềm 

 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 2: 

Yêu cầu: 

Thực hiện nhiệm vụ 1: 

Thực hiện nhóm đôi (2 Hs/ máy) 

Nháy đúp chuột lên biểu tượng của 

phần mềm Audicity  trên màn 

hình nền. 

 

 

 

 

 

 

Thực hiện nhiệm vụ 2: 

HS thực hành nhóm đôi (2 Hs/ máy) 

* Mở tệp âm thanh và nghe nhạc 



 

 

+ Nêu cách mở một tệp âm thanh dạng mp3 

trên máy tính? 

 

GV Nhận xét và chốt kiến thức  

GV hướng dẫn HS nghe lại bản nhạc vừa mở 

bằng cách nháy vào nút Play trên thanh công 

cụ hoặc nhấn phím Space 

 

Chuyển giao nhiệm vụ 3: 

Giới thiệu thanh công cụ ghi âm của phần 

mềm 

 
Cho Hs thu âm thanh trực tiếp từ máy tính 

Nhận xét quá trình thực hiện của Hs 

Chú ý: Sau khi thu âm em sẽ thấy một rãnh 

có hình sóng âm xuất hiện 

 

 

 

 

 

 

 

 

 

 

 

- Thực hiện lệnh FileOpen, chọn 

tệp mp3 để mở tệp âm anh  

- Nháy nút  hoặc nhấn phím 

Space để nghe bản nhạc vừa mở 

Các nhóm nhận xét lẫn nhau. 

 

Thực hiện nhiệm vụ 3: 

Thực hiện nhóm đôi (2 Hs/ máy) 

* Thu âm thanh trực tiếp từ máy 

tính 

- Nháy chuột vào nút       để bắt 

đầu thu âm 

- Nháy chuột vào nút        để kết 

thúc thu âm 

HS quan sát hình 4.15 SGK và nêu 

lên chức năng của từng nút lệnh 

HS quan sát trên phần mềm 

 

Tìm hiểu cách làm việc với tệp *.aup (Audicity Project File)  

Chuyển giao nhiệm vụ 4: 

Giới thiệu: Sản phẩm cuối cùng của phần 

mềm Audacity là các tệp âm thanh có dạng 

WAV, MP3, WMA,…Tuy nhiên, trong quá 

trình làm việc, chỉnh lí, thiết kế chúng ta sẽ 

làm việc với các tệp *.aup (Audicity Project 

File) đây là các tệp dự án âm thanh chính của 

phần mềm. 

GV cho học sinh khám phá các chức năng khi 

làm việc với tệp *.aup 

Thực hiện nhiệm vụ 4: 

Thực hiện nhóm đôi (2 Hs/ máy) 

*Thực hiện các thao tác mở tệp, ghi 

tệp, tạm dừng và đóng tệp aup. 

- Tạo một tệp aup mới: File  New  

- Mở tệp aup đã có trên máy tính: File 

 Open 

- Lệnh ghi tệp aup: File  Save 

Project 

- Đóng tệp đang mở: File  Close 

Tìm hiểu Cấu trúc tệp dự án âm thanh 



 

 

Chuyển giao nhiệm vụ 5: 

Yêu cầu: nêu thao tác thêm một tệp âm thanh 

có sẵn? 

Cho HS quan sát giao diện 

Hướng dẫn HS thao tác thêm một tệp âm thanh 

có sẵn 

Chốt lại: Mỗi âm thanh gốc khi đưa vào dự án 

được thể hiện trên một rãnh (tracks) âm thanh. 

Như vậy mỗi dự án âm thanh sẽ bao gồm một 

hay nhiều rãnh âm thanh.  

Thực hiện nhiệm vụ 5: 

Thực hành trên máy 2hs/máy 

+ Thực hiện lệnh: 

FileImportAudio 

Sau đó chọn tệp âm thanh (dạng 

wav,mp3,…) 

+ Tìm hiểu các chức năng của các 

nút lệnh trên giao diện (hình 4.17 

sgk/125) 

+ Đọc ghi nhớ và ghi vào vở: 

- Mỗi dự án bao gồm các rãnh âm 

thanh. Mỗi âm thanh là dữ liệu âm 

thanh đầu vào của dự án. Số lượng 

rãnh của mỗi dự án không hạn chế. 

- Có thể thu âm trực tiếp hoặc thêm 

các tệp âm thanh có sắn (wav, 

mp3,…) vào các rãnh 

- Thanh thời gian (timeline) chỉ ra 

thông số theo thời gian của dự án âm 

thanh. Âm thanh đích là tổ hợp, kết 

quả thể hiện đồng thời của các rãnh 

âm thanh theo thời gian. 

 

3.3 Hoạt động luyện tập: 

HS quan sát trên màn hình và nhắc lại các chức năng của một số nút lệnh vừa học. 

3.4 Hoạt động vận dụng: 

HS thực hành lại các thao tác vừa học trên phần mềm Audicity . 

4. Hướng dẫn HS học ở nhà: 

- Về nhà xem lại các thao tác mở tệp âm anh và nghe nhạc. 

- Thực hành lại các thao tác làm việc với tệp aup. 

- Tìm hiểu cách chỉnh sửa, ghép nối âm thanh nâng cao 
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BÀI 13: PHẦN MỀM GHI ÂM VÀ XỬ LÍ ÂM THANH AUDACITY. (tt) 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Hs biết cấu trúc tệp dự án âm thanh 

- Biết chỉnh sửa âm thanh mức đơn giản 

2. Kĩ năng:  



 

 

- Thực hiện thao tác thêm một tệp âm thanh có sẵn . 

- Thực hiện các lệnh chỉnh sửa đơn giản như: nghe lại một đoạn âm thanh, làm to 

nhỏ âm lượng của từng rãnh âm thanh, đánh dấu, xóa, cắt, dán đoạn âm thanh. 

3. Thái độ: Có ý thức sử dụng phần mềm để tạo ra các tệp âm thanh để sử dụng với 

nhiều mục đích khác nhau  

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

- Thực hành. 

- Thảo luận nhóm. 

- Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

 1. Giáo viên: Phòng máy sẵn sàng để phục vụ cho việc dạy học. 

     Phần mềm Audacity đã cài đặt sẵn. 

2. Học sinh: Chuẩn bị trước bài 13: Phần mềm ghi âm và xử lí âm thanh Audacity 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định: 

2. Kiểm tra bài cũ:  

3. Tổ chức dạy học:  

3.1. Khởi động:  

GV  khởi động Audacity mở giao diện một dự án âm thanh và giới thiệu: cách chỉnh 

sửa âm thanh, ghép nối âm thanh nâng cao. Tiết  này chúng ta sẽ tìm hiểu tiếp phần 

mềm Audacity. 

 

3.2. Hoạt động hình thành kiến thức: 

Hoạt động của GV Hoạt động của HS 

Chỉnh sửa âm thanh mức đơn giản 

a) Nghe lại một đoạn âm thanh 

Chuyển giao nhiệm vụ 1 

Giới thiệu các thao tác khi làm việc với dự án 

âm thanh của Audacity. 

Hướng dẫn và quan sát các nhóm thực hành 

 

 

Nhận xét và yêu cầu thực hiện thêm vài lần 

GV chốt kiến thức 

 

b) Làm to, nhỏ âm lượng hoặc tắt âm thanh 

của từng rãnh 

Chuyển giao nhiệm vụ 2: 

Thực hiện nhiệm vụ 1: 

Thực hành: 

- Dùng chuột đánh dấu một đoạn âm 

thanh trên rãnh, nhấn phím Space 

hoặc nháy chuột vào nút . 

-  Muốn dừng thì nháy nút  

 

Thực hiện nhiều lần để ghi nhớ 

 

 

Thực hiện nhiệm vụ 2: 



 

 

Hướng dẫn HS cách làm to, nhỏ âm lượng của 

từng rãnh. 

 

Hướng dẫn và quan sát các nhóm thực hành 

 

Yêu cầu một số nhóm thực hiện rồi nhận xét 

GV chốt kiến thức 

 

 

 

c. Đánh dấu một đoạn âm thanh (10’) 

Chuyển giao nhiệm vụ 3: 

Cho HS thảo luận cách đánh dấu một đoạn âm 

thanh. 

Yêu cầu Hs nêu cách thực hiện 

 

Nhận xét, bổ sung 

GV chốt kiến thức 

 

 

d) Thao tác xóa, cắt, dán đoạn âm thanh 

Chuyển giao nhiệm vụ 4: 

Yêu cầu: Làm sao để xóa, cắt, dán đoạn âm 

thanh? 

 

 

 

Tổng kết lại các bước thực hiện 

 

Thực hành: 

- Kéo thả con trượt                           

Để tăng giảm âm lượng 

- Nháy nút lệnh Mute để tắt âm 

thanh của rãnh hiện thời 

- Nháy nút Solo để tắt âm thanh của 

tất cả các rãnh khác trừ rãnh hiện 

thời.   

Thực hiện mẫu cho nhóm khác quan 

sát 

 

Thực hiện nhiệm vụ 3: 

Thực hành nhóm đôi:                                            

- Chọn công cụ    

- Kéo thả chuột từ vị trí đầu đến vị trí 

cuối 

- Nếu trong khi kéo thả chúng ta di 

chuyển chuột qua nhiều rãnh thì sẽ 

đánh dấu trên nhiều rãnh. 

Nhận xét, bổ sung 

 

Thực hiện nhiệm vụ 4: 

Thực hành nhóm đôi:                                            

Báo cáo: 

- Xóa đoạn âm thanh: đánh dấu đoạn 

âm thanh cần xóa, nhấn Delete 

- Sao chép một đoạn âm thanh: 

+ Đánh dấu đoạn âm thanh muốn sao 

chép 

+ Nhấn Ctrl + C (sao chép) hoặc Ctrl 

+X (cắt) 

+ Nháy chuột tại vị trí muốn chuyển 

đến 

+ Nhấn Ctrl +V. 

Nhận xét, bổ sung 

Các nhóm thực hành theo các bước 

Chỉnh sửa, ghép nối âm thanh mức nâng cao  

a. Khái niệm clip trên rãnh âm thanh 

Chuyển giao nhiệm vụ 5: 

Yêu cầu: Nêu khái niệm clip âm thanh? 

 

 

Thực hiện nhiệm vụ 5: 

Cá nhân báo cáo kết quả: 



 

 

Minh họa hình ảnh các clip âm thanh trên rãnh  

Nhận xét, chốt lại 

GV chốt kiến thức 

 

 

 

b. Tạo, tách rãnh âm thanh thành các clip, 

nối clip âm thanh 

Chuyển giao nhiệm vụ 6: 

Hướng dẫn HS cách tách rãnh tại một vị trí 

thành hai clip.  

 

Tương tự như tách rãnh âm thanh, em hãy nêu 

cách tách một đoạn âm thanh trên rãnh? 

 

Nhận xét 

GV chốt kiến thức 

 

 

 

 

 

 

 

Chuyển giao nhiệm vụ 7: 

Yêu cầu:  HS thảo luận cách tách một đoạn âm 

thanh và di chuyển sang rãnh mới 

 

 

Minh họa thao tác nối hai clip liền nhau trên 

rãnh 

 

 

 

 

Nhận xét, bổ sung 

GV chốt kiến thức 

 

Yêu cầu HS thực hành trên máy 

 

 

 

- Khi thu âm trực tiếp hoặc chuyển 

một tệp âm thanh, các rãnh được 

khởi tạo sẽ là một đoạn âm thanh 

liền mạch. Có thể tách các rãnh này 

thành các đoạn âm thanh rời gọi là 

clip âm thanh. 

Nhận xét bổ sung 
 

 

Thực hiện nhiệm vụ 6: 

* Tách rãnh tại một vị trí thành hai 

clip 

- Sử dụng công cụ chọn , nháy 

chuột chọn vị trí trên rãnh muốn 

tách, thực hiện lệnh Edit  Clip 

Boundaries  Split hoặc nhấn Ctrl 

+ I 

* Tách một đoạn âm thanh đã đánh 

dấu trên rãnh 

- Sử dụng công cụ chọn  để chọn 

đoạn âm thanh muốn tách, thực hiện 

lệnh Edit  Clip Boundaries  

Split hoặc nhấn Ctrl + I 

 

Thực hiện nhiệm vụ 7: 

HS thảo luận nhóm đôi tìm ra cách 

thực hiện 

Đại diện trình bày 

* Tách một đoạn âm thanh đã đánh 

dấu trên rãnh và di chuyển sang một 

rãnh mới 

- Sử dụng công cụ chọn  , nháy 

chuột chọn đoạn âm thanh muốn 

tách, thực hiện lệnh Edit  Clip 

Boundaries  Split New hoặc nhấn 

Ctrl + Alt + I 

* Nối hai clip liền nhau trên rãnh 

- Cách 1: Khi hai clip nằm sát nhau 

trên rãnh, dùng chuột nháy vào cạnh 

giữa chúng để nối lại. 



 

 

 

 

 

 

c. Di chuyển clip dọc theo thanh thời gian 

Chuyển giao nhiệm vụ 8: 

Hướng dẫn thao tác di chuyển clip 

 

Nhận xét, bổ sung 

GV chốt lại 

 

 

d. Chuyển đổi lip sang rãnh khác 

Chuyển giao nhiệm vụ 9 

Yêu cầu: Chuyển đổi clip sang rãnh khác bằng 

cách nào? 

 

Nhận xét, bổ sung 

GV chốt lại 

 

- Cách 2: Dùng công cụ chọn , 

đánh dấu đoạn âm thanh chứa vị trí 

tách, sau đó nhấn Ctrl + J hoặc lệnh 

Edit  Clip Boundaries  Join 

Nhận xét và thực hành 

 

Thực hiện nhiệm vụ 8 

HS thảo luận nhóm đôi tìm ra cách 

thực hiện 

- Nháy chuột chọn công cụ . 

Dùng chuột kéo thả trên các clip 

theo chiều ngang để dịch chuyển 

Nhận xét, bổ sung 

 

Thực hiện nhiệm vụ 9 

HS thảo luận nhóm đôi 

HS trả lời: 

- Trong khi di chuyển các clip trên 

rãnh, có thể chuyển các clip này sang 

rãnh khác nếu có vị trí trống với độ 

dài lớn hơn clip này. Thao tác là kéo 

thả clip đó sang khoảng trống của 

rãnh khác. 

Nhận xét, bổ sung 

Xuất kết quả ra tệp âm thanh 

Chuyển giao nhiệm vụ 10 

Yêu cầu: Nêu cách xuất kết quả ra tệp âm 

thanh? 

 

Nhận xét, chốt lại 

Thực hiện nhiệm vụ 10 

Báo cáo: 

- Thực hiện lệnh File  Export 

Audio. 

- Lựa chọn tên tệp kết quả và kiểu, 

dạng tệp âm thanh, sau đó nháy 

Save. 

Nhận xét, bổ sung, thực hành 

 

3.3 Hoạt động luyện tập: 

Chuyển giao nhiệm vụ 11 

Yêu cầu:  

+ Nhắc lại thao tác di chuyển clip? 

+ Nêu cách xuất kết quả ra tệp âm thanh? 



 

 

HS trả lời: 

+ Nháy chuột chọn công cụ . Dùng chuột kéo thả trên các clip theo chiều 

ngang để dịch chuyển. 

+ Xuất kết quả: 

Thực hiện lệnh File  Export Audio. 

Lựa chọn tên tệp kết quả và kiểu, dạng tệp âm thanh, sau đó nháy Save. 

HS nhận xét, bổ sung 

GV nhận xét, chốt lại. 

3.4 Hoạt động vận dụng: 

Chuyển giao nhiệm vụ 12 

Yêu cầu: Thực hành bài tập 4 sgk/130 

HS thảo luận và thực hành trên máy. 

Các nhóm báo cáo kết quả thực hành được trước cả lớp  

Gv nhận xét, chốt lại. 

4. Hướng dẫn HS học ở nhà: 

- Về nhà làm câu 5,6 phần bài tập 

- Xem trước bài thực hành 10 
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Bài thực hành 10:  

TẠO SẢN PHẨM ÂM THANH  BẰNG AUDACITY 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Làm quen với phần mềm xử lí âm thanh Audacity. 

- Tạo được một vài dự án âm thanh hoàn chỉnh bằng Audacity. 

2. Kĩ năng:  

- Thực hiện thao tác chỉnh sửa, ghép nối âm thanh để hoàn thành một dự án 

- Xuất được âm thanh ra dạng tệp wav hoặc mp3 sau khi đã hoàn thành dự án 

3. Thái độ: Có ý thức sử dụng phần mềm để tạo ra các tệp âm thanh để sử dụng với 

nhiều mục đích khác nhau 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

- Thực hành. 

- Thảo luận nhóm. 

- Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 



 

 

 1. Giáo viên: Phòng máy sẵn sàng để phục vụ cho việc dạy học 

     Phần mềm Audacity đã cài đặt sẵn 

2. Học sinh: Chuẩn bị trước bài thực hành 10: Tạo sản phẩm âm thanh bằng 

Audacity 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (kiểm tra trong quá trình thực hành) 

3. Tổ chức dạy học:  

3.1. Hoạt động khởi động: 

GV phân nhóm: 2 HS 1 máy. 

Yêu cầu HS khởi động máy tính. 

3.2. Hoạt động luyện tập, vận dụng: 

Hoạt động của GV Hoạt động của HS 

Dữ liệu cần chuẩn bị  

Chuyển giao nhiệm vụ 1: 

Yêu cầu:  

+ HS đọc dữ liệu cần chuẩn bị 

sgk/133, tiến hành tải dữ liệu lưu vào 

thư mục cá nhân. 

Nhận xét việc chuẩn bị của Hs 

Thực hiện nhiệm vụ 1 

HS thực hiện nhóm cặp đôi: 

Tiến hành tải dữ liệu: (Lưu vào thư 

mục cá nhân) 

- Các hình ảnh theo chủ đề cây xanh. 

- Các tệp âm thanh: 

+ Chidhood-Memory: bản nhạc không 

lời 

+ Em Yeu Truong Em.mp3: Bài hat 

Em yêu trường em 

Báo cáo kết quả thực hiện với GV. 

 

Thực hành 

Chuyển giao nhiệm vụ 2: 

Yêu cầu:  

+ Khởi động phần mềm Audacity, 

thiết lập dự án âm thanh 

+ Thiết lập dự án âm thanh có tên theo 

chủ đề của em, ví dụ ‘Cây xanh’ 

Nhận xét, chốt kiến thức 

Chuyển giao nhiệm vụ 3: 

Yêu cầu:  

+ Thực hiện thu âm lời thuyết minh 

cho bức tranh 

Quan sát, hỗ trợ Hs thực hành 

Thực hiện nhiệm vụ 2 

HS thực hiện nhóm đôi (2hs/máy): 

- Tạo mới File  Save Project As 

Vd: Cayxanh.aup 

 

Nhận xét, bổ sung 

 

 

Thực hiện nhiệm vụ 3 

HS thực hiện nhóm đôi (2hs/máy): 

* Cách thu âm: 



 

 

Nhận xét, chốt lại 

* Lưu ý: Khi thu âm lời thoại mới thì 

cần tạm thời tắt âm thanh của tất cả 

các rãnh hiện có trên màn hình bằng 

cách nháy nút Mute của các rãnh đã 

có. 

 

Chuyển giao nhiệm vụ 4: 

Yêu cầu:  

+ Ghép các lời thuyết minh thành một 

rãnh âm thanh hoàn chỉnh 

 

Quan sát, hỗ trợ Hs thực hành 

Nhận xét, chốt lại 

 

- Nháy lên nút  sau đó bắt đầu đọc 

thuyết minh để thu âm 

- Nháy chuột vào nút        để kết 

thúc thu âm 

* Lần lượt thu âm lời thuyết minh cho 

mỗi hình ảnh 

Thực hành theo yêu cầu 

Thực hiện nhiệm vụ 4: 

HS thực hiện nhóm đôi (2hs/máy): 

* Cách thực hiện: 

- Nháy chuột chọn công cụ . 

- Dùng chuột kéo thả phần âm thanh 

của rãnh bên dưới sang phải, sau đó đẩy 

lên rãnh trên 

- Dùng chuột để nối hai clips thành 

một. 

Thực hành theo các bước 

 

4. Hướng dẫn HS học ở nhà: 

- Thực hiện lại các thao tác đã thực hành trên lớp 

- Xem tiếp phần còn lại của bài. 
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ÔN TẬP KIỂM TRA GIỮA KỲ II 

 I. MỤC TIÊU: 

1. Kiến thức: 

- Học sinh ôn tập lại kiến thức về phần mềm trình chiếu PowerPoint   

2. Kĩ năng:  

- Học sinh có kĩ năng tạo được các trang chiếu đơn giản  

3. Thái độ 

- Tập trung, nghiêm túc thực hiện các hoạt động học tập theo sự hướng dẫn của 

giáo viên 

- Có ý thức tự giác cao và có tính thần giúp đỡ lẫn nhau trong học tập. 

- Yêu thích môn Tin học và hình thành ý thức vận dụng các kiến thức đã học để 

áp dụng có hiệu quả trong thực tiễn cuộc sống. 

II. CHUẨN BỊ 

Giáo viên: Kế hoạch bài dạy, sgk 



 

 

 Học sinh: Đọc trước bài cũ ở nhà. 

III. TIẾN TRÌNH LÊN LỚP: 

1. Ổn định lớp.  

Giáo viên ổn định tổ chức và kiểm tra sỉ số học sinh. 

2.Kiểm tra bài cũ. 

Lồng ghép trong quá trình ôn tập. 

3.Tiến trình bài học: 

3.1 Hoạt động luyện tập: 

HOẠT ĐỘNG CỦA GV HOẠT ĐỘNG CỦA HS 

1. Hoạt động 1: Thêm hình ảnh 

vào trang chiếu  

Chuyển giao nhiệm vụ 1 

Yêu cầu: 

Câu 1: Để thêm hình ảnh vào trang 

chiếu em thực hiện như thế nào?  

Câu 2: Để thay đổi thứ tự của lớp 

hình ảnh em làm như thế nào?  

 

 

 

GV nhận xét, chốt lại 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Hoạt động 2: Tạo các hiệu ứng 

động  

 

 

 

Thực hiện nhiệm vụ 1 

Học sinh hoạt động cá nhân 

+ B1: Chọn trang chiếu cần chèn hình ảnh 

vào  

+ B2: Nháy chuột chọn Insert  chọn 

Picture . Xuất hiện hộp thoại Insert 

picture 

+ B3: Chọn thư mục chứa hình ảnh  

chọn tệp tin hình ảnh. 

+ B4: Nháy chuột chọn Insert 

Câu 2:  Để thay đổi thứ tự của lớp hình ảnh 

em làm như thế nào?  

Nháy chuột phải vào trong hình ảnh: 

+ Chọn Bring to Front  chọn Bring to 

Front để chuyển hình ảnh lên lớp trên 

cùng hoặc Bring Forward để chuyển lên 

trên một lớp  

+ Chọn Send to Back  chọn Send to 

Back để chuyển hình ảnh xuống lớp dưới 

cùng hoặc Back Forward để chuyển 

xuống dưới một lớp 

 

HS nhận xét, bổ sung 

 

 

 



 

 

Chuyển giao nhiệm vụ 2 

- Câu 1: Em hãy nêu các bước tạo 

hiệu ứng động cho đối tượng trên 

trang chiếu?  

- Câu 2: Để thay đổi thứ tự của lớp 

hình ảnh em làm như thế nào?  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GV nhận xét, chốt lại. 

 

Thực hiện nhiệm vụ 2 

Học sinh hoạt động cá nhân 

 

- Câu 1:  

+ B1: Chọn đối tượng trên trang chiếu  

+ B2: Nháy chuột vào Animations  

chọn  

+ B3: Chọn Add Effect  chọn ngôi sao 

màu xanh  chọn More Effect ... 

 
+ B4 : Chọn hiệu ứng thích hợp  nháy 

Ok.  
- Câu 2:   

Em hãy nêu các bước hiệu ứng động 

chuyển trang chiếu?  

+ B1: Chọn trang chiếu cần chuyển hiệu 

ứng  

+ B2: Nháy chuột chọn Transitions  

chọn more   Chọn hiệu ứng chuyển 

trang chiếu thích hợp  

+ B3: Trong nhóm Timing gồm có: 

* Lệnh Apply to all: Áp dụng hiệu ứng 

chuyển trang cho tất cả các trang chiếu.  

* Lệnh Duration: Thiết lập thời gian thực 

hiện chuyển trang chiếu 

* Lệnh On mouse lick: Chọn chuyển 

trang khi nháy chuột  

* Lệnh After: Nhập thời gian để chuyển 

trang sau khoảng thời gian quy định. 

 

HS nhận xét, bổ sung 

Bài tập: 

 (Tổ chức HS hoạt động nhóm) 

 

 



 

 

GV: yêu cầu học sinh khởi động máy 

tính và thực hiện các nhiệm vụ thực 

hành sau: 

+ Khởi động phần mềm powerpoint 

2010  

+ Tạo bài trình chiếu về cảnh đẹp quê 

hương Quảng Nam   

+ Trình chiếu bài trình chiếu để kiểm 

tra kết quả 

 GV: Hướng dẫn cho học sinh, 

hướng dẫn từng nhóm, quan tâm đến 

từng đối tượng học sinh, giúp đỡ khi 

các em gặp khó khăn trong quá trình 

thực hành. 

 GV: Nếu đa số các em học 

sinh mắc cùng một lỗi thì nên cho 

các em dừng thực hành, hướng dẫn 

cho cả lớp để sửa lỗi 

 

2. Thực hành tạo bài trình chiếu giới 

thiệu về cảnh đẹp quê hương Quảng 

Nam  
  

- HS: Tiến hành thực hiện nhiệm vụ theo 

nhóm đã phân công (2hs/1 máy)  

- HS: Thực hiện tìm kiếm trên Google 

hình ảnh. 

4. Hướng dẫn học tập ở nhà.  

-  Nắm chắc các kiến thức đã được học từ trước đến nay.  

-  Ôn lại tất cả các kiến thức về tạo bài trình chiếu.  

- HS Tắt máy tính. 

 

Tuần 27  

Tiết: 53 

KIỂM TRA GIỮA KÌ II 
I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Củng cố và kiểm tra được việc lĩnh hội kiến thức của học sinh qua các bài đã học 

2. Kỹ năng: Rèn cho hs kỹ năng trình bày bài làm, vận dụng kiến thức đã học vào để 

trả lời từng câu hỏi cụ thể. 

3. Thái độ: Giáo dục hs tính cẩn thận, chính xác, ý thức kỷ luật, nghiêm túc trong 

kiểm tra thi cử. 

4. Định hướng phát triển năng lực cho HS: 

Năng tự chủ chủ và tự học 

II. CHUẨN BỊ: 

 1. Giáo viên: Ma trận, bảng đặc tả, đề kiểm tra giữa kỳ II, đáp án, biểu điểm cụ thể. 

 2. Học sinh: Kiến thức, đồ dùng học tập. 

III. HÌNH THỨC ĐỀ KIỂM TRA 

- Hình thức: TNKQ + Tự luận. 

- Học sinh làm bài trên máy tính.



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

MA TRẬN ĐỀ KIỂM TRA GIỮA HỌC KÌ II 

 NĂM HỌC 2023 - 2024 

MÔN: TIN HỌC LỚP 9  – THỜI GIAN LÀM BÀI: 45 phút  

 

 

Cấp độ 

 

Chủ đề 

Nhận biết Thông hiểu 
Vận dụng 

 

Cộng 
Cấp độ thấp Cấp độ cao 

TN TL TN TL TN TL TN TL 

Bài 10: Thêm hình ảnh vào trang 

chiếu 
   .  

Số câu 

Số điểm 

4 

2đ 
 

1 

0.5đ 

1 

2đ 
    

6 

4.5đ 

Bài 11: Tạo các hiệu ứng động      

Số câu 

Số điểm 

3 

1.5đ 
 

1 

0.5đ 
 

 

 

1 

2đ 
 

1 

1đ 

6 

5đ 

Bài 12: Thông tin đa phương tiện      

Số câu 

Số điểm 

1 

0.5đ 
       

1 

0.5đ 

Tổng số câu 8  2 1  1  1 13 

Tổng số điểm 4đ  1đ 2đ  2đ  1đ 10đ 

Tỉ lệ 40%  30%  20%  10% 100% 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

BẢNG ĐẶC TẢ  ĐỀ KIỂM TRA GIỮA HỌC KÌ II 

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9  – THỜI GIAN LÀM BÀI 45 phút 

 

 

Chủ đề Nội dung Mức độ đánh giá 

Số câu hỏi theo mức độ nhận 

thức 

Nhận 

biết 

Thông 

hiểu 

Vận 

dụng 

Vận 

dụng 

cao 

Chương 

3. Phần 

mềm 

trình 

chiếu 

Bài 10: 

Thêm hình ảnh 

vào trang chiếu 

Nhận biết 

- Biết cách chèn hình ảnh và các đối tượng khác vào trang 

chiếu 

- Biết sao chép và di chuyển trang chiếu 

Thông hiểu 

- Hiểu được cách thêm hình ảnh vào trang chiếu sao cho 

đẹp, hài hòa, sinh động. 

4TN 

(C1,3,

4,5) 

1TN 

(C2) 

1TH 

(C11) 

  

Bài 11: 

Tạo các hiệu ứng 

động 

Nhận biết 

- Biết tạo hiệu ứng cho các đối tượng trên trang chiếu 

Thông hiểu 

- Hiểu cách tạo hiệu ứng động 

Vận dụng  

- Vận dụng để định dạng trang chiếu, nội dung, chèn hình 

ảnh, … Tạo hiệu ứng cho đối tượng, trang chiếu thêm sinh 

động hấp dẫn. 

Vận dụng cao  

3TN 

(C6,7,

8) 

1TN 

(C9) 

1TH 

(C12) 

1TH 

(C13) 



 

 

- Sử dụng mẫu trang chiếu, mẫu định dạng. 

- Tạo bài trình chiếu hoàn thiện sinh động, hấp dẫn. 

Chương 

4. Đa 

phương 

tiện 

Bài 12: Thông tin 

đa phương tiện 

Nhận biết 

- Biết đâu là phần mềm đa phương tiện, tên gọi 

 

1TN 

(C10) 
   

Tổng số câu 8TN 
2TN 

+1TH 
1TH 1TH 

Tổng số điểm 4 3 2 1 

Tỉ lệ % 40% 30% 20% 10% 
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(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1. Em không thể thực hiện những thao tác nào dưới đây với các hình 

ảnh đã được chèn vào trang chiếu? 

A. Thay đổi vị trí của hình ảnh   B. Thay đổi kích thước của hình ảnh  

C. Thay đổi thứ tự của hình ảnh  D. Thay đổi và chỉnh sửa nội dung hình 

ảnh 

Câu 2. Hình ảnh được chèn vào trang chiếu không có tác dụng nào sau 

đây? 

A. Minh họa trực quan thông tin dạng văn bản làm cho thông tin dễ hiểu hơn. 

B. Tăng tính hấp dẫn và sinh động của bài trình chiếu. 

C. Tăng mức độ trừu tượng của thông tin cần trình bày. 

D. Bổ sung những thông tin mà khi diễn tả bằng văn bản hoặc lời nói có thể dài 

dòng 

Câu 3. Để đưa hình ảnh xuống lớp dưới cùng, em sử dụng lệnh? 

A. Bring Forward    B. Bring to Front      

C. Send to Back          D. Send Backward. 

Câu 4. Nếu sao chép toàn bộ trang chiếu, em sử dụng cặp lệnh nào? 

A. Copy/Paste B. Copy/Cut   C. Cut/Paste D. 

Paste/Copy 

Câu 5. Để xóa hình ảnh trên trang chiếu, em sử dụng phím gì? 

A. Tab B. Delete C. Enter D. Shift 

Câu 6. Tạo hiệu ứng động tùy biến cho đối tượng, em sử dụng dải lệnh nào? 

A. Dải lệnh Animations    B. Dải lệnh Insert 

C. Dải lệnh Home    D. Dải lệnh Slide Show   

Câu 7. Khi trình chiếu nội dung của mỗi trang chiếu:  

A. Bắt buộc phải có 1 hiệu ứng âm thanh đi kèm. 

B. Bắt buộc phải có 2 hiệu ứng âm thanh trở lên. 

C. Tùy theo nội dung thể hiện để chọn âm thanh cho phù hợp. 

D. Tuyệt đối không nên sử dụng hiệu ứng âm thanh. 

Câu 8. Nếu muốn áp dụng 1 hiệu ứng chuyển trang cho tất cả các trang chiếu. 

Ta nháy nút nào? 

Họ và tên:…………………………… 

 Lớp: …..…                   MÃ ĐỀ A 

KIỂM TRA GIỮA HỌC KÌ II  

NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút (Không kể thời gian giao đề) 

Điểm 
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A. Apply to All Slides B. Apply to Slides      C. Apply to Master D. Apply 

to All  

Câu 9. Chọn phát biểu sai? 

A. Khi tạo hiệu ứng động cho một khối văn bản ta có thể cho xuất hiện lần lượt 

từng từ trong khối văn bản khi trình chiếu 

B. Sau khi đã tạo hiệu ứng động cho một đối tượng nào đó ta không thể thay đổi 

kiểu hiệu ứng cho đối tượng đó 

C. Có thể thực hiện hiệu ứng chuyển trang cho 1 slide bất kỳ trong bài trình diễn 

D. Có thể thực hiện hiệu ứng chuyển trang cho tất cả các slide trong bài trình diễn 

Câu 10. Phần mềm máy tính nào dưới đây là ví dụ về sản phẩm đa phương 

tiện? 

A. Phần mềm đồ họa   B. Phần mềm trình chiếu 

C. Phần mềm trò chơi   D. Phần mềm xử lý ảnh 

II. Phần thực hành: (5 điểm) Hãy thực hành trên máy tính  

Câu 11. (2 điểm) Sử dụng phần mềm Powerpoint để thiết kế bài trình chiếu gồm 

5-7 trang giới thiệu về một món ăn ở Việt Nam. 

Câu 12. (2 điểm) Định dạng trang chiếu, nội dung, chèn hình ảnh, … Tạo hiệu 

ứng cho đối tượng, trang chiếu thêm sinh động hấp dẫn. 

Câu 13. (1 điểm) Sử dụng mẫu trang chiếu, mẫu định dạng. 

 

* Lưu ý: Khởi động máy tính vào ổ đĩa D Tạo thư mục có tên là:  

 + HOVATEN-LOP(VD:  NGUYENGIABAO91) 

(với HOVATEN  và LOP là tên và lớp của thí sinh). 

+ Được sử dụng Internet để tìm thông tin, hình ảnh. 

 

-------------- Hết ---------- 
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(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1. Em có thể chèn hình ảnh vào trang chiếu bằng cách nào ? 

A. Insert  text box     B. Format  Font 

C. Insert  Picture  From File…   D. Edit  Select All 

Câu 2. Hình ảnh được chèn vào trang chiếu không có tác dụng nào sau 

đây? 

A. Tăng mức độ trừu tượng của thông tin cần trình bày.  

B. Tăng tính hấp dẫn và sinh động của bài trình chiếu. 

C. Minh họa trực quan thông tin dạng văn bản làm cho thông tin đẽ hiểu hơn. 

D. Bổ sung những thông tin mà khi diễn tả bằng văn bản hoặc lời nói có thể dài 

dòng 

Câu 3. Để chuyển hình ảnh lên lớp trên cùng, em sử dụng lệnh? 

A. Bring Forward   B. Bring to Front        

C. Send to Back   D. Send Backward. 

Câu 4. Để di chuyển toàn bộ trang chiếu, em sử dụng cặp nút lệnh nào sau 

đây? 

A. Copy/Paste B. Copy/Cut   C. Cut/Paste D. 

Paste/Copy 

Câu 5. Với phần mềm trình chiếu, ta không chèn được những đối tượng 

nào vào trang chiếu để minh họa nội dung? 

A. Các tệp hình ảnh và âm thanh    

B. Các đoạn phim ngắn 

C. Bảng và biểu đồ   

D. Một tệp văn bản Word và khi trình chiếu ta có thể xem được từng trang văn 

bản Word này 

Câu 6. Hiệu ứng động là công cụ hỗ trợ trình bày nội dung trên trang chiếu. 

Có mấy loại hiệu ứng động? 

A. 1        B. 2    C. 3   D. 4 

Câu 7. Để tạo hiệu ứng động tùy biến cho đối tượng, em sử dụng dải lệnh 

nào? 

A. Dải lệnh Slide Show      B. Dải lệnh Insert 

Họ và tên:……………………….…… 

 Lớp: …..…                   MÃ ĐỀ B 

KIỂM TRA GIỮA HỌC KÌ II 

NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút (Không kể thời gian giao đề) 

Điểm 
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C. Dải lệnh Home    D. Dải lệnh Animations 

Câu 8. Nên sử dụng các hiệu ứng động ở mức độ nào? 

A. Càng nhiều càng tốt.   B. Mỗi nội dung nên tạo nhiều hiệu ứng. 

C. Mức độ vừa phải.   D. Không nên tạo hiệu ứng động. 

Câu 9. Âm thanh đưa vào bài trình diễn để làm gì?  

A. Thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

B. Thực hiện được chỉ khi tạo hiệu ứng chuyển trang giữa các slide. 

C. Thực hiện được chỉ khi tạo hiệu ứng động cho đối tượng trong slide. 

D. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

Câu 10. Đa phương tiện trong tiếng anh được viết là gì? 

A. Supermedia        B. Multiple  C. Media  D. Multimedia  

II. Phần thực hành: (5 điểm) Hãy thực hành trên máy tính  

Câu 11. (2 điểm) Sử dụng phần mềm Powerpoint để thiết kế bài trình chiếu gồm 

5-7 trang giới thiệu về loài động vật quý hiếm ở Việt Nam. 

Câu 12. (2 điểm) Định dạng trang chiếu, nội dung, chèn hình ảnh, … Tạo hiệu 

ứng cho đối tượng, trang chiếu thêm sinh động hấp dẫn. 

Câu 13. (1 điểm) Sử dụng mẫu trang chiếu, mẫu định dạng. 

 

* Lưu ý: Khởi động máy tính vào ổ đĩa D Tạo thư mục có tên là:  

 + HOVATEN-LOP(VD:  NGUYENGIABAO91) 

(với HOVATEN  và LOP là tên và lớp của thí sinh). 

+ Được sử dụng Internet để tìm thông tin, hình ảnh. 

 

-------------- Hết ---------- 
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UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

ĐÁP ÁN ĐỀ KIỂM TRA GIỮA HỌC KÌ II  

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9 

Thời gian: 45 phút (không kể thời gian giao đề) 

 

 

MÃ ĐỀ A 

I. PHẦN LÝ THUYẾT : (5điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án D C C A B A C D B B 

 

MÃ ĐỀ B 

I. PHẦN LÝ THUYẾT : (5điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án C A B C D B D C A D 

 

II. PHẦN THỰC HÀNH: (5 điểm) Dùng chung cho 2 đề 

Câu 11: Tạo được bài trình chiếu đúng theo yêu cầu   2 điểm 

Câu 12: Định dạng trang chiếu, nội dung, chèn hình ảnh, … Tạo hiệu ứng cho 

đối tượng, trang chiếu thêm sinh động hấp dẫn.    2 điểm 

Câu 13: Sử dụng mẫu trang chiếu, mẫu định dạng.   1 điểm 

 

 



 

 

 

Tuần 28  

Tiết: 55, 56 

Bài thực hành 10:  

TẠO SẢN PHẨM ÂM THANH  BẰNG AUDACITY (tt) 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Dùng phần mềm Audacity để tạo một sản phẩm âm thanh hoàn chỉnh  

2. Kĩ năng:  

- Thực hiện thao tác chỉnh sửa, ghép nối âm thanh để hoàn thành một dự án 

- Xuất được âm thanh ra dạng tệp wav hoặc mp3 sau khi đã hoàn thành dự án 

3. Thái độ: Có ý thức sử dụng phần mềm để tạo ra các tệp âm thanh để sử dụng với 

nhiều mục đích khác nhau 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 

- Thực hành. 

- Thảo luận nhóm. 

- Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

 1. Giáo viên: Phòng máy sẵn sàng để phục vụ cho việc dạy học 

     Phần mềm Audacity đã cài đặt sẵn 

2. Học sinh: Chuẩn bị trước bài thực hành 10: Tạo sản phẩm âm thanh bằng 

Audacity 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định:  

2. Kiểm tra bài cũ: (kiểm tra trong quá trình thực hành) 

3. Tổ chức dạy học:  

3.3. Hoạt động khởi động: 

GV phân nhóm: 2 HS 1 máy. 

Yêu cầu HS khởi động máy tính. 

3.4. Hoạt động luyện tập, vận dụng: 

Hoạt động của GV Hoạt động của HS 

Thực hành 

Chuyển giao nhiệm vụ 1: 

Yêu cầu:  

+ Khởi động phần mềm Audacity, 

thiết lập dự án âm thanh 

+ Mở dự án đã lưu ở tiết trước. 

Thực hiện nhiệm vụ 1 

HS thực hiện nhóm đôi (2hs/máy): 

- Mở dự án đã lưu ở tiết trước  

 

Nhận xét, bổ sung 



 

 

 

Chuyển giao nhiệm vụ 2: 

Yêu cầu:  

+ Thực hiện bổ sưng thêm nhạc nền 

cho lời thuyết minh. 

+ Tách lời thuyết minh thành hai phần 

+ Đưa một bài hát vào khoảng giữa 

hai đoạn thuyết minh. 

+ Xuất ra tệp Wav tạo thành sản phẩm 

âm thanh hoàn chỉnh. 

Quan sát, hỗ trợ Hs thực hành 

Nhận xét, chốt kiến thức 

 

Thực hiện nhiệm vụ 2 

HS thực hiện nhóm đôi (2hs/máy): 

+ Bổ sung thêm nhạc nền: 

File - > Import - > Audio - > Chọn tệp 

âm thanh. 

Thực hành theo yêu cầu 

 

 

4. Hướng dẫn HS học ở nhà: 

- Thực hiện lại các thao tác đã thực hành trên lớp 

 

Tuần 29  

Tiết: 57, 58 

BÀI THỰC HÀNH 9: 

THỰC HÀNH TỔNG HỢP  

I. MỤC TIÊU:  

1. Kiến thức: 

- Ôn lại những kiến thức đã học trong các bài học trước. 

- Ôn lại những kỹ năng đã làm được trong các bài thực hành trước. 

2. Kĩ năng: 

- Tạo được một bài trình chiếu hoàn chỉnh dựa trên nội dung có sẵn. 

3. Thái độ: 

- Nghiêm túc, làm việc khoa học, sáng tạo mang tính thẩm mỹ cao. 

II. CHUẨN BỊ: 

GV: Chuẩn bị phòng máy, các hình ảnh như sgk cài đặt trong máy tính, bài trình 

chiếu mẫu  

HS: Ôn tập các kiến thức và kỷ năng đã học để tạo bài trình chiếu. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ: (thực hiện trong quá trình thực hành) 

3. Luyện tập, vận dụng:  

 

Hoạt động của GV Hoạt động của HS 

Hướng dẫn ban đầu  

GV nêu yêu cầu từng tiết HS : Ổn định vị trí trên các máy. 



 

 

+ Chia nhóm: cặp đôi. 

+ Cho các nhóm thảo luận, 

lập dàn ý 

+ Góp ý và đưa ra dàn ý 

chung cho cả lớp. 

HS : Kiểm tra tình trạng máy tính của mình => Báo 

cáo tình hình cho Gv. 

-  Thảo luận cùng nhau bàn bạc đưa ra cách làm, 

sao chép các thông tin nếu cần 

- Hoàn thiện bài trình chiếu theo dữ liệu đã có. 

Hướng dẫn thực hành  

Chuyển giao nhiệm vụ 

Trình chiếu mẫu có sẵn  

Cho học sinh tiến hành làm 

bài thực hành 

GV quan sát HS thực hành, 

hỗ trợ nếu cần 

Nhận xét bài làm của HS, 

chốt kiến thức và ghi điểm 

Thực hiện nhiệm vụ 

Thực hiện nhóm cặp đôi 

Học sinh tiến hành làm bài thực hành theo mẫu 

hoặc gợi ý của giáo viên. 

Lịch sử máy tính

 

Máy tính điện tử đầu tiên

• Có tên là ENIAC

• Khởi công năm 1943, 

hoàn thành năm 1946

ENIAC

• Rất lớn và rất nặng

• Có bộ nhớ và hoạt động

theo chương trình

• Được chế tạo dựa trên

nguyên lí của Phôn Nôi-

man

 

Một vài máy tính lớn khác

Máy tính UNIVAC 1 Máy tính IBM 360

 



 

 

Máy tính cá nhân đầu tiên

• Có tên là Micral

• Do ông Trương Trọng Thi (người Việt sống ở

Pháp) và đồng nghiệp phát minh (1973)

Máy tính Micral

 

Máy tính cá nhân IBM

• IBM PC/XT (1983)

• Phần lớn máy tính các

nhân hiện nay được sản

xuất dựa trên máy tính

IBM
Máy tính cá nhân IBM PC/XT

 

Một số dạng máy tính ngày nay

• Máy tính lớn

• Siêu máy tính

• Máy tính xách tay

• Máy tính bỏ túi

• Máy tính cầm tay

(PDA)

 

4. Hướng dẫn học ở nhà:  

- GV nhận xét giờ thực hành tuyên dương và cho điểm nhóm làm tốt 

- Dọn dẹp phòng máy Tắt máy 

- Thực hiện bài tương tự ở nhà với chủ để tự do. 

 

 

Tuần 30  

Tiết: 59, 60 

BÀI THỰC HÀNH 9: 

THỰC HÀNH TỔNG HỢP (TT) 

 

I. MỤC TIÊU:  

1. Kiến thức:  
- Tạo được bài trình chiếu hoàn chỉnh dựa trên nội dung có sẵn. 

- Có kĩ năng trình bày, thuyết minh được bài trình chiếu đã tạo. 



 

 

2. Kĩ năng: 

- Tạo được một bài trình chiếu hoàn chỉnh dựa trên nội dung có sẵn. 

3. Thái độ: 

- Nghiêm túc, làm việc khoa học, sáng tạo mang tính thẩm mỹ cao. 

II. CHUẨN BỊ: 

GV: Chuẩn bị phòng máy, các hình ảnh như sgk cài đặt trong máy tính, bài trình 

chiếu mẫu  

HS: Ôn tập các kiến thức và kỷ năng đã học để tạo bài trình chiếu. 

III. CÁC HOẠT ĐỘNG DẠY – HỌC 

1. Ổn định lớp  

2. Kiểm tra bài cũ: (thực hiện trong quá trình thực hành) 

3. Luyện tập, vận dụng:  

 

Hoạt động của GV Hoạt động của HS 

Chuyển giao nhiệm vụ 1  

Yêu cầu: 

Khởi động máy tính. 

Hãy tạo một trình chiếu có các Slide theo chủ 

đề tự chọn, lưu vào thư mục cá nhân với tên 

TH9-BAI3.PPT 

GV quan sát, hỗ trợ nhóm yếu 

GV nhận xét, bổ sung, chốt lại 

 

Chuyển giao nhiệm vụ 2  

Yêu cầu: 

- Tạo nội dung đầy đủ cho các Slide 

- Tạo nền thống nhất cho các Slide, màu chữ 

thích hợp (chú ý đến yếu tố thẩm mỹ). 

- Thiết lập hiệu ứng hoạt hình thích hợp cho 

các đối tượng trên tất cả các Slide 

- Thiết lập hiệu ứng chuyển động thích hợp 

cho tất cả các Slide 

- Tạo các nút về đầu, về cuối các Slide, kết 

thúc trình diễn ở Slide số 2. 

- Tạo trình chiếu tự động, sau đó thiết lập 

trình diễn tự động 

 

Thực hiện nhiệm vụ 1 

Thực hiện nhóm cặp đôi. 

Khởi động máy tính. 

Chọn chủ đề, sưu tầm hình ảnh, 

tạo bài trình chiếu hoàn chỉnh. 

Báo cáo sản phẩm 

 

Các nhóm nhận xét, bổ sung lẫn 

nhau 

 

Thực hiện nhiệm vụ 2 

Thực hiện nhóm 

HS báo cáo sản phẩm 

Các nhóm nhận xét, bổ sung lẫn 

nhau 



 

 

- Sau đó lưu lại sự thay đổi của bài 

GV nhận xét bài làm của HS, bổ sung và 

ghi điểm. 

 

4. Hướng dẫn học ở nhà:  
- GV nhận xét giờ thực hành tuyên dương và cho điểm nhóm làm tốt 

- Củng cố lại bài: nhắc lại các nội dung đã thực hành. 

- HS Tắt máy tính. 

 

 

Tuần 31  

Tiết: 61 

ÔN TẬP KIỂM TRA CUỐI KỲ II 

 I. MỤC TIÊU: 

1. Kiến thức: 

- Học sinh ôn tập lại kiến thức về phần mềm trình chiếu PowerPoint   

- Dùng phần mềm Audacity để tạo một sản phẩm âm thanh. 

2. Kĩ năng:  

- Học sinh có kĩ năng tạo được các trang chiếu đơn giản  

3. Thái độ 

- Tập trung, nghiêm túc thực hiện các hoạt động học tập theo sự hướng dẫn của 

giáo viên 

- Có ý thức tự giác cao và có tính thần giúp đỡ lẫn nhau trong học tập. 

- Yêu thích môn Tin học và hình thành ý thức vận dụng các kiến thức đã học để 

áp dụng có hiệu quả trong thực tiễn cuộc sống. 

II. CHUẨN BỊ 

Giáo viên: Kế hoạch bài dạy, sgk 

 Học sinh: Đọc trước bài cũ ở nhà. 

III. TIẾN TRÌNH LÊN LỚP: 

1. Ổn định lớp.  

Giáo viên ổn định tổ chức và kiểm tra sỉ số học sinh. 

2.Kiểm tra bài cũ. 

Lồng ghép trong quá trình ôn tập. 

3.Tiến trình bài học: 

3.1 Hoạt động luyện tập: 

HOẠT ĐỘNG CỦA GV 
HOẠT ĐỘNG 

CỦA HS 

Tổ chức trò chơi một trò chơi như sau: 

- Chia lớp thành 4 đội, đội nào thắng sẽ được phần quà. 

Các đội thảo luận và 

trả lời câu hỏi chọn 

được  



 

 

- Trò chơi gồm 4 câu hỏi, mỗi câu hỏi 10 điểm, đội nào 

không trả lời được thì đội khác có quyền trả lời để dành 

điểm 

- Câu hỏi: 

Câu 1. Để chèn hình ảnh vào trang chiếu, em sử dụng 

dải lệnh nào sau đây? 

A. Home B. Insert C. Design  D. View 

Câu 2. Trong PowerPoint nháy chuột phải lên hình ảnh 

Chọn Bring to Front  Bring Forward để chuyển 

hình ảnh 

A. xuống lớp dưới cùng             B. xuống dưới một lớp 

C. lên lớp trên cùng   D. lên trên một lớp          

Câu 3. Đưa con trỏ chuột lên trên hình ảnh và kéo thả để 

di chuyển đến vị trí khác có chức năng gì?  

A. Thay đổi thứ tự lớp của hình ảnh. B. Thay đổi vị trí. 

C. Thay đổi kích thước. D. Xóa hình ảnh. 

Câu 4. Sau khi đã thiết kế xong bài trình diễn, cách làm 

nào sau đây không phải để trình chiếu ngay bài trình 

diễn đó? 

A. Chọn Slide Show -> Custom Show  

B. Nhấn phím F5 

C. Chọn View -> Slide Show  

D. Chọn Slide Show -> View Show 

Các đội khác theo 

dõi và nhanh tay 

dành quyền trả lời 

cho đội mình nếu đội 

bạn trả lời sai 

 

3.2. Hoạt động luyện tập: 

GV yêu cầu HS chuẩn bị trả lời các câu hỏi trong đề cương. 

Sau 25 phút, yêu cầu HS lần lượt chọn các phương án trả lời cho các câu hỏi sau: 

Câu 5. Đưa con trỏ chuột lên trên hình ảnh và kéo thả để di chuyển đến vị trí khác có 

chức năng gì?  

A. Xóa hình ảnh. B. Thay đổi thứ tự lớp của hình ảnh.  

C. Thay đổi vị trí. D. Thay đổi kích thước.  

Câu 6. Chức năng nào sau đây không phải của phần mềm PowerPoint? 

A. Tạo bài giảng điện tử   

B. Soạn thảo văn bản và tạo bảng tính  

C. Tạo tệp trình chiếu gồm các trang chiếu  

D. Trình chiếu một số hoặc tất cả các trang chiếu 

Câu 7. Sau khi đã thiết kế xong bài trình diễn, cách làm nào sau đây không phải để 

trình chiếu ngay bài trình diễn đó? 

A. Nhấn phím F5 B. Chọn Slide Show -> Custom Show 



 

 

C. Chọn View -> Slide Show D. Chọn Slide Show -> View Show 

Câu 8. Để xóa hình ảnh trên trang chiếu, ta sử dụng phím gì? 

A. Tab B. Delete C. Enter D. Shift 

Câu 9. Để tạo hiệu ứng chuyển trang chiếu, em thực hiện các thao tác nào? 

A. View → Slide Layout B. Insert → Picture → From File 

C. Slide Show → Animation Schemes D. Slide Show → Slide Transition  

Câu 10. Để tạo hiệu ứng động có sẵn cho các đối tượng trên trang chiếu ta thực hiện 

theo trình tự nào? 

A. Mở bảng chọn Format → Slide Layout  

B. Mở bảng chọn Slide Show → View Show 

C. Mở bảng chọn Slide Show → Slide Transition 

D. Mở bảng chọn Slide Show → Animation Schemes 

Câu 11. Khi trình chiếu nội dung của mỗi trang chiếu thì chọn hiệu ứng âm thanh như 

thế nào?  

A. Bắt buộc phải có 1 hiệu ứng âm thanh đi kèm. 

B. Bắt buộc phải có 2 hiệu ứng âm thanh trở lên. 

C. Tuyệt đối không nên sử dụng hiệu ứng âm thanh. 

D. Tùy theo nội dung thể hiện để chọn âm thanh cho phù hợp. 

Câu 12. Âm thanh đưa vào bài trình diễn thực hiện được khi nào? 

A. Chỉ khi tạo hiệu ứng chuyển trang giữa các slide.  

B. Chỉ khi tạo hiệu ứng động cho đối tượng trong slide.  

C. Khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

D. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

Câu 13. Để khởi động phần mềm ghi âm thanh và xử lí âm thanh, em kích vào: 

A.     B.     C.    D.    

Câu 14. Trong phần mềm Audacity để thêm một tệp âm thanh vào phần mềm ta thực 

hiện lệnh nào? 

A. File -> New                          B. File -> Export audio  

C. File -> Import -> Audio             D. File -> Save Project 

Câu 15. Thành phần nào rất đặt biệt của đa phương tiện và là dạng tổng hợp thông 

tin? 

A. Phim   B. Văn bản  C. Hình ảnh  D. Âm thanh      

Câu 16. Trong nghệ thuật đa phương tiện ứng dụng để làm gì 

A. Bài trình chiếu  B. Mổ nội soi C. Sản xuất phim D. Trò chơi 

Câu 17. Phần mềm ghi âm thanh và xử lí âm thanh có tên là gì? 

A. PhotoShop B. Movie Maker  C. Geogebra   D. Audacity   

Câu 18. Trong phần mềm Audacity, tổ hợp phím nào sau đây dùng để tách một đoạn 

âm thanh đã đánh dấu trên rãnh và chuyển sang một rãnh mới? 



 

 

A. Ctrl + Alt + I B. Ctrl + I  C. Ctrl + V D. Ctrl + X 

Câu 19. Thành phần nào rất điển hình của đa phương tiện và phát triển từ lâu? 

A. Văn bản  B. Phim   C. Hình ảnh  D. Âm thanh      

Câu 20. Đa phương tiện trong tiếng anh được viết là gì? 

A. Media       B. Multiple  C. Multimedia  D. Supermedia  

 

3.3. Hoạt động vận dụng: 

Tạo bài trình chiếu với nội dung gợi ý như sau để giới thiệu về Quảng Nam. 

Trang 1: Quảng Nam quê hương tôi 

Trang 2: Vị trí địa lý 

- Quảng Nam nằm ở khu vực miền Trung Việt Nam 

- Cách thành phố Đà Nẵng 60 km về phía Nam  

- Tỉnh lỵ của Quảng Nam đặt tại thành phố Tam Kỳ.  

- Tổng diện tích đất tự nhiên của tỉnh là 10.438 km². 

Trang 3: Địa điểm du lịch nổi tiếng 

Trang 4: Khu di tích lịch sử 

Trang 5: Món ăn đặc sản 

* Chú ý: - Các em cần tạo màu nền, hiệu ứng chuyển trang, hiệu ứng động cho các 

đối tượng sao cho phù hợp. 

 Có thể sáng tạo thêm nếu em biết thêm về Quảng Nam. 

 Hình minh họa có trong thư mục Hinh trên màn hình Desktop 

của từng máy con, lựa chọn hình minh họa sao cho phù hợp 

với nội dung. 

4. Hướng dẫn HS học ở nhà: 

- Yêu cầu học sinh về nhà xem lại kiến thức cũ 

- Ôn lại phần lí thuyết 

- Nhắc HS hình thức thi kiểm tra học kỳ II: 

+ Phần I: Lý thuyết (5đ) Làm bài trắc nghiệm 

 + Phần II: Thực hành (5đ) Làm bài thực hành trên máy tính. 

 

 

 

Tuần 31  

Tiết: 62 

KIỂM TRA CUỐI HỌC KỲ II 

I. MỤC TIÊU BÀI HỌC: 

1. Kiến thức:  

- Củng cố và kiểm tra được việc lĩnh hội kiến thức của học sinh qua các bài đã học 

2. Kỹ năng: Rèn cho hs kỹ năng trình bày bài làm, vận dụng kiến thức đã học vào để 

trả lời từng câu hỏi cụ thể. 

3. Thái độ: Giáo dục hs tính cẩn thận, chính xác, ý thức kỷ luật, nghiêm túc trong 

kiểm tra thi cử. 

4. Định hướng phát triển năng lực cho HS: 



 

 

Năng tự chủ chủ và tự học 

II. CHUẨN BỊ: 

 1. Giáo viên: Ma trận, bảng đặc tả, đề kiểm tra cuối kỳ II, đáp án, biểu điểm cụ thể. 

 2. Học sinh: Kiến thức, đồ dùng học tập. 

III. HÌNH THỨC ĐỀ KIỂM TRA 

- Hình thức: TNKQ + Tự luận. 

- Học sinh làm bài trên máy tính. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

MA TRẬN ĐỀ KIỂM TRA CUỐI HỌC KÌ II 

 NĂM HỌC 2023 - 2024 

MÔN: TIN HỌC LỚP 9  – THỜI GIAN LÀM BÀI: 45 phút  

 

Cấp độ 

 

Chủ đề 

Nhận biết Thông hiểu 
Vận dụng 

 

Cộng 
Cấp độ thấp Cấp độ cao 

TN TL TN TL TN TL TN TL 

Bài 10: Thêm hình ảnh vào trang 

chiếu 
   .  

Số câu 

Số điểm 

2 

1đ 
 

1 

0.5đ 

1 

2đ 
    

3.5đ 

35% 

Bài 11: Tạo các hiệu ứng động      

Số câu 

Số điểm 

2 

1đ 
 

1 

0.5đ 
 

 

 

1 

2đ 
  

3.5đ 

35% 

Bài 12: Thông tin đa phương tiện      

Số câu 

Số điểm 

2 

1đ 
       

1đ 

10% 

Bài 13: Phần mềm ghi âm và xử lý 

âm thanh Audacity. 
     

Số câu 

Số điểm 

2 

1đ 
      

1 

1đ 

2đ 

20% 

Tổng số câu 8  2 1  1  1 13 

Tổng số điểm 4đ  1đ 2đ  2đ  1đ 10đ 

Tỉ lệ 40%  30%  20%  10% 100% 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

BẢNG ĐẶC TẢ  ĐỀ KIỂM TRA CUỐI HỌC KÌ II 

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9  – THỜI GIAN LÀM BÀI 45 phút 

 

 

Chủ đề Nội dung Mức độ đánh giá 

Số câu hỏi theo mức độ nhận 

thức 

Nhận 

biết 

Thông 

hiểu 

Vận 

dụng 

Vận 

dụng 

cao 

Chương 

3. Phần 

mềm 

trình 

chiếu 

Bài 10: 

Thêm hình ảnh 

vào trang chiếu 

Nhận biết 

- Biết cách chèn hình ảnh và các đối tượng khác vào trang 

chiếu 

- Biết sao chép và di chuyển trang chiếu 

Thông hiểu 

- Hiểu được cách thêm hình ảnh vào trang chiếu sao cho 

đẹp, hài hòa, sinh động. 

2TN 

(C1,2) 

1đ 

1TN 

(C3) 

0,,5đ 

1TH 

(C12) 

2đ 

  

Bài 11: 

Tạo các hiệu ứng 

động 

Nhận biết 

- Biết tạo hiệu ứng cho các đối tượng trên trang chiếu 

Thông hiểu 

- Hiểu cách tạo hiệu ứng động 

Vận dụng  

- Vận dụng để định dạng trang chiếu, nội dung, chèn hình 

ảnh, … Tạo hiệu ứng cho đối tượng, trang chiếu thêm sinh 

động hấp dẫn. 

2TN 

(C4,5) 

1đ 

1TN 

(C6) 

0,5đ 

1TH 

(C11) 

2đ 

 



 

 

Chương 

4. Đa 

phương 

tiện 

Bài 12: Thông tin 

đa phương tiện 

Nhận biết 

- Biết đâu là phần mềm đa phương tiện, tên gọi 

 

2TN 

(C9,10

) 

1đ 

   

Bài 13: Phần mềm 

ghi âm và xử lý 

âm thanh 

Audacity. 

Nhận biết 

- Nhận biết biểu tượng và tên của phần mềm 

Vận dụng cao: 

- Sử dụng phần mềm Audacity để cắt/ ghép file nhạc … để 

chèn vào bài trình chiếu. 

2TN 

(C7,8) 

1đ 

 

  

1TH 

(C13) 

1đ 

Tổng số câu 8TN 
2TN 

+1TH 
1TH 1TH 

Tổng số điểm 4 3 2 1 

Tỉ lệ % 40% 30% 20% 10% 

 

 



 

 

(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1. Để chèn hình ảnh vào trang chiếu, em sử dụng dải lệnh nào sau đây? 

A. Home  B. Insert  C. Design  D. View 

Câu 2. Trong PowerPoint nháy chuột phải lên hình ảnh  Chọn Bring to 

Front  Bring Forward để chuyển hình ảnh 
A. xuống lớp dưới cùng             B. xuống dưới một lớp 

C. lên lớp trên cùng   D. lên trên một lớp          

Câu 3. Đưa con trỏ chuột lên trên hình ảnh và kéo thả để di chuyển đến vị 

trí khác có chức năng gì?  

A. Thay đổi thứ tự lớp của hình ảnh. B. Thay đổi vị trí.   

C. Thay đổi kích thước. D. Xóa hình ảnh. 

Câu 4. Sau khi đã thiết kế xong bài trình diễn, cách làm nào sau đây không 

phải để trình chiếu ngay bài trình diễn đó? 

A. Chọn Slide Show -> Custom Show B. Nhấn phím F5 

C. Chọn View -> Slide Show D. Chọn Slide Show -> View 

Show 

Câu 5. Để tạo hiệu ứng chuyển trang chiếu, em thực hiện các thao tác nào? 

A. Slide Show → Animation Schemes B. View → Slide Layout 

C. Slide Show → Slide Transition D. Insert → Picture → From File 

Câu 6. Khi trình chiếu nội dung của mỗi trang chiếu thì chọn hiệu ứng âm 

thanh như thế nào?  

A. Bắt buộc phải có 1 hiệu ứng âm thanh đi kèm. 

B. Bắt buộc phải có 2 hiệu ứng âm thanh trở lên. 

C. Tuyệt đối không nên sử dụng hiệu ứng âm thanh. 

D. Tùy theo nội dung thể hiện để chọn âm thanh cho phù hợp. 

Câu 7. Để khởi động phần mềm ghi âm thanh và xử lí âm thanh, em kích 

vào: 

A.     B.    C.    D.   

Câu 8. Trong phần mềm Audacity để thêm một tệp âm thanh vào phần 

mềm ta thực hiện lệnh nào? 
A. File -> Import -> Audio             B. File -> Save Project 

C. File -> New                          D. File -> Export audio 

Câu 9. Thành phần nào rất đặt biệt của đa phương tiện và là dạng tổng hợp 

thông tin? 

Họ và tên:…………………………… 

 Lớp: …..…                   MÃ ĐỀ A 

KIỂM TRA CUỐI HỌC KÌ II  

NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút (Không kể thời gian giao đề) 

Điểm 



 

 

A. Văn bản   B. Phim   C. Hình ảnh  D. Âm 

thanh      

Câu 10. Trong nghệ thuật đa phương tiện ứng dụng để làm gì 

A. Sản xuất phim  B. Bài trình chiếu  C. Mổ nội soi D. Trò 

chơi 

 

II. Phần thực hành: (5 điểm) Hãy thực hành trên máy tính  

Câu 11. (2 điểm) Sử dụng phần mềm Powerpoint để tạo bài trình chiếu từ 8 đến 

10 trang với chủ đề: “Bảo vệ môi trường” 

Câu 12. (2 điểm) Định dạng trang chiếu, nội dung, chèn hình ảnh, … Tạo hiệu 

ứng cho đối tượng, trang chiếu thêm sinh động hấp dẫn. 

Câu 13. (1 điểm) Sử dụng phần mềm Audacity để cắt/ ghép file nhạc … để chèn 

vào bài trình chiếu. 

 

* Lưu ý: Khởi động máy tính vào ổ đĩa D Tạo thư mục có tên là:  

 + HOVATEN-LOP(VD:  TRANVANANH92) 

(với HOVATEN  và LOP là tên và lớp của thí sinh). 

+ Được sử dụng Internet để tìm thông tin, hình ảnh. 

 

-------------- Hết ---------- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Họ và tên:………………………. 

 Lớp: …..…                   MÃ ĐỀ B 

KIỂM TRA CUỐI HỌC KÌ II 

NĂM HỌC 2023-2024 

Môn: Tin học, lớp 9 

Thời gian : 45 phút (Không kể thời gian giao đề) 

Điểm 

(* Lưu ý: Học sinh làm bài trên máy tính) 

 

I. Phần trắc nghiệm (5 điểm) Chọn chữ cái đứng trước câu trả lời đúng 

Câu 1. Thao tác chọn File -> Close dùng để 

A. lưu tập tin hiện tại B. mở một tập tin nào đó 

C. đóng tập tin hiện tại D. thoát khỏi Powerpoint 

Câu 2. Trong PowerPoint nháy chuột phải lên hình ảnh  Send to Back 

 Send Backward để chuyển hình ảnh 
A. xuống lớp dưới cùng             B. xuống dưới một lớp 

C. lên lớp trên cùng   D. lên trên một lớp                    

Câu 3. Đưa con trỏ chuột lên trên hình ảnh và kéo thả để di chuyển đến vị trí 

khác có chức năng gì?  

A. Thay đổi vị trí. B. Thay đổi kích thước.  

C. Xóa hình ảnh. D. Thay đổi thứ tự lớp của hình ảnh. 

Câu 4. Để tạo hiệu ứng động có sẵn cho các đối tượng trên trang chiếu ta 

thực hiện theo trình tự nào? 

A. Mở bảng chọn Slide Show → Slide Transition 

B. Mở bảng chọn Slide Show → View Show 

C. Mở bảng chọn Format → Slide Layout 

D. Mở bảng chọn Slide Show → Animation Schemes 

Câu 5. Sau khi đã thiết kế xong bài trình diễn, cách làm nào sau đây không 

phải để trình chiếu ngay bài trình diễn đó? 

A. Nhấn phím F5 B. Chọn Slide Show -> Custom 

Show  

C. Chọn View -> Slide Show D. Chọn Slide Show -> View 

Show 

Câu 6. Âm thanh đưa vào bài trình diễn thực hiện được khi nào? 

A. Chỉ khi tạo hiệu ứng động cho đối tượng trong slide.  

B. Chỉ khi tạo hiệu ứng chuyển trang giữa các slide. 

C. Khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

D. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

Câu 7. Phần mềm ghi âm thanh và xử lí âm thanh có tên là gì? 

A. Audacity  B. Movie Maker  C. Geogebra   D. PhotoShop  

Câu 8. Trong phần mềm Audacity, tổ hợp phím nào sau đây dùng để tách 

một đoạn âm thanh đã đánh dấu trên rãnh và chuyển sang một rãnh mới? 

A. Ctrl + V B. Ctrl + I  C. Ctrl + Alt + I D. Ctrl + X 

Câu 9. Thành phần nào rất điển hình của đa phương tiện và phát triển từ 

lâu? 



 

 

A. Văn bản  B. Phim   C. Hình ảnh  D. Âm thanh     

  

Câu 10. Trong trường học đa phương tiện ứng dụng để làm gì? 

A. Chụp ảnh  B. Tạo trình chiếu  C. Mổ nội soi D. Sản xuất 

phim 

II. Phần thực hành: (5 điểm) Hãy thực hành trên máy tính  

Câu 11. (2 điểm) Sử dụng phần mềm Powerpoint để tạo bài trình chiếu từ 8 đến 

10 trang với chủ đề: “Bảo vệ trái đất” 

Câu 12. (2 điểm) Định dạng trang chiếu, nội dung, chèn hình ảnh, … Tạo hiệu 

ứng cho đối tượng, trang chiếu thêm sinh động hấp dẫn. 

Câu 13. (1 điểm) Sử dụng phần mềm Audacity để cắt/ ghép file nhạc … để chèn 

vào bài trình chiếu. 

 

* Lưu ý: Khởi động máy tính vào ổ đĩa D Tạo thư mục có tên là:  

 + HOVATEN-LOP(VD:  TRANVANANH92) 

(với HOVATEN  và LOP là tên và lớp của thí sinh). 

+ Được sử dụng Internet để tìm thông tin, hình ảnh. 

 

-------------- Hết ---------- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

UBND HUYỆN NÚI THÀNH 

TRƯỜNG THCS CHU VĂN AN 

ĐÁP ÁN ĐỀ KIỂM TRA CUỐI HỌC KÌ II  

NĂM HỌC 2023 - 2024 

MÔN TIN HỌC 9 

Thời gian: 45 phút (không kể thời gian giao đề) 

 

 

MÃ ĐỀ A 

I. PHẦN LÝ THUYẾT : (5điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án B D B A C D B A B A 

 

MÃ ĐỀ B 

I. PHẦN LÝ THUYẾT : (5điểm) mỗi câu trả lời đúng 0.5 điểm 

Câu 1 2 3 4 5 6 7 8 9 10 

Đáp án D B A D B C A C D B 

 

II. PHẦN THỰC HÀNH: (5 điểm) Dùng chung cho 2 đề 

Câu 11: Tạo được bài trình chiếu đúng theo yêu cầu   2 điểm 

Câu 12: Định dạng trang chiếu, nội dung, chèn hình ảnh, … Tạo hiệu ứng cho 

đối tượng, trang chiếu thêm sinh động hấp dẫn.    2 điểm 

Câu 13: Sử dụng phần mềm Audacity để cắt/ ghép file nhạc … để chèn vào bài 

trình chiếu.   1 điểm 

 

 

 

 

 

Tuần 33  

Tiết: 63-66 

BÀI TẬP 

I. MỤC TIÊU: 

1. Kiến thức:  

- Tổng hợp kiến thức đã học từ tuần 19 đến tuần 30  

- Ôn luyện lại lý thuyết và các dạng bài tập đã gặp. 

2. Kĩ năng: Hình thành kĩ năng tư duy tổng hợp, thành thạo các thao tác. 

3. Thái độ: Học tập nghiêm túc, có ý thức tự giác, tinh thần vươn lên vượt qua 

khó khăn. 

4. Định hướng phát triển năng lực cho HS: 

Năng lực tự học, năng lực giao tiếp, năng lực hợp tác. 

II. PHƯƠNG PHÁP VÀ KĨ THUẬT DẠY HỌC: 



 

 

- Thực hành. 

- Thảo luận nhóm. 

- Hỏi đáp. 

III. TƯ LIỆU VÀ PHƯƠNG TIỆN: 

 1. Giáo viên: Kế hoạch bài dạy, SGK, nội dung ôn tập 

2. Học sinh: Ôn và hệ thống lại nội dung chương trình tin 9 HK II. 

IV. TIẾN TRÌNH DẠY HỌC: 

1. Ổn định: Ổn định, báo cáo sỉ số. 

2. Kiểm tra bài cũ: (Lồng ghép trong nội dung bài học.) 

3. Tổ chức dạy học: 

3.1. Hoạt động khởi động:  

 

Hoạt động của GV Hoạt động của HS 

Tổ chức trò chơi một trò chơi như sau: 

- Chia lớp thành 4 đội, đội nào thắng sẽ được phần quà. 

- Trò chơi gồm 4 câu hỏi, mỗi câu hỏi 10 điểm, đội nào 

không trả lời được thì đội khác có quyền trả lời để dành 

điểm 

- Câu hỏi: 

+ Câu 1: Trong PowerPoint nháy chuột phải lên hình 

ảnh -> Chọn Bring to Front -> Bring Forward để 

chuyển hình ảnh 

A. Xuống lớp dưới cùng            

B. Xuống dưới một lớp 

C. Lên trên một lớp                    

D. Lên lớp trên cùng 

+ Câu 2: Trong phần mềm Audacity để thêm một tệp âm 

thanh vào phần mềm ta thực hiện: 

A. File -> Import -> Audio         

B. File -> Save Project 

C. File -> New                           

D. File -> Export audio 

+ Câu 3: Sản phẩm nào trong số các sản phẩm dưới 

đây (được tạo bằng máy tính và phần mềm máy tính) 

là sản phẩm đa phương tiện? 

A. Bài thơ được soạn thảo bằng Word 

B. Một ca khúc đượcghi âm và lưu trong máy tính 

C. Bảng điểm lớp em được tạo bằng Excel 

D. Bài trình chiếu có hình ảnh minh họa. 

Các đội thảo luận 

và trả lời câu hỏi 

chọn được  

Các đội khác theo 

dõi và nhanh tay 

dành quyền trả lời 

cho đội mình nếu 

đội bạn trả lời sai 



 

 

+ Câu 4: Đưa con trỏ chuột lên trên hình ảnh và kéo thả 

để di chuyển đến vị trí khác có chức năng gì?  

 A. Thay đổi thứ tự lớp của hình ảnh B. Thay đổi kích 

thước 

 C. Thay đổi vị trí    D. Xóa hình ảnh 

GV nhận xét, tổng kết đội thắng cuộc và phát quà 

 

3.2. Hoạt động luyện tập:  

 

Hoạt động của GV VÀ HS Tiến trình nội 

dung 

GV yêu cầu HS trả lời các câu hỏi sau: 

I.TRẮC NGHIỆM: 

Câu 1: Để lưu tệp dự án âm thanh ta chọn:  

A. File/New              B. File/Save Project 

C. File → Export Audio   D. File/Save 

Câu 2: Kích chuột phải lên hình ảnh đã chèn trong Power 

Point và chọn Send To Back có chức năng gì?  

A. Thay đổi màu sắc hình ảnh     

B. Thay đổi thứ tự lớp của hình ảnh  

C. Thay đổi chi tiết hình ảnh      

D. Thay đổi kích thước hình ảnh  

Câu 3: Để tạo hiệu ứng chuyển cho các trang chiếu, ta 

thực hiện như thế nào?  

A. Slide Show → Animation Schemes  

  

B. View → Transition to This Slide 

C. Transitions → Transition to This Slide   

D. Home → Slide Transition     

Câu 4: Đưa con trỏ chuột lên trên hình ảnh và kéo thả để 

di chuyển đến vị trí khác có chức năng gì?  

 A. Thay đổi thứ tự lớp của hình ảnh    

B. Thay đổi kích thước  

 C. Thay đổi vị trí       

D. Xóa hình ảnh 

Câu 5: Để tạo hiệu ứng động có sẵn cho các đối tượng 

trên trang chiếu ta thực hiện theo trình tự nào?  

 A. Mở dải lệnh Home → Slide Transition   

C. Mở bảng chọn File → Animation   

 

 

Gv: Chuyển giao 

nhiệm vụ học tập : 

Hoạt động nhóm 

thảo luận trả lời câu 

hỏi:  

HS:Thực hiện 

nhiệm vụ học tập: 

+  Các nhóm thảo 

luận và trả lời câu 

hỏi trắc nghiệm và 

tự luận của giáo 

viên. 

HS: Báo cáo kết 

quả thảo luận:  

+ HS báo cáo kết 

quả thảo luận của 

nhóm mình thông 

qua gv yêu cầu. 

- Nhận xét, đánh 

giá, kết luận: 

+  Sau khi thực hiện 

xong bài tập Giáo 

viên nhận xét đánh 

giá tinh thần, thái độ 

học tập và kết quả 

học sinh đã báo cáo.  



 

 

 C. Mở dải lệnh Animations → Transition   

D. Mở dải lệnh Animations → Animation 

Câu 6: Để điều khiển việc chuyển trang chiếu, lựa chọn 

After có tác dụng gì?  

 A. Không có tác dụng 

 B. Tự động chuyển trang sau một khoảng thời gian khi 

trình chiếu  

 C. Thiết lập thời gian thực hiện hiệu ứng chuyển  

 D. Chỉ chuyển trang khi nháy chuột  

Câu 7: Để xuất kết quả âm thanh ta chọn:  

A. File  → Import Audio      

B. File → Export Audio   

C. File → Save       

D. File  → Open 

Câu 8: Tệp dự án âm thanh (*.aup) của Audacity có thể 

chứa bao nhiêu rãnh âm thanh?  

A. Không hạn chế.  B. 1          C. 3 D. 10    

   

Câu 9: Điền từ vào chố trống: 

……………..là dạng thông tin cơ bản quan trọng nhất 

trong biểu diễn thông tin. 

A.Âm thanh   B. Hình ảnh    

D. Văn bản   D. Phim  

Câu 10: Một trang chiếu có nhiều đối tượng và em đã áp 

dụng hiệu ứng động cho một số đối tượng đó. Khi trình 

chiếu, các đối tượng sẽ xuất hiện với thứ tự như thế nào 

sau mỗi lần nháy chuột? 

 A. Mọi đối tượng sẽ lần lượt xuất hiện theo thứ tự từ 

trên xuống dưới, từ trái qua phải.  

 B. Các đối tượng không được áp dụng hiệu ứng động sẽ 

xuất hiện ngay cùng với trang chiếu sau khi nháy chuột, 

các đối tượng được áp dụng hiệu ứng động sẽ xuất hiện 

lần lượt theo thứ tự từ trên xuống dưới, từ trái qua phải. 

  C. Các đối tượng được áp dụng hiệu ứng động sẽ xuất 

hiện lần lượt theo đúng thứ tự khi em chọn hiệu ứng để 

áp dụng, các đối tượng không được áp dụng hiệu ứng 

động sẽ xuất hiện sau cùng. 

  D. Các đối tượng không được áp dụng hiệu ứng động sẽ 

xuất hiện ngay cùng với trang chiếu sau khi nháy chuột, 

 



 

 

các đối tượng được áp dụng hiệu ứng động sẽ xuất hiện 

lần lượt theo đúng thứ tự khi em chọn hiệu ứng để áp 

dụng. 

Câu 11: Để điều khiển việc chuyển trang chiếu, lựa chọn 

Duration có tác dụng gì?  

A. Không có tác dụng 

B. Chỉ chuyển trang khi nháy chuột  

C. Thiết lập thời gian thực hiện hiệu ứng chuyển  

D. Tự động chuyển trang sau một khoảng thời gian khi 

trình chiếu   

Câu 12: Các sản phẩm đa phương tiện có thể gồm những 

dạng thông tin nào dưới đây?  

A. Văn bản với nhiều dạng trình bày phong phú. 

B. Văn bản, hình ảnh, âm thanh, phim, ảnh động và các 

tương tác. 

C. Hình ảnh, sơ đồ, biểu đồ, bản đồ. 

D. Các bản nhạc và chương trình nghe nhạc. 

Câu 13: Một rảnh âm thanh có thể bao gồm bao nhiêu 

clip? 

A. 1     B. 2  C. 5     D. Không hạn chế 

Câu 14:  Điền từ vào chố trống: 

……………….là thành phần rất đặc biệt của đa phương 

tiện và có thể được coi là dạng tổng hợp tất cả các dạng 

thông tin. 

A.Âm thanh  B. Ảnh động   C. Phim    D. Văn bản 

Câu 15: Chọn phát biểu sai trong các câu dưới đây? 

A. Khi tạo hiệu ứng động cho một khối văn bản ta có thể 

cho xuất hiện lần lượt từng từ trong khối văn bản khi 

trình chiếu 

B. Sau khi đã tạo hiệu ứng động cho một đối tượng nào 

đó ta không thể thay đổi kiểu hiệu ứng cho đối tượng đó 

C. Có thể thực hiện hiệu ứng chuyển trang cho 1 slide 

bất kỳ trong bài trình chiếu 

D. Có thể thực hiện hiệu ứng chuyển trang cho tất cả các 

slide trong bài trình chiếu. 

Câu 16: Hãy chọn câu trả lời sai trong các câu sau đây? 

A. Ảnh động bao gồm một số ảnh tĩnh ghép lại và thể 

hiện theo thứ tự thời gian trên màn hình. 



 

 

B. Phim được quay bằng máy ảnh kĩ thuật số cũng là 

một dạng ảnh động. 

C. Ảnh động là ảnh chụp lại một cảnh hoạt động của 

con người hoặc các sự vật. 

D. Khi hiển thị ảnh động trên màn hình máy tính ta sẽ 

nhìn thấy hình chuyển động. 

Câu 17: Sau khi tạo hiệu ứng chuyển trang chiếu ưng ý 

cho trang tiêu đề của bài trình chiếu, nếu muốn áp dụng 

hiệu ứng đó cho tất cả các trang còn lại, em thực hiện thao 

tác nào dưới đây?  

A. Chọn Apply to All trong nhóm Timing trên dải lệnh 

Animations. 

B. Lặp lại các thao tác tạo hiệu ứng cho từng trang chiếu, 

như đã thực hiện với trang tiêu đề.  

C. Chọn Apply to All trong nhóm Timing trên dải lệnh 

Transitions. 

 D. Không phải thực hiện thao tác nào nữa, ngầm định 

hiệu ứng chuyển trang chiếu sẽ được áp dụng cho mọi 

trang chiếu của bài trình chiếu. 

Câu 18: Sắp xếp các thao tác sau theo thứ tự đúng để 

chèn hình ảnh vào trang chiếu: 

1. Chọn trang chiếu cần chèn hình ảnh vào 

2. Chọn tệp đồ họa cần thiết và nháy Insert 

3. Chọn thư mục lưu tệp hình ảnh trong ngăn trái của 

hộp thoại 

4. Mở dải lệnh Insert, chọn lệnh Picture trong nhóm 

Images để hiển thị hộp thoại Insert Picture. 

A. (3) - (2) - (1) - (4)  B. (1) - (4) - (3) - (2)

  

C. (4) - (2) - (1) - (3)  D. (4) - (1) - (2) - (3) 

Câu 19: Hãy chọn câu trả lời sai. Đa phương tiện có 

những ưu điểm và hạn chế nào sau đây? 

 A. Thu hút sự chú ý hơn, vì sự kết hợp các dạng thông 

tin luôn thu hút sự chú ý của con người hơn so với chỉ 

một dạng thông tin cơ bản. 

 B. Không thích hợp với việc sử dụng máy tính, mà 

chỉ thích hợp cho tivi, máy chiếu phim, máy nghe nhạc. 

 C. Rất phù hợp cho giải trí, nâng cao hiệu quả dạy và 

học. 



 

 

 D. Thể hiện thông tin tốt hơn. 

Câu 20: Để lưu tệp dự án âm thanh ta chọn:  

A. File → Export Audio B. File/Save Projec 

C. File/New                           D. File/Save 

Câu 21: Hiệu ứng chuyển trang chiếu là gì?  

A. Trật tự xuất hiện của các hình ảnh được chèn vào 

các trang chiếu.  

B. Cách xuất hiện tiêu đề của các trang chiếu.  

C. Cách xuất hiện phần nội dung của trang chiếu.  

D. Cách xuất hiện của trang chiếu khi bắt đầu được 

hiển thị thay thế trang chiếu trước.  

Câu 22: Bạn Lan muốn áp dụng một hiệu ứng chuyển 

động cho nội dung của trang tiêu đề. Khi mở trang tiêu 

đề rồi mở dải lệnh Animations, Lan thấy các biểu tượng 

hiệu ứng chuyển động trong nhóm Animations bị mờ và 

không nháy chọn được. Em hãy giúp bạn Lan biết lí do?  

A. Bạn Lan tuy đã mở trang tiêu đề nhưng chưa chọn đối 

tượng nào trên trang chiếu nên các biểu tượng hiệu ứng 

động trong nhóm Animations bị mờ.  

B. Các biểu tượng hiệu ứng chuyển động trong nhóm 

Animations bị mờ vì không được áp dụng hiệu ứng động 

cho nội dung của trang tiêu đề (trang tiêu đề phải xuất 

hiện ngay khi trình chiếu). Chỉ có thể áp dụng hiệu ứng 

động cho các đối tượng trên những trang nội dung.  

C. Bạn Lan mở sai dải lệnh, Lan phải mở dải lệnh 

Transitions sẽ thấy các biểu tượng hiệu ứng hiện rõ trên 

dải lệnh.  

D. Bạn Lan bấm nhầm phím nào đó trên bàn phím.  

Câu 23: Em có thể thực hiện những thao tác nào dưới 

đây với các hình ảnh đã được chèn vào trang chiếu? Hãy 

chỉ ra câu trả lời sai trong các câu sau?   

    A.Thay đổi kích thước của hình ảnh.   

    B.Thay đổi vị trí của hình ảnh. 

    C.Thay đổi thứ tự lớp scủa hình ảnh.   

    D.Thay đổi và chỉnh sửa nội dung hình ảnh. 

Câu 24: Để chuyển một hình ảnh được chọn để đưa 

xuống dưới một lớp ta thực hiện nháy chuột phải lên 

hình ảnh và chọn Send to Back rồi chọn: 

   A. Send to Back     B. Bring to Front 



 

 

   C. Bring Forward  D. Send Backward 

Câu 25: Để chuyển một hình ảnh được chọn lên trên một 

lớp ta thực hiện nháy chuột phải lên hình ảnh và chọn 

Bring to Front rồi chọn: 

     A. Send to Back. B. Bring Forward.   

     C. Bring to Front. D.Send Backward 

II. TỰ LUẬN: 

Câu 1: Nhận biết được các nút lệnh có trong phần mềm 

Audacity? (xem Hình 4.15 và hình 4.17 sgk) 

Câu 2: Trình bày các ưu điểm của đa phương tiện? Cho 

ví dụ của từng ưu điểm?  

Câu 3: Thao tác đánh dấu một đoạn âm thanh; sao chép, 

cắt, dán, đoạn âm thanh trong audacity? 

Câu 4: Tạo một trang chiếu với tiêu đề có biểu tượng là 

một hình nhỏ ngay bên cạnh, tương tự như hình c) dưới 

đây: 

                           
        Hình a               Hình b     Hình c 

Sau khi nhập văn bản trong khung tiêu đề, em đặt con trỏ 

vào cuối phần văn bản (hình a) và sử dụng lệnh Picture 

trên dải lệnh Insert để chèn hình ảnh. Kết quả nhận được 

không như em mong đợi, hình ảnh được chèn vào một vị 

trí khác trên trang chiếu (hình b). Em hãy giải thích vì sao 

khi chèn hình vào kết quả không giống như hình c và nêu 

cách thực hiện làm thế nào để được như hình c? 

Câu 5: Các bước thiết lập thời gian cho hiệu ứng chuyển 

trang chiếu? 

 

4. Hướng dẫn HS học ở nhà:  

- Yêu cầu học sinh về nhà coi lại kiến thức cũ 

- Ôn lại phần lí thuyết 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tuần 34  

Tiết: 67-70 

BÀI TẬP 

I. MỤC TIÊU CẦN ĐẠT 

1. Kiến thức:  Biết cách tạo ra một sản phẩm từ phần mềm. 

2. Kĩ năng: Thực hiện được các công cụ trong phần mềm  

3. Thái độ:  
- Cẩn thận, nghiêm túc luyện tập từ dễ đến khó. 

- Phát triển tư duy, phản xạ nhanh. 

- Tự chủ trong học tập, hoạt động hiệu quả theo nhóm. 

4. Định hướng hình thành năng lực: Năng lực tự học, năng lực giải quyết vấn 

đề, năng lực giao tiếp, năng lực hợp tác, tư duy logic 

II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH 

 Giáo viên: Máy tính, máy chiếu, khbd 

Học sinh: micro, tai nghe, sgk 

III. TỔ CHỨC HOẠT ĐỘNG DẠY VÀ HỌC 
1. Hoạt động: Khởi động  

*Giới thiệu bài mới: hôm nay chúng ta sẽ báo cáo 1 sản phẩm âm thanh theo 

1 chủ đề. 

 - GV: yêu cầu học sinh khởi động máy tính, khởi động phần mềm Audicity   

- HS: Bật máy tính , khởi động phần mềm  

2. Hoạt động: Hình thành kiến thức  

 

Hoạt động của GV và HS Nội dung 



 

 

- Gv: gọi từng nhóm lên báo cáo sản phẩm 

 GV: Hướng dẫn cho học sinh, 

hướng dẫn từng nhóm, quan tâm đến từng 

đối tượng học sinh, giúp đỡ khi các em 

gặp khó khăn trong quá trình báo cáo 

HS: lần lượt từng nhóm trình bày, các 

nhóm khác lắng nghe, đặt câu hỏi, nhận 

xét 

GV: Nhận xét, chốt lại  

 

Bài tập: Dùng phần mềm 

audacity để tạo 1 sản phẩm âm 

thanh theo chủ đề hoàn chỉnh 

 

 

3. Hoạt động: Luyện tập  

Nhắc lại các thao tác trong quá trình tạo sản phẩm âm thanh 

4. Hoạt động: Vận dụng  
Tìm thêm những chủ đề khác để tạo ra các sản phẩm âm thanh. 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


